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Welcome
Getting Started

The following steps will get you started using the MobileAsset. These steps should be done in
order. Click on the links provided below to see the Help topics necessary to perform each step.
The steps below discuss manually entering information into your database; however, much of
this data can be imported using the MobileAsset PC application. Importing data is also discussed
in the MobileAsset Quick Start Guide that came with your CD. The Quick Start Guide is also
available for download at:

Even if you are planning on importing your information, we recommend that you review the steps
below to help you understand how the different types of data interrelate.

Note: The screen shots in this Help file are from Internet Explorer using the Vista operating
system. The look of some screens may vary slightly in different browsers and operating systems.

1. Use the MobileAsset PC application to setup your Groups and Users in Security and to
define your Company information. Please see the MobileAsset Online Help for more
information on using the PC application.

2. Create Sites and Create Locations: Once your Groups and Users are setup and you
have entered your Company information in the PC application, you are ready to begin
entering sites and locations into the database.

A site is a major classification for areas that contain assets within your company. For
instance, if you have two warehouses, you might set up MobileAsset to have two sites:
Warehouse 1 and Warehouse 2. You must enter at least one site before can add assets
to your system.

Assets that you enter into your system must each be assigned to a Site and a Location
within that site. Using the example above, within Warehouse 1, you might have three
locations: Main Storage Area, Manager’s Office and Administrative Office. We suggest
creating one site for each building that contains assets.

It is important to note that you can have the same Location code defined at more than
one Site - for instance, Warehouse 1 and Warehouse 2 may each have Location codes of
Shelf 1 - so always pay attention to which Site you are working with when performing
transactions.

Setting up your locations now will allow you to just pick a Location from a list when you
begin adding inventory later. It is possible, however, to define Locations as you add
inventory.

If you already have location information contained in another database, you may want to
use MobileAssets Import function rather than manually entering in this information. For
more information on importing locations, please refer to the topic Importing Into the
Database in the MobileAsset PC Online Help.

You must create a minimum of one Site, one Location at that Site.

3. Create Vendors, Create Manufacturers, Create Depreciation Classes: These are all
optional features. You can manually create or import this information. It is helpful to




MobileAsset Users' Manual

enter this information prior to setting up your assets.

4. Create Asset Types: This is the first step in creating an Asset in the application. You
must first create your Asset Types, then each asset you add to the system must be
assigned to a specific Asset Type. You can think of Asset Types as a classification for
assets. Forinstance, you may have an Asset Type of IBM Laptop X6000 that defines the
manufacturer, size specs, etc. of this particular type of computer. Then specific
computers of the same type are assigned as assets to the IBM Laptop X6000 asset type.
Asset Types are created in the database using the New Asset Type screen. You can
then assign assets to a specific asset type on the New Asset screen.

The Asset Type defines the Description, Depreciation Class, Category, Manufacturer and
Model Number of the asset.

5. Create Assets: One or more Assets can be assigned to each Asset Type. The
individual assets are a unique item of a specific make and model number. Each asset is
given an Asset Tag that is unique across all Sites and Locations.

You are now ready to perform transactions on your MobileAsset application!
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Definitions

Asset
One or more Assets can be assigned to each Asset Type. The individual assets
are a unique item of a specific make and model number. Each asset is given an
Asset Tag that is unique across all Sites and Locations.

Asset Linking
Asset Linking, also known as Asset Kitting, allows you to link two or more assets
together to form one new asset. For example, the asset Mary's Computer may
consist of 4 separate assets - CPU, Keyboard, Mouse and Monitor. These four
individual assets are linked together to form one new asset, Mary's Computer. In
this example, Mary's Computer is known as the "Parent" asset and the four
component assets are the "Child Assets".
A child asset can have only one parent, however, a parent may have multiple child
assets and be a child itself. In this scenario, the linking might look like this:

——— /-/ HH"'\-._

cru | [ montr | [ Mouse || Kevboars |
___,_,_,-'—'_'_ —
i Network Card | SoundCard |

In the example above, Mary's Computer is the parent of the assets CPU, Monitor,
Mouse and Keyboard. CPU is the parent of Network Card and SoundCard.
Therefore, CPU is both the child of Mary's Computer and the parent of Network
Card and SoundCard.

Asset Tag
A unique identifier you assign each asset in your database (this is done on the New
Asset screen). The tag can be letters or numbers or a combination of both. The
asset tag is printed and attached to the physical asset. Creation of the tags can be
done using the Wasp Labeler application that installed when you installed the
software. To access Labeler, from the Main screen, click Labels > Asset Tags.
The number on the tag corresponds to the asset tag number in the database. An
asset tag usually contains a barcode for quick identification and tracking.

Asset Type
This is the first step in creating an Asset in the software. You must first create your
Asset Types, then each asset you add to the system must be assigned to a specific
Asset Type. You can think of Asset Types as a classification for assets. For
instance, you may have an Asset Type of IBM Laptop X6000 that defines the
manufacturer, size specs, etc. of this particular type of computer. Then specific
computers of the same type are assigned as assets to the IBM Laptop X6000 asset
type. Asset Types are created in the database using the New Asset Type screen,
or you can import this information. You can then assign assets to a specific asset
type on the New Asset screen.

The Asset Type defines the Description, Depreciation Class, Category,
Manufacturer and Model Number of the asset.

Description can be any text used to describe the Asset Type.
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Depreciation Class controls whether or not depreciation will be calculated
for this Asset Type (Depreciation Class is further defined below).

Category is a superset of the Asset Type. This can be very broad (furniture,
computer equipment, etc.) or more specific (desk, chair, lamp, monitor, PC,
keyboard, etc.)

Manufacturer records the brand or maker of the Asset Type.

Model # records the manufacturer's designation for this Asset Type.

Depreciation Class
Depreciation Classes can be created to determine a specific Depreciation Method.
The Depreciation Class is assigned to one or more Asset Types (on the New Asset
Type screen). All assets assigned to that Asset Type will follow the Depreciation
Method defined in the specified Depreciation Class.

Depreciation Methods
If you are using the Standard version of MobileAsset, youYou have two depreciation
methods: None and Straight Line. If you are using the Professional version, you will
have six depreciation methods to choose from: None, Straight Line, Double
Declining Balance, 150% Declining Balance, Declining Balance Custom and Sum of
the Years' Digits.
Definitions for each of these methods are provided below:

Straight Line - The simplest and most commonly used depreciation
method, straight line depreciation is calculated by taking the purchase or
acquisition price of an asset subtracted by the salvage value divided by the
total productive years (Life) the asset can be reasonably expected to benefit
the company.

Example:

purchase price of asset — approximate salvage value
(divided by)
estimated useful life of asset

Assume you buy a new computer for your business costing approximately
$5,000. You expect a salvage value of $200 selling parts when you dispose
of it. Accounting rules allow a maximum useful life of five years for
computers; in the past, your business has upgraded its hardware every
three years, so you think this is a more realistic estimate of useful life, since
you are apt to dispose of the computer at that time. Using that information,
you would plug it into the formula:

$5,000 purchase price - $200 approximate salvage value
(divided by)
3 years estimated useful life

The answer, $1,600, is the depreciation charges your business would take
annually if you were using the straight line method.

Double Declining Balance - The double declining balance depreciation
method is similar to the straight-line method. To use it, the system first
calculates depreciation as if it were the straight line method. Then it
determines the total percentage of the asset that is depreciated the first
year and doubles it. Each subsequent year, that same percentage is
multiplied by the remaining balance to be depreciated. At some point, the
value will be lower than the straight-line charge, at which point, the double
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declining method should be scrapped and straight line used for the
remainder of the asset’s life. Remember that the IRS does allow
businesses to switch depreciation methods one time in the life of an asset.
MobileAsset will not make this switch for you. It is up to the individual
business to keep track of when the switch to straight line depreciation
should be made.

In MobileAsset, you must enter at least 100% for the custom declining
balance.

Example:

In our straight-line example, we calculated that a $5,000 computer with a
$200 salvage value and an estimated useful life of three years would be
depreciated by $1,600 annually. The first year, we have to compare this to
the total amount to be depreciated, in this case, $4,800 [$5,000 base - $200
salvage value = $4,800]. Dividing $1,600 by $4,800, we discover the
straight-line depreciation charge [$1,600] is 33.33% of the total depreciation
amount [$4,800]. Using this information, we double the 33.33% figure to
66.67%.

In the first year, we would take $4,800 multiplied by .6667 to get a total
depreciation charge of approximately $3,200. In the second year, we would
take the same percentage [66.67%] and multiply it by the remaining amount
to be depreciated. Continuing with the example, we find that $1,600 is the
remaining amount to be depreciated at the start of the second year [$4,800
- $3,200 = $1,600]. Multiply 1,600 by .6667 to get $1,066. This is the
depreciation charge for the second year — or not! Remember that once the
depreciation charges dip below the amount that would be charged using the
straight-line method, the double declining balance should be scrapped and
straight line immediately utilized. The straight line method called for charges
of $1,600 per year. Obviously, the $1,066 charge is smaller than the $1,600
that would have occurred under straight line. Thus, the deprecation charge
for the second year would be $1,600.

The equation below illustrates this method:
depreciable base * (2 * 100% / useful life in years)

150% Declining Balance - This method uses 150% of the straight-line
percentage for the first year. The same percentage is then applied to the
remaining balance, each succeeding year.

Declining Balance Custom - This method allows you to enter a custom
declining balance percentage. Declining Balance is a common
depreciation-calculation system that involves applying the depreciation rate
against the non-depreciated balance. Instead of spreading the cost of the
asset evenly over its life, this system expenses the asset at a constant rate,
which results in declining depreciation charges each successive period.

Example:
If an asset that costs $1,000 is depreciated at 25% each year, the

deduction is $250.00 in the first year and $187.50 in the second year, and
so forth.
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e Sum of the Years' Digits - To calculate depreciation charges using the
sum of the years' digits method, take the expected life of an asset (in years)
count back to one and add the figures together.

Example:

10 years useful life=10+9+8+7+6+5+4 + 3+ 2+ 1 Sum of the
years =55

In the first year, the asset would be depreciated 10/55 in value [the fraction
10/55 is equal to 18.18%)] the first year, 9/55 [16.36%)] the second year,
8/55 [14.54%] the third year, and so on. Going back to our example from
the straight-line method: a $5,000 computer with a $200 salvage value and
3 years useful life would be calculated as follows:

3 years useful life =3 + 2 + 1 Sum of the years = 6

Taking $5,000 - $200 we have a depreciable base of $4,800. In the first
year, the computer would be depreciated by 3/6ths [50%], the second year,
by 2/6 [33.33%] and the third and final year by the remaining 1/6 [16.67%].
This would have translated into depreciation charges of $2,400 the first
year, $1,599.84 the second year, and $800.16 the third year. The straight-
line example would have simply charged $1,600 each year, distributed
evenly over the three years of useful life.

Location
Locations are places within a particular Site where Assets reside. Typically, a Site
is a building or area that contains one or more inventory Locations. For instance,
Sebastian's Office might be a location within the site My Company.

Child Asset
An asset that is linked to a parent asset. See the illustration in the Asset Linking
definition, above.

Parent Asset
Any asset that has child assets attached to it. See the illustration in the Asset
Linking definition, above.

Serial Number
If an asset has a Serial Number and you choose to record it, it is associated with a
specific Asset, not with an Asset Type.

Site
The software can manage assets at one or more Sites (specific buildings or
vehicles) depending on the version of the software you have. Typically, a Site is a
building that contains one or more asset Locations. For instance, Sebastian's
Office might be a location within the site My Company. Pay attention to the Site you
are working with when using Asset.
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Logging In

Logging In to MobhileAsset

Logging In Using Windows NT Authentication

Using the Sample Company

Logging In When You Have Access to Multiple Databases (Enterprise Only)

Logging In to MobileAsset Web:
After entering the URL of MobileAsset you will be presented with the Login page.

1. The Login page of the MobileAsset application is where you will enter your user name
and password. An example of this page is shown below:

2. Enter your User Name and Password, then click the Login button. The User Name and
Password are the same as your MobileAsset User Name and Password (set on the Add
New User screen in the MobileAsset PC application).

Click the Help link to access this help file.

The Main Menu will appear. Please refer to the topic Navigating the Main Menu for
more information on this page.

Logging In Using Windows NT Authentication:

If your business is using Windows NT Authentication, MobileAsset will recognize any Groups
setup in the MobileAsset PC application that match a group in the Active Directory and take care
of the user account creation process for you.

1. If Windows NT Authentication is turned on, the first time a user tries to access
MobileAsset from his/her network machine, the standard Windows Network Login
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screen, similar to the one shown below, will appear:

Windows Security I 23 |

Jane Doe

| Passward

[C] Rermember my credentials

Use another account

QK l [ Cancel

2. After entering the user name and password, the OS will check to see if a Group exists in
MobileAsset matching the group this user is assigned to in the Active Directory. If there
is, the user is logged on to MobileAsset and a User Account is automatically created for
this user in the Mobile Asset PC Application (Security > Manager Users).

Using the Sample Company:

If you want to log in using the Sample Company, select the Use Sample Company checkbox,
then click the Login button. This company contains a set of data you can use to learn about
MobileAsset. You can practice using the features and functions contained in the software using
this data. You can enter information into the Sample Company; however, when upgrading to a
new version, this data will be lost. It is very important that you do not enter any information into
the Sample Company that you do not want to lose. The Sample Company is meant for training
purposes only and should not be used as your working database. For more information on using
the Sample Company, please refer to the topic Using the Sample Company.
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Logging In When You Have Access to Multiple Databases (Enterprise Only)

If you have created multiple databases for use with two or more companies, you will see the
Company Selection List after logging on. You will only see this screen if you have access to
more than one database.

Using Windows NT Authentication with Multiple Companies: If you have multiple companies
setup in MobileAsset (see Working with Multiple Companies) and you are using Windows NT
Authentication, the process works much the same as above, except the user will be taken to the
Company Selection List to choose the company they want to work with before entering
MobileAsset.
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Company Selection List

The Company Selection List page appears after you log on to MobileAsset if you have created
multiple databases and you have access to more than one database.

Selecting a Company:

1. After logging in to MobileAsset, you will see a page similar to the following (if you have
created multiple databases and you have access to more than one database). You will
only see those companies to which you have been given access in Security in
MobileAsset on the PC. The first time you log in using the Admin login, you will see all
companies.

' Company Group Name

] Wasp Barcode Technologies

.Test DB 6-4-10 - [
WaspTrackAssetMain | Wasp Team
WaspTrackAssetMain Wasp Development

2. Click on the company you wish to access. MobileAsset will open with the desired
company's information displayed. Note that the title bar at the top of the window
indicates which company you currently have open.

Click Cancel on the Company Selection List to return to the Log In page.

10
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Using the Sample Company

The Sample Company contains a set of data you can use to learn about MobileAsset. You can
practice using the features and functions contained in the software using this data.

You can enter information into the Sample Company; however, when upgrading to a hew version,
this data will be lost. It is very important that you do not enter any information into the Sample
Company that you do not want to lose. The Sample Company is meant for training purposes only
and should not be used as your working database.

Accessing the Sample Company:

1. Onthe Log In page, select the Use Sample Company checkbox, then click the Login
button. The following message appears:

Click OK on the popup message.

2. You can use the software as normal once logged in. You can create additional asset
types and assets, link assets, dispose of assets, etc. When using the Sample Company,
the Main Menu will display Wasp MobileAsset Trial Company in the title bar. On
reports, the company name and each address line will be followed by "trial".

Windows NT Authentication Users:

If you are using Windows NT Authentication, follow these steps to access the Sample Company:

1. Log off MobileAsset Web by clicking the Log Off link on the toolbar:

The Log Out screen will appear.

11
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2. Onthe Log Out screen, click Log In as Different User.

Click LogIn as a
Different User

Click @413 to iagin again

Thank wou for using MohileAsset. Login Az A Differant User
The MobileAsset Web Log In screen appears.

3. Select Use Sample Company, enter your User Name and Password, then click Login.

v MaihiieAssel
_4 o web Editions

il
=

12
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Logging Out

To Log Out of MobileAsset, click the Log Out button from the top of any page.

i ..'.___,

The Log In Again screen will appear:

w

—— -

Click €33 to login again

Thank wou for using Mobileasset, Login Az & Different Uzer

Click the Here button to Log In again or click Login as a Different User.

13
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Login as Different User

If your business is using Windows NT Authentication, the user currently logged into the computer
is automatically logged into MobileAsset. If a different user needs to log in to MobileAsset from a
machine where a user is already logged in, click the Log Out button at the top of the screen.

I HERE RUNETILETELL

Thank wou for using Mobileasset, Login Az & Different Uzer

14
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Navigating the Main Menu

The Main Menu is the first page you will see upon logging in to MobileAsset. You can access all
of the features of MobileAsset from the Main Menu. The Main Menu first appears with the Asset
Management options displayed by default.

Below is an example of the Main Menu:

MobileAsset Main Menu

List Assets
Asset Management

New Asset

List Forms
Move

Administration Check-Out

Check-In

Reports
Transfer Check-Out

Dispose

Maintenance Entry
Reservations

The Main Menu is divided into two sections:
Title Bar

Navigation Window

Title Bar

The Title Bar is visible from any screen in MobileAsset. The database/company currently open
(if you have created more than one database) and the Username of the user currently logged in
display here.

This section also contains the following links:

Home - Click this icon to return to the Main Menu from any screen in MobileAsset.

Logoff - Click this icon to log out of MobileAsset. The Log Off screen will appear allowing you to
log in again or log in as a different user.

15
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About - Click this icon to view information about this version of MobileAsset.

Navigation Window

The Navigation Window displays icons you can use to access various parts of the software.

When you first open MobileAsset, the Asset Management menu will be open. To open another
menu, click on the icon on the left. For example, if the List Forms icon is clicked, the List menu
will appear, as displayed below:

MobileAsset Main Menu

Asset Management

| e

List Forms

Admimst&'o{

Reports

Reservations

Click the
List Forms
icon to view
the List
Menu.

Assets

Asset Types

Contracts/Licenses

Customers

Departments

Depreciation Classes

Employees

Locations

Manufacturers

If an arrow precedes an option, click on the icon to reveal the options:

Security

-_—

Security

[

Change Password

When the menu items are displayed, a down arrow will precede the menu. Click the icon to hide
the menu options.

16
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Changing Your Password

The Change Password feature allows you to change your current password. Keep in mind that if
you are using Windows NT Authentication, changing your password in MobileAsset does not
change your network password. If you change your MobileAsset password, you will need to use
your new password (not your network password) to login to MobileAsset on the web or on the PC.
For more information on Windows NT Authentication, please see the Security topic.

1. To access this feature from the Main Menu, select Administration > Security > Change

Password.

User Mame

Old Password
Mew Password

Confirm Mew Password

=R

2. Enter your old password followed by your new password. Enter your new password
again, then click the OK button to save the changes.

Password Rules:
) Passwords are case sensitive.
. A Password may contain any of the following characters:
A - Z (uppercase & lowercase),

0-9
or any of these special characters: "~1@#$% " &*()_+-=[]1{}I<>?:;.,

17



MobileAsset Users' Manual

About Screen

Click the About icon to view details about your version of MobileAsset and license details.

Below is an example of the About screen:

Mobilefsset Web

(C) 2010 Wasp Barcode Technologies
Build: Version: 6.1 (Buld: 7.29.2010.247)

ersion: Enterprise
Database Mame:
License: Activated )

Warning: This program is protected by copyright law
and internaticnal treaties. Unauthonzed reproduction
or distribution of this program, or any part of it, may
result in severe civil and cniminal penalties, and will
be prosecuted to the maximum extent possible under
the law.

Click Close to close the screen.

18



Adding Information
Adding New Assets

The New Asset page is used to enter a new asset into the database.

The following topics are discussed in this section:

Accessing the New Asset Page
General Tab

Asset Linking Tab
Depreciation Tab

Attachments Tab

Picture Tab

Maintenance Tab

Contracts Tab

Transaction History Tab
Custom Fields Tab

Accessing the New Asset Page:

To access this feature, from the Main Menu select Asset Management > New Asset.

OR

From the Main Menu select New > Asset.

This feature can also be accessed from the Asset List by clicking the New Record button on the

toolbar. For more information on using the list screens, please refer to the topic Working with

Lists.

The New Asset page is divided into several tabs as shown below:
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New Asset
Asset
Asset Tag: Asset Description:

Automatically assigned| |£J
General Asszet Linking Depreciation Picture Attachments Maintenance Contracts Transaction History Custom Fields L4
Site: ! lb Asset Type: - &J
Location: it |£J Asset Type Description:

Department Code: i lb Manufacturer: - &J
Serial No: Model: |i]
Condition: = |¥| Wendor Number: ~ &J
Hyperlink: lb Checkout Length: 0 Days = |0 Hours = | 0 Minute |i]
Additional Info: Lead Time: 0 Days (= |0 Hours 5 | 0 Minute = |¥|

Depreciation Class:
L]
Category:
| Additicnal information about asset. |
(¥] e

New Asset Page > General Tab

An example of the General Tab is shown in the screen shot above.

Pinning: You may notice that some fields on this and other tabs have a Pin icon in front of them.
These fields represent data that can be "pinned". Pinning allows you to "lock” the information
entered into a field. This is convenient if, for example, you are entering multiple new assets for a
particular site and location. You can enter the site and location once, then pin them. The fields
will retain the information you entered through each new entry until you unpin them. In the
example screen shown below, values are entered in the Site, Location and Department Code
fields. These three fields were Pinned by clicking on their pushpins, causing them to look like
this.

X

Click the pushpin again to unlock the field to enter different information.

Click the Pin All icon to pin every field that offers the pinning feature. Click it again to undo
pinning for all fields.

To Create an Asset:

1. Enter information in the required fields. You must enter information in the Asset Tag,
Asset Type, Site, and Location fields.

Note: If you are using Automatic Asset Tags, you do not need to enter anything in the
Asset Tag field. If the Automatic Asset Tags function is turned on (Administration >
Options on the PC version of MobileAsset), the Asset Tag field will appear as follows:
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New Asset

Asset

Asset Tag:

Automatically assigned

General Asset Linking Depreciation Picture Attachments Maintenance

The tag will be generated when you click the Save button or when you click the
button next to the Asset Tag field.

When you select an Asset Type, the following screen will display:

Set Common Asset Fields?

Do you want to populate the asset fields that are in
@ common with the asset type with the asset type

values?

Yes Mo

Select Yes to populate fields with information from the Asset Type such as Check Out
Length, Model Number, Vendor, etc. For example, if Check Out Length information is
entered for the Asset Type, it will appear here.

If you have enabled the Edit Inherited Asset Type Data option on the Options screen,
you can make changes to the information that is populated from the Asset Type. If this
option is not enabled, these fields will be disabled and you will not be able to make
changes.

If you do not want to incorporate information from the Asset Type, other than the Asset
Type number and Description, click No.

The Department Code, Serial No., Condition, Hyperlink and Additional Info fields are
optional.

The Hyperlink field can be used to store a link to the manufacturer's website, or even to
a location on your network. When a valid web address is entered in this field, the icon
next to it will be enabled. Clicking the icon will open your web browser and access the
website.

Note: When using the drop down lists to enter information in a field (Asset Type, Site,
Location, etc.), the last few selections will appear in the list. If you want to search for an
existing value, select <More> from that field's drop down list to access the List screen.

Use the vertical scroll bar to select a record from the List and click the List dialog's
Select button.

21



MobileAsset Users' Manual

4. Click OK if you are done entering information for this asset or click on another tab to
proceed with entering more information.

New Asset Page > Asset Linking Tab

Asset Linking is only available in the Professional and Enterprise versions of MobileAsset.
Asset Linking, also known as Asset Kitting, allows you to link two or more assets together to
form one new asset. For example, the asset Mary's Computer may consist of 4 separate assets -
CPU, Keyboard, Mouse and Monitor. These four individual assets are linked together to form one
new asset, Mary's Computer. For a complete definition of Asset Linking and an example,
please refer to the Definitions topic.

The Asset Linking tab allows you to create links:

automatically assigned
_——

General Asset Linking Depreciation Picture Attachments Maintenance Contracts Transaction History Custom Fields =
|| Transact as Whele - Select this checkbox to indicate that this asset and all of its child assets should be audited/checked-out/checked-in etc., as a group.

Parent Asset:

"
Child Asset(s):
Hélp | m Pin All Print Tag On OK - Copies: 0= “

1. The Asset Tag value entered on the General tab will be displayed at the top, but can still
be edited, if desired.

2. If this asset is to be the Parent, or top-level asset, of this group, you can leave the
Parent Asset field blank. If you want to give this asset a parent (for instance, if this asset
is a monitor and you want to link to the asset Mary's Computer), select an asset from the
drop down list in the Parent Asset field.

The asset can have a parent assigned to it and be a parent (have child assets assigned
to it).

Select <More> from the drop down list to access the Asset List. Remember, you can
filter the asset list to only display "Top Level" assets, or parent assets, if needed. See the
Working with Lists topic for further information.

3. To associate child assets with this asset (the current asset will be the "parent” of these
assets), click the Link button below the Child Asset(s) window. The Asset List will
appear.

Highlight the desired asset in the Asset List, then click the Select button. The selected
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asset will appear in the Child Asset(s) window as shown below:

General Asset Linking Depreciation Picture Attachments Maintenance Contracts Transaction History Custom Fields =

|+ Transact as Whole - Select this checkbox to indicate that this asset and all of its child assets should be audited/checked-out/checked-in etc., as & group.

Parent Asset:
78923 MRS

Child Asset(s):

103 - HP Printer

- wv

In this example, asset number 78923 is the parent of the current asset and 103-HP
Printer is the child.

A Note about the Transact as Whole Flag: In the example above, the Transact as
whole flag is checked; therefore, any functions (check-in, check-out, audit, move, etc.)
will be performed as a whole for the group. This flag is driven from the top down,
meaning the selection made for the parent asset will override the selection for a child
asset. If you want to move only one asset that is a child of this asset, you will need to
deselect this checkbox. Deselecting it on the Edit Asset > Asset Linking tab for the
child asset (in this case, Asset 103) will not override the selection made for this asset,
and this group would still be moved as a whole. Similarly, if the Transact as whole flag
was NOT selected on this tab, but it IS selected for Asset 78923 (the parent of this
asset), the group would still be transacted as a whole because the selections made for
the parent of this asset would take precedence. To put it another way, if you think of
these relationships in the vein of child-rearing, one of your children may decide it is ok to
borrow the car, but you as the parent do not think it is ok. Your decision as the parent
would override that of the child.

Also keep in mind that when you check out an asset that has Transact as whole turned
on and you select to use the Default Due Date (on the Check Out screen) MobileAsset
will search all assets linked to the selected asset to find the maximum checkout duration.
The program will use this maximum length to calculate the due dates for all the linked
assets. This ensures that all the assets in the transaction have the same due date even if
some of the linked assets have different checkout durations.

You can unlink child assets by highlighting the asset in the Child Assets list and clicking
the Unlink button.

Click OK if you are done entering information for this asset or click another tab to
proceed with entering more information.

New Asset Page > Depreciation Tab:
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Click the Depreciation tab if you want the software to calculate depreciation for this asset. The
method used by the system to calculate depreciation is dependent on the Asset Type assigned to
this asset.

The Asset Tag value entered on the General tab will be displayed at the top, but can still be
edited, if desired.

n&set Tag: =t Description:

Automatically assigned
General Asszet Linking Depreciation Picture Attachments Maintenance Contracts Transaction History Custom Fields =
Depreciate Asset: L | Assets of this asset type cannot be depreciated.
Purchase Order: |¥ | Depreciation Begin Date: & |¥J
Purchase Date: = llj Last Depreciation Date:
Purchase Cost: 0.00 5 llj Total Depreciation:
Salvage Value: 0.00 5 |£J Current Depreciation:
Class Info: Book Value:
Help n m Pin All Print Tag On OK - Copies: 0= ﬁ

1. Click the Depreciate Asset checkbox if you want the software to calculate depreciation.
The Depreciate Asset checkbox will be disabled if a Depreciation Class has not been
defined for the Asset Type specified on the General tab -or- that Asset Type has a
Depreciation Class, but its Depreciation Method is "None".

2. The depreciation method used for an asset is determined by the Depreciation
Class assigned to the Asset Type. This information appears in the Class Info box and
cannot be modified from this screen. If you want to change the Depreciation Method or
the Life of a particular asset, you will need to make changes to the Depreciation Class
assigned to the Asset Type, or create a new Depreciation Class to assign to the Asset
Type. See the Depreciation Class help topic for further information.

3. Purchase Cost and Depreciation Begin Date are required fields when Depreciate
Asset has been enabled, therefore, you must complete them if you want to calculate
depreciation. These two fields are used in the calculation. Please see the Definitions
topic for detailed explanations of each Depreciation Method.

4. Purchase Order, Purchase Date and Salvage Value are optional fields. If a Salvage
Value is not specified, the Calculate Depreciation function will assume a Salvage
Value of zero dollars.

The Class Info, Last Depreciation Date, Total Depreciation, Current Depreciation,
and Depreciated Value cannot be modified. Information is populated in these fields by
the system as depreciation functions are performed.

In the following example, an asset is being entered that uses 5-year Straight-Line
depreciation:
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General Asset Linking |ml Picture Attachments
Depreciate Asset: [+ &]

Purchase Order: w
Purchase Date: &J
Purchase Cost: §99.00 & w

Salvage Value:

0.00 5 w

Maintenance

Contracts Transaction History

Depreciation Begin Date | 7/14/2010
Last Depreciation Date:
Total Depreciation:

Current Depreciation:

Custom Fields

E (¥

Class Tnfo: Book Value:
Class: 5 Year Straight Line
Depreciation Method: Straight-Line
Life:
(] v e a5 om0 o | 012 o

5. Click OK if you are done entering information for this asset or click the next tab to

proceed with entering more information

New Asset Page > Attachments Tab

To attach an image or other documentation to this Asset, click on the Attachments tab:

A TSRy a55pred — . L I
General | Asset Linkng Picture Comtracts | Trassaction Mistory | Custom Fields

Amser Artachements
Asses Type Atiachments

Em O

Print Tag On O - Copies:

1. To add an attachment, click the Add button.
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- GRS T om0 3 = 1=

A screen will appear allowing you to navigate to the desired file on your computer.
Attachments are copied to the MobileAsset database from the external source you
browse to when you click the Add button. Any change made to the external source file
after adding the attachment will not update the attachment in the database. To update
the database with a later version of an attached file, you must first Remove the
attachment from the database, then Add the file again.

Asset Attachments relate only to the specific Asset being recorded. Asset Type
Attachments relate to every Asset recorded for this Asset Type.

If you have attached an image, you can designate this the "default" image (meaning this
is the image that will appear on the Picture tab) by clicking the Set Default Image
button.

After you have added at least one file, the View button is enabled. This feature allows
you to view the attached file. The File Associations defined in Windows Explorer
determine which application will be started to open files, based on their filename
extensions. On most machines, a PDF file would be opened by Adobe® Reader, for
example. Image attachments can be viewed the same way or you can use the Picture
tab to use Asset's internal image viewer.

The Save to File button copies the selected attachment from the database to any drive
and folder available on your system.

The Remove button can only be used to Remove Asset Attachments. It is grayed-out
(disabled) when an Asset Type Attachment is selected. These Asset Type
Attachments may be related to other Asset Tags under the same Asset Type. Asset
Type Attachments can only be removed via the Edit Asset Type Attachments tab (see
Creating New Asset Types for further information.).

Attachments are not actually added to the database until the OK button is clicked. You
can click it at this time if you are finished adding additional information, or click it later,
after you have completed information on other tabs.

New Asset Page > Picture Tab

Click the Picture tab to view any image files that have been attached to either the Asset Type
Attachments folder or the Asset Attachments folder.
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1121 Philips Monitor

General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields =

Hel;; Print Tag On OK - Copies: 0 : ﬁ E

1. The first time you access this tab it will be blank if a default picture has not been added
on the Attachments tab either on the Add/Edit Asset screen or the Add/Edit Asset
Type screen (for the Asset Type assigned to this asset).

The current default picture is always displayed on the Picture tab. Right click the image
to see the popup Picture menu. This menu allows you to Add (a new) Image or to
Select (a previously added) Image. Any image you select for display will become the
new default image.

The files listed in the Select Image sub-menu are a combination of Asset Type
Attachment images and Asset Attachments images, sorted alphabetically, by filename.

2. Image files are not actually added to the database until the OK button is clicked. You can
click it at this time if you are finished adding additional information, or click it later, after
you have completed information on other tabs.

New Asset Page > Maintenance Tab

The Maintenance tab allows you to define maintenance procedures, a maintenance schedule,
and warranty information for an Asset.

This tab allows you to:

Enter Warranty Information

Enter New Maintenance Schedules
Edit Existing Maintenance Schedules
View Maintenance History

Below is an example of the Maintenance tab:
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Automatically assigned

General || Assetlinking | Depreciation | Picture | Attachments |Maintenamcew| Contracts | Transaction History | Custom Fields =

Warranty
( Warranty Begin: Warranty End: Warranty Provider: \

List of Maintenance Schedules:

I
Assigned m} Dﬁtﬁﬂﬁ)lll Ocl:llrs‘ Next Date‘

e [~ sase—
(5] o o Tag onox-comer o2 o o]

Entering Warranty Information:

1. You can optionally enter Warranty Begin and End dates and a Warranty Provider at
the top of this tab.

Click on the Calendar icon to access the calendar feature:

Automatically assigned

General Asset Linking Depreciation Picture Attachments Co
*Warranty
Warranty Begin: @ Warranty End:

List of Maintenance |

AssignedtnI Desi

11 12 [13] 14 15 16 17 || Clickonthe arrows
R e e e to scoll through the

months.
25 26 27 28 29 30 31

You can also click on the Month/Year (August, 2009 in the example above) to view a list
of all months. You can then click on a month to quickly switch dates:
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‘ Automatically assigned @

General Asset Linking Depreciation Picture Attachments | Maintenance

*Warranty
{ Warranty Beain: | Warranty End:
: : 1 2010 Fo|
Assigned tﬂ| Desi  1an Feb Mar Apr [
May Jun Jul Aug
You can click ona

month or use the
sep Oct Nowv Dec | arrows to scroll to
a different year.

2. You can optionally enter the warranty provider in the Provider field.
Entering New Maintenance Schedules:
To enter a new maintenance schedule:

1. Click the New button below the window:

Assigned to Desu:ripliun| 0c1:urs| Mext Date
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The Maintenance Schedule screen appears:

Maintenance Mame:

Assign to: =

Occurs: Date =
Date

[ 7/13/2010 (]

Mext Date: Tuesday, July 13, 2010

Instructions:

e

2. Enter a name for this maintenance schedule.

3. Select the employee who this asset will be assigned to from the Assigned To drop down
list. All employees currently set up in your software will appear in the drop down list.

4. Select how often this maintenance schedule is to happen from the Occurs drop down
list. The area below the Occurs drop down list will change depending on the selection
you make here. Your options are:

e Date - This option indicates a one-time maintenance procedure. When you
select this option, a Date field will appear below the Occurs drop down list.
Select the date on which the maintenance should take place. You can click on
the calendar icon to select a date or type a date directly into the field.
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| Occurs: |

i Date

| [ 7/13/2010 e
| Mext Date: Tuesday, July 13, 2010

Daily - This option allows you to specify a Maintenance Start date, followed by a
frequency specified as Every x number of days (up to a maximum of every 366
days).

In this example, maintenance would be performed every 10 days beginning
Tuesday, July 13, 2010.

| Occurs: Daily . !
E : !
| ¢ Daily |
Maint Start: 7/13/2010 | |
| Every 10 & day(s)
| Next Date: Tuesday, July 13, 2010
|

The Next Date at the bottom of the screen indicates the next date maintenance
will be performed on this asset.

Weekly - This option allows you to specify a Maintenance Start date, followed
by the frequency specified as Every x number of weeks. You will also select the
days of the week on which the maintenance is to be performed. More than one
weekday can be selected.

In this example, maintenance will be performed every week on Fridays beginning
July 16, 2010.

| Deecurs: Weelkly e |

| |
| - Weekly [
| |
[ Maint Start: 7/16/2010 [E| |
[ Every 1 : week(s) on: |
1
I || Sun [ | Mon [ | Tue || Wed I
[ || Thu |+] Fri | | zat |
| |
Mext Date: Friday, July 18, 2010 |

The Next Date at the bottom of the screen indicates the next date maintenance
will be performed on this asset. In this example, since we have selected Friday
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32

as the maintenance day, the Next Date is Friday, July 16, 2010.

Monthly - This option allows you to specify a Maintenance Start date, followed
by your choice of two possibilities: Maintenance Every x number of months (up
to a maximum of every 99 months) as shown below:

In this example, maintenance will occur on the 1st day of each month every
month.

Dccurs: -
Monthly
Maint Start: 7/16/2010 [m=]
(*) Day 1 : of every 1 : meonth(s)
of every = month(s)
Mext Date: Sunday, August 01, 2010

Notice the Next Date reflects the first day of the next month.

OR

Maintenance can be set to occur on a specific weekday of every x number of
months (up to a maximum of every 99 months) as shown below:

Oceurs: Monthly -
Monthly
Maint Start: 7/16/2010 [=H]
() Day = of every & month(s)
(») | 1st - .Thursday v. of every 1 : month(s)

Mext Date: Thursday, August 05, 2010

In this example, maintenance will occur on the first Thursday of every month.
Notice the Next Date reflects the first Thursday of the next month from the Start
Date.

Disable - This option is used when you want to temporarily disable an existing
maintenance schedule. Highlight the maintenance schedule in the list, then click
Edit. On the Maintenance Schedule screen, select Disabled from the Occurs
drop down box. You can also set up a new maintenance schedule as Disabled
then enable it later by select Daily, Weekly, etc.

5. Click Save when you are done entering information for this maintenance schedule. The
schedule will appear in the list on the Maintenance tab:
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Warranty

{ Warranty Begin:

[#E|| Warranty End:

List of Maintenance Schedules:

Assigned to Description Occurs | Next Date |

Bradley, Pittsburg | Battery Replacement | Monthly | 7/13/2010

Em -

Editing Existing Maintenance Schedules:

1.

Highlight the maintenance entry you want to edit, then click the Edit button. The
Maintenance Schedule screen will appear populated with the selected entry's
information.

Make changes as necessary, then click the Save button. The edited entry will appear in
the list on the Maintenance tab.

Viewing Maintenance History:

The Maintenance History screen displays all completed maintenance on this asset.

1.

3.

Click the View History button. The Maintenance History screen will appear:

<SS>

When you first access this screen, all maintenance entries associated with the selected
maintenance schedule are displayed. You can change the selected schedule using the
Schedule drop down menu. You can also enter From and To dates to further filter the
list.

Click the Show All button to remove the filter.

4. Select the Print History button to print a list of the displayed maintenance entries.

New Asset Page > Contracts Tab

The Contracts tab allows you to record contract and/or software licenses associated with this
asset. The tab will appear empty when you are first adding a new asset. You can add contracts
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and licenses to this asset as needed from this tab. Contracts/licenses can be added to the
database via the Contracts List screen.

Butomatically assigned

General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields -

Select from the full contract list

Begin Date Description Contract Number Cost End Date Internal Contact Software Hyperlink Licenses Vendor Number

= JUET oo -0 % —>—]

1. To add a contract/license, click the Add button. The Contracts List will appear. Select
the desired contract from the list, then click Select on the Contracts List screen. The
selected contract will appear on the Contracts tab as shown in the example below:

Automatically assigned

General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields

Select from the full contract list

Begin Date Description Contract Number Cost End Date  Internal Contact Software Hyperlink Licenses Vendor Number
|10f23f2007 Contract 3 for Software 3 0.00| 10/23/2008 = Al =

2. You can remove a contract by highlighting it in the window, then clicking the Remove
button.

Click Select All to select all contracts in the window.
Click Clear All to deselect all contract in the window.

3. Click OK if you are done entering information for this asset or click the next tab to
proceed with entering more information

New Asset Page > Transaction History Tab

The Transaction History tab displays data only after one or more Asset Management
transactions have been performed (check-in, check-out, etc.). Keep in mind that this tab will be
blank when you are setting up a new asset. The example below shows the Transaction History
tab as it might appear on the Edit Asset screen.
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1121 =1l Optiplex GX270

General Asset Linking Depreciation Attachments Picture Maintenance Contracts m} Custom Fields b
Time Type Action User Name
7/7/2010 10:40:06 AM Check-0Out To employee: 1 - from hardware filter category, ckout <2 asset tag to empl 4 with new locat wilson Stock Admin, User
7/7/2010 10:40:04 AM Move From: Helpdesk 1_ at The Wilson Hospital - Admin, User
7/7/2010 10:40:04 AM Mowve To: Stock Room 1_ at The Wilson Hospital - Admin, User
7/6/2010 11:45:56 AM | New Asset Admin, User

Print Transactions
" o]

Click Print Transactions to send a list of the transactions for this asset to the printer.

Click OK if you are done entering information for this asset or click another tab to proceed with
entering more information.

New Asset Page > Custom Fields Tab

Please refer to the Using Custom Fields topic for instructions on creating custom text, number
and date fields.

utomatically zssigned
General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields hd
~Text ~ Number
Custom Text 1: - Custom Number 1: 0.0000 :
Custom Text 2: = Custom Number 2: 0.0000 &
Custom Text 3: - Custom Number 3: 0.0000 (&
Custom Number 4: g =
Custom Text 4: - 0000 i
Custom Number 5: 0.0000 15
Custom Text 5: -
Custom Text 6: i I i
Custom Date 1: )
Custom Text 7; - —
Custom Date 2: ES)|
Custom Text 8: - Custom Date 3: E
Custom Text 9: - Custom Date 4: E
Custom Text 10: - Custom Date 5: @
() o o nox a2 o ] o

If the Close New Form option is enabled on the Options screen and no fields are pinned, the
screen will close when the OK button is clicked.
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Create New Asset Type

The Create New Asset Type screen allows you to enter a new Asset Type in the database. The
asset type is a category for assets. Assets are assigned to a specific asset type. For instance,
you may have an Asset Type of Label Printers that defines the manufacturer, size specs, etc. of
this particular type of printer. Then specific printers of the same type are assigned to the Label
Printers asset type.

Accessing the New Asset Type Screen
Using the General Tab

Using the Attachments Tab

Using the Picture Tab

Using the Custom Fields Tab

Accessing the New Asset Type Screen

1. To access the screen from the Main Menu, click New > Asset Type.

The New Asset Type screen can also be accessed from the Asset Type List by clicking
the New button on the toolbar. For more information on using the List screens, see the
Working with Lists topic.

2. Complete the information on the screen. The New Asset Type screen is divided into
tabs: General, Attachments, Picture, Custom Fields

New Asset Type Screen > General Tab
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e

[ Asset Type: |
| Description:
General Attachments Picture Custom Fields =
| Manufacturer: - Dimensicns
|
| Model: Length:
| Wendor Number: % Width:
ight: |
Drepreciation Class: % Height: |
[ |
| Categery: £l Weight:
| Checkout Length: 0 days 5 Ohrs 5 0 mins (5
| Lead Time: 0 days 5 Ohrs 5 0 mins 5
[ Hyperlink: |
|
|
o =
- - |

1. Enter the name of the Asset Type in the Asset Type field.. All other fields, including
Description, are optional.

Asset Types must be unique across all Sites and Locations. A particular value can
occur only once in the software database.

e Select a Manufacturer from the drop down list or create a new one by entering
the new value and clicking OK to launch the Create New Manufacturer screen.

¢ Enter a Model name or number for the Asset Type.

e Selecta Vendor Code from the drop down list or create a new one by entering
the new value and clicking OK to launch the Create New Vendor screen.

e Select a Class from the drop down list or create a new one by entering the new
value and clicking OK to launch the Create New Depreciation Class screen.

e Select a Category from the drop down list or create a new one by entering the
new value.

e Optionally enter the Length, Width, Height and/or Weight for this Asset Type.
These are text fields in which the units of measure can be specified along with
the dimension or weight. (5 mm, 10 in, 3 Ibs, etc.)

e Checkout Length specifies the default period, in days, that assets assigned to
this Asset Type may be checked-out to a customer or an employee. Keep in
mind that you can set the check out length to only consider weekdays and the
due date to only fall on a weekday on the Options screen.
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e Lead Time indicates how long after an asset is received, checked in, etc. before
it is available. The lead time allows time for recalibration, cleaning, etc.

e The Hyperlink field can be used to store a link to the manufacturer's website, or
even to a location on your network. When a valid web address is entered in this
field, the icon next to it will be enabled. Clicking the icon will open your web
browser and access the website.

e If you want to search for an existing value, select <More> from that field's drop
down list to open the relevant List screen. Use the vertical scroll bar to select a
record from the List and click the List screen's Select button.

New Asset Type Screen > Attachments Tab

To attach an image or other documentation for this Asset Type, click on the Attachments tab:

General Attachments Picture Custom Fields hd
~ Attachments
AAsset Type Attachments
MobileAsset_ QSG_0210.pdf
| Add
Remove
Set Default Image
| Save To File

1. To add an attachment, click the Add button. A screen will appear allowing you to
navigate to the desired file on your computer. Attachments are copied to the MobileAsset
Web database from the external source you browse to when you click the Add button.
Any change made to the external source file after adding the attachment will not update
the attachment in the database. To update the database with a later version of an
attached file, you must first Remove the attachment from the database, then Add the file
again.

2. If you have attached an image, you can designate this the "default" image (meaning this

is the image that will appear on the Picture tab) by clicking the Set Default Image
button.
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After you have added (and saved) at least one file, the View button is enabled. This
feature allows you to view the attached file. The File Associations defined in Windows
Explorer determine which application will be started to open files, based on their filename
extensions. On most machines, a PDF file would be opened by Adobe® Reader, for
example. Image attachments can be viewed the same way or you can use the Picture
tab to use MobileAsset Web's internal image viewer.

The Save to File button copies the selected attachment from the database to any drive
and folder available on your system.

Attachments are not actually added to the database until the OK button is clicked. You
can click it at this time if you are finished adding additional information, or click it later,
after you have completed information on other tabs.

New Asset Type Screen > Picture Tab

Click the Picture tab to view any image files that have been attached to this Asset Type.

General

—Tiescription:

Attachments Picture Custom Fields

Ll

(—eip | G|
1. The current default Picture is always displayed on the Picture tab. Right click the image

to see the popup Picture menu. This menu allows you to Add (a new) Image or to
Select (a previously added) Image. Any image you select for display will become the
new default image.

The files listed in the Select Image sub-menu are a combination of Asset Type
Attachment images and Asset Attachments images, sorted alphabetically, by filename.

Image files are not actually added to the database until the OK button is clicked. You can

click it at this time if you are finished adding additional information, or click it later, after
you have completed information on other tabs.
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New Asset Type Screen > Custom Fields Tab

General Attachments Picture | pGustom Fields. 5
~ Text ~ Number
Custom Text 1: lbanana EI Custom Number 1: 0.0000 5
Custom Text 2 = Customn Number 2: 0.0000 5
3 -
R ord e . Custom Number 3: 0.0000 (5
Customn Number 4: 0.0000 5
Custom Text 4: - z
Custom Number 5: 0.0000 5
Custom Text 5: -
~ Dat
Custom Text &6: - ik
Custom Date 1: @
Custom Text 7t -
Custom Date 2: =
Custom Text 8: - Custom Date 3: @
Custom Text O: - Custom Date 4: @
Custom Text 10: - Custom Date 5: =

i
=
f

Please refer to the Using Custom Fields topic for instructions on creating custom text, number
and date fields.
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Create New Contract/License

Contracts/Licenses can be entered into the database so you can associate them with specific
assets. For example, you may have 15 licenses for Microsoft Windows and each license is
assigned to a different computer. You can track which assets those licenses are tied to by

associating the license with the assets on the New/Edit Asset screens.

1. To create a new contract/license, from the Main Menu, click New > Contract/License.

The New Contract screen can also be accessed from the Contract List by clicking the
New Record button on the toolbar. For more information on using the List screens, see
the Working with Lists

topic.

New Contract
General Attachments Custormn Fields
Contract Number: Vendor Number:
Description: Licenses:
1 || software:

Internal Contact: Begin Date: End Date:
7/16/2010 = 7/16/2011

i

Hyperlink: Cost: |_J Mo End Date

2 0.00 2

Associated Assets ,

Asset Tag Asset Type Asset Type Description Site Location

:

oo

2. Complete the requested information at the top of the page.

When you enter a Vendor, the icon next to the field is enabled as shown below:

Vendor Number:

3

Licenses:

Click on this icon to open the Edit Vendor page so you can view this vendor's
information.
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You can optionally enter a hyperlink for this vendor. This can be a hyperlink to the
vendor's website or to a document stored on your network. Cost is also an optional field.
You can enter cost here, but keep in mind it is not tracked in MobileAsset.

You can associate assets with this contract/license by clicking the Associate button.
The Asset List appears. Highlight the desired listing, then click the Select button on the
Asset List. The selected asset appears in the Associated Assets grid as shown below:

Hyperlink: Cost:
2 0.00 [
Associated Assets )
Asset Tag Asset Type Asset Type Description Site Location 1

Ll 3

T ==
S

You can remove an asset by highlighting it in the grid and clicking the Remove button.

If you associate an asset to a contract/license from this screen, this contract will display
on the asset's Edit Asset screen > Contracts tab.

4. Click OK save your changes.
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Create New Customers

The Create New Customer page, allows you to enter a new customer into the database. Assets
can then be checked-out to that customer.

1. To access this screen, from the Main Menu click New > Customer. The New Customer
page appears

The New Customer page can also be accessed from the Customer List by clicking the
New Record button on the toolbar. For more information on using the List screens, see
the Working with Lists topic.

In addition, the New Customer screen can also be opened automatically from the
Check-Out screen if an unknown Customer is entered.

Below is an example of the New Customer screen.

S ]

General Information Additicnal Information Custom Fields ol

New Customer

Customer No.: MName:
Company MName: Department:
Date Added: 7f14/2010 |

~ Address

Address Type: Customer Billing -
Address 1:

Address 2:

Mail Stop: City:

State: Postal Code:

Country:

=1 o

2. Complete the information on the screen. Only the Customer No. and Address Type
fields are required.

Select an Address Type from the drop down list, then provide any of the associated
information you have for this customer: Address 1, Address 2, Mail Stop, City, State,
Postal Code and Country. Address information can be entered for each Address Type
you select.

3. The Additional Information tab provides optional fields where other information about
the Customer can be recorded: Phone, Extension, Fax, Cell No., Home No., Email
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and Notes.

Notes is a text field available to record any additional information you might have about
this Customer. See the Notes topic.

New Customer "

General Information | Additional Information . Custom Fields x|

~ Additional Information

Phone: | Extension: | |

Home Mo:

Email:

|

Fax: | | Cell Phone: | |
|
|

Motes:

Add Mote

= o)

For information about the Custom Fields tab, see Using Custom Fields.

4. When the Close New Form option is turned off: Click Save to commit your entry or
click Close to exit the form.

When the Close New Form option is turned on: Click OK to commit your entry and exit
the form or Cancel to exit the form without saving your entry.
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Create New Department

The Create New Department screen allows you to enter a new Department to which an asset
and/or employee is assigned.

1. To access this page from the Main Menu select New > Department.
The Create New Department page can also be accessed from the Department List by

clicking the New Record button on the toolbar. For more information on using the Lists,
see the Working with Lists topic.

~ Department

Department Code:

Department Name:

=1 =~

2. Complete the fields on this screen. All fields are required. (Example: "GA" and
"Graphic Arts")

3. Click OK after entering information to save the new record.’
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Create New Depreciation Class

The Create New Depreciation Class page allows you to specify what Depreciation Method, if
any, should be used to calculate depreciation for an Asset Type associated with the Class, and
for what period.

Note: While you can create depreciation classes to assign to asset types in MobileAsset, the
Calculate Depreciation feature is only available in the software version of MobileAsset.

1. To access this screen from the Main Menu click New > Depreciation Class.

The Create New Depreciation Class page can also be accessed from the Depreciation
Class List by clicking the New Record button on the toolbar. For more information on
using the List screens, see the Working with Lists topic.

| Name: |
|

Depreciation Method: Mone g '

Custom Percentage:

Y
0 Months —

Life: 0 Years =

2

Fully depreciate to salvage value

|
|
oo ]

2. Complete the fields on this screen. Name and Depreciation Method are required fields.

It is a good idea to use a descriptive Class name that incorporates some indication of the
depreciation method and the Years/Months you intend to specify for depreciation classes
(with Depreciation Method other than None). (Examples: DepNone, DepSL5yr,
DepSL1yrémo, etc.)

Select the depreciation method you would like to use from the Depreciation Method
drop down menu. Selecting None from the list specifies that depreciation is not to be
calculated for Asset Types of this Class. Please refer to the Definitions section for
detailed definitions of each depreciation type.

Fully depreciate to salvage value option: If you select Double Declining, Custom or
150% Declining, the Fully depreciate to salvage value option will be enabled. Leave
this checkbox selected (default) if you want MobileAsset to fully depreciate your assets to
the salvage value.

Example: Assume you select double declining balance over five years, and enter a

salvage value (entered on the Create New Asset screen) of $20.00. Assume that after 4
years, following the double declining balance method, the asset may have depreciated to
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$40.00. In this situation, if this checkbox is selected, MobileAsset will lower the value of
the asset to the salvage value - $20.00 in this case - at year 4 despite what the actual
depreciated value is.

Uncheck the Fully Depreciate option if you do not want MobileAsset to fully depreciate
the asset.

3. Click OK when you have completed the screen.

If any method other than None has been selected, information must be entered in the Years
and/or Months fields.
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Create New Employee

The New Employee page allows you to enter a new employee into the database. Employees,
like customers, can have assets checked-out to them.

Accessing the New Employee Page
Using the General Tab

Using the Attachments Tab

Using the Picture Tab

Using the Transaction History Tab
Using the Custom Fields Tab

Accessing the New Employee Page:
1. To access the screen from the Main Menu click New > Employee.
The New Employee page can also be accessed from the Employee List by click the

New Record button on the toolbar. For more information on using the Lists, see the
Working with Lists topic.

In addition, it can also be opened automatically from the Check-Out screen if an
unknown Employee is entered.

2. The First Name, Last Name, Employee No., and Address Type fields are required and
must be completed. The remaining fields are optional.

3. The New Employee page is divided into tabs: General, Attachments, Picture,
Transaction History, Custom Fields.

New Employee Screen > General Tab
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Employee
First Name: Last Name:
Employee No: Title:
| @General | Attachments Picture Transaction History Custom Fields =
Department: gd Manager No: .
Phone Type: Work Phone - Phone: Ext:
Email:
Address Type: Work Address hd
Address 1:
Address 2:
Mail Stop: City:
State: Postal Code:
Country:
Motes:
.

If you intend to use the optional Manager field when creating one or more Employees, you must
create all the manager Employees ahead of non-manager Employees, working through your
organizational chart from the top down.

Select an Address Type from the drop down list, then provide any of the associated information
you have for this Employee. Address information can be entered for each Address Type you
select.

New Employee Screen > Attachments Tab

To attach an image or other documentation for this Employee, click on the Attachments tab:
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General Attachments Picture Transaction History Custom Fields
~ Attachments

Al

Employee Attachments

Adding Attachments:

1. To add an attachment, click the Add button. A browser window will appear allowing you
to navigate your computer to find the desired file.

If you are adding a picture, and want to make it the "default" image (the image that
displays first on the Picture tab) click the Set Default Image button.

2. Click Save to add the file.

Attachments are copied to the MobileAsset database from external sources you browse
to when you click the Add button. Any change made to the external source file after
adding the attachment will not update the attachment in the database. To update the
database with a later version of an attached file, you must first remove the attachment
from the database, then add the file again.

Viewing Attachments:

To view an attachment that is already attached to the employee record, click the View button.
The File Associations defined in Windows Explorer determine which application will be started to
open files, based on their filename extensions. On most machines, a PDF file would be opened
by Adobe® Reader, for example. Image attachments can be viewed the same way or you can
use the Picture tab to use MobileAsset's internal image viewer.

Removing Attachments:
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To remove an attachment from the database, highlight the item in the Attachments window, then
click Remove.
Saving to File:

The Save to File button copies the selected attachment from the database to a location you
specify on your computer.

Note: Attachments are not actually added to the database until the OK button is clicked.

New Employee Screen > Picture Tab

Click the Picture tab to view any image files that have been attached to this employee.

Employee No: o0

General Attachments Picture Transaction History Custom Fields

The current default picture is always displayed on the Picture tab. Right click the image to see a
pop up menu. This menu allows you to Add (a new) Image or to Select (a previously added)
Image. Any image you select for display will become the new default image.

The files listed in the Select Image sub-menu are sorted alphabetically, by filename. (In the
example shown, only one image file has been attached to this Employee record.)

Note: Image files are not actually added to the database until the OK button is clicked.

New Employee Screen > Transaction History
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The Transaction History tab displays the assets check-out to the employee and any assets the
employee previously had checked-out that have been checked back in. Keep in mind that this
tab will be blank when you are setting up a new employee. The example below shows the
Transaction History tab as it might appear on the Edit Employee screen.

} oyee No? /_\\
____‘_.___,_r_-ﬂ/
— e
General Attachments Picture | Transaction History. Custom Fields =
Time | Type | Action | User Name
7/8/2010 1:27:51 P| Check-Out 78943 «-—- (1: 1) ckout parent 2 v| Shirley Zay
7/8/2010 1:27:51 P| Check-Out 78942 «--- (1: 1) ckout parent 2 | Shirley Zay
7/8/2010 1:27:51 P| Check-Out 78941 «--- (1: 1) clkout parent 2 v| Shirley Zay
7/8/2010 1:27:51 P| Check-Out 78940 «--- (1: 1) ckout parent 2 | Shirley Zay
7/8/2010 1:27:51 P| Check-Out 78939 «--- (1: 1) ckout parent 2 v| Shirley Zay
7/8/2010 1:27:51 P| Check-Out 78938 «--- (1: 1) ckout parent 2 | Shirley Zay
7/8/2010 1:27:51 P| Check-Out 2 «--- (1: 1) ckout parent 2 with | Shirley Zay

|Print Transactions |

o o

You can print a list of these transactions by selecting the Print Transactions button.

New Employee Screen > Custom Fields
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T Employee No: itle: Tes
General | Attachments Picture | Transaction History || GustemiFieldss =
~ Text ~Mumber
Custom Text 1: N Custom Number 1: 0.0000 (5
Custom Text 2: B Customn Numnber 2: 0.0000 (5
' F Y
Custom Text 3: - Custom Number 3: 0.0000 =
Custom Mumnber 4: : =
Custom Text 4: i 0.0000 =
Custom Number 5: 0.0000 5
Custom Text 5: -
Custom Text &: " A Rtes
Custom Date 1:
Custom Text 7:
M Custom Date 2:
Custom Text 8: FE Custorn Date 3:
Custom Text 9: - Custom Date 4:
Custom Text 10: v Custom Date 5:

See the Using Custom Fields topic for instructions on creating custom text, number and date
fields.
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Create New Location

The New Location page allows you to enter a new Location for an existing site to the database.
Locations are places within a particular Site where assets reside. Typically, a Site is a building
that contains one or more inventory Locations. For instance, Sebastian's Office might be a
location within the site My Company.

54

1. To access the New Location page from the Main Menu click New > Location. The

New Location screen appears.

You can also access the New Location screen from the Location List by clicking the
New Record button on the toolbar. For more information on using the Lists, see the
Working with Lists topic.

Site: i_,: |

Description:

Notes:

Add Mote

=S

2. Enter the requested information on the screen. The Site and Location fields are

required. If you enter a site that does not exist in the database, the system will ask if you
want to create the new site now.

Description allows you to enter a description of the Location. This is useful when the
Location name is abbreviated (For example, Location "A7B2" could be described as
"Aisle 7 Bin 2".)

Notes is a text field available to record any additional information you might have about
this Location. Click the Add Notes button to edit the Notes field.

For information about the Custom Texts and Custom Numbers and Dates tabs, see
Using Custom Fields.
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4. When the Close New Form option is turned off: Click Save to commit your entry or click
Close to exit the form.

When the Close New Form option is turned on: Click OK to commit your entry and exit
the form or Cancel to exit the form without saving your entry.

Users setup in the Admin Group in Security can limit use of MobileAsset Web to a single Site.
See the Set Default Working Site help topic for more information.
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Create New Manufacturer

The Create New Manufacturer page allows you to enter a new Manufacturer in the database.
Manufacturers can be assigned to Asset Types.

If a Manufacturer is also your Vendor for an Asset Type, it is best to define the company in the
software as a Vendor, in addition to defining it as a Manufacturer.

1. To access this screen, from the Main Menu, click New > Manufacturer. The New
Manufacturer page will appear.

The New Manufacturer page can also be accessed from the Manufacturer List by
clicking the New Record button on the toolbar. For more information on using the List
screens, see the Working with Lists topic.

General Information Additional Information Custom Fields

Name:

~ Address
Address Type: Manufacturer Billing

Address 1:

Address 2:

Mail Stop: City:

State: Postal Code:

Country:

Phone: Fax:
Email:

Web Site:

2. Complete the information on the screen. The Name and Address Type fields are
required; all other fields are optional.

Select an Address Type from the drop down list, then provide any of the associated
information you have for this Manufacturer: Address 1, Address 2, Mail Stop, City,
State, Postal Code and Country. Address information can be entered for each

Address Type you select.

Different Phone, Fax, Email and Web Site information can be entered for different
Address Types.

3. The Additional Information tab provides optional fields where other information about
the Manufacturer can be recorded: Contact Name, Contact Phone, Extension,
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Contact Cell No., Contact Fax and Notes fields.

Notes is a text field available to record any additional information you might have about
this Manufacturer. Click the Add Notes button to edit the Notes field.

New Hanuﬁlcturér

Aodetins 1 £ a

General Information

~ Contact Personal Information

Contact Name: |

Contact Phone:

Extension:

Contact Fax:

| |
| |
Contact Cell No: | |
| |

MNotes:

Add Note
(Cioe |

4. For information about the Custom Fields tab, see Using Custom Fields.

5. When the Close New Form option is turned off: Click Save to save your entry or click
Close to exit the screen.

When the Close New Form option is turned on: Click OK to save your entry and exit the
form or Cancel to exit the screen without saving your entry.
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Create New Site

The New Site page allows you to add a new Site to your database. Typically, a Site is a building
that contains one or more asset Locations. For instance, Sebastian's Office might be a location
within the site My Company. Pay attention to the site you are working with when using
MobileAsset.

Users setup with Administrative Privileges in Security can limit use of MobileAsset to a single
Site. See the Set Working Site help topic for more information.

It is not uncommon to use this product with only one Site defined. A minimum of one Site is
required.

1. To access the New Site page from the Main Page click New > Site. The New Site
screen appears.

The New Site screen can be accessed from the Site List by clicking the New Record
button on the toolbar. For more information on using the Lists, see the Working with

Lists topic.
nwste T

Site:

Description:

Motes:

s m

2. Description allows you to enter a description of the Site. This is useful when the Site
value is unclear (For example, Site "H7" could be described as "Hangar 7".)

Notes is a text field available to record any additional information you might have about
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this Site. Click the Add Notes button to edit the Notes field.

For information about the Custom Fields tab, see Using Custom Fields.

When the Close New Form option is turned off: Click Save to save your entry or click
Close to exit the screen.

When the Close New Form option is turned on: Click OK to save your entry and exit the
form or Cancel to exit the screen without saving your entry.
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Create New Vendor

The Create New Vendor page is used to enter a new vendor into the database. Vendors can be
assigned to Asset Types.

60

1. To access the screen, from the Main screen click New > Vendor. The New Vendor

screen appears.

The New Vendor page can also be accessed from the Vendor List by clicking the New
Record button on the toolbar. For more information on using the List screens, see the
Working with Lists topic.

If a Vendor is also your Manufacturer for an Asset Type, it is best to define the
company in the software as a Manufacturer, in addition to defining it as a Vendor.

General Information Additional Information Custom Fields =

New Vendor

Vendor Code:

Name:

- Address
Address Type: Wendor Billing hd
Address 1:

Address 2:
Mail Stop: City:
State: Postal Code:

Country:

Phone: Fax:
Email:

Web Site:

==

2. Enter the requested information on this screen. The Vendor Code and Address Type

fields are required. All other fields are optional.

Select an Address Type from the drop down list, then provide any of the associated
information you have for this Vendor: Address 1, Address 2, Mail Stop, City, State,
Postal Code and Country. Address information can be entered for each Address Type
you select.

A different Phone, Fax, Email and Web Site can be entered for different Address
Types.

The Additional Information tab provides optional fields where other information about
the Vendor can be recorded: Contact Name, Contact Phone, Extension, Contact Cell
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No., Contact Fax and Notes fields.

Notes is a text field available to record any additional information you might have about
this Vendor. Click the Add Notes button to edit the Notes field.

General Information

~ Contact Personal Information

Contact Name: |

Contact Phone:

Extension:

Contact Fax:

| |
| |
Contact Cell No: | |
| |

Motes:

Add Note
==

4. You can optionally enter information on the Custom tabs. For information about the
Custom Fields tab, see Using Custom Fields.

5. When the Close New Form option is turned off: Click Save to save your entry or click
Close to exit the screen.

When the Close New Form option is turned on: Click OK to save your entry and exit the
form or Cancel to exit the screen without saving your entry.
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Using Custom Fields

Custom fields allow you to enter information specific to your company in MobileAsset. In the
MobileAsset PC application you can set custom fields that will appear for all users. In the
MobileAsset Web Module you can enter custom text, numbers or dates on specific screens.
Custom Field tabs are available on the following screens:

New/Edit Asset Screen

New/Edit Asset Type Screen
New/Edit Contract/License Screen
New/Edit Employee Screen
New/Edit Location Screen
New/Edit Manufacturer Screen
New/Edit Site Screen

New/Edit Vendor Screen

If a custom field has been set in the MobileAsset PC application and made visible and/or
required, you will see it on the Custom Field tab. For example, if you make a custom drop down
list in a custom text field for the New/Edit Asset screen and make it required, all users who create
or edit assets in the MobileAsset Web Module will see the field on the Custom Field tab and will
have to complete it before they can save the asset.

You can also enter information in a custom field specific to just that instance. This type of custom
text/number/date will only be visible on that specific asset, asset type, contract, etc.

Below is an example of the Custom Fields tab on the New/Edit Asset screen:

Gtomatically assigned
General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields s
~Text ~ Number
Custom Text 1: - Custom Number 1: 0.0000 (5
Custom Text 2: . Customn Number 2: 0.0000 (5
. -
Custom Text 3: = Custom Number 3: 0.0000 &
Custom Number 4: 5 =
Custom Text 4 - 00000 b
Custom Number 5: 0.0000 H5
Custom Text 5: -
Custom Text 6: - [ Dates —
Custom Date 1: =
Custom Text 7: - —
Custom Date 2: E3
Custom Text 8: - Custom Date 3: [
S Tk - Custom Date 4: =
Custom Text 10: - Custom Date 5: [
o - R T o
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Edit Asset

The Edit Asset screen allows you to modify an existing asset. This page is accessed from the
Asset List by highlighting an asset in the list, then clicking the Edit button on the toolbar. For
more information on using the List screens, see the Working with Lists topic.

The Edit Asset screen is identical to the New Asset page, except all the information previously
entered for the asset appears on the screen. You can change any of this information. For
information on using each tab of the screen, please refer to the Create New Asset topic.
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Edit Asset Type

The Edit Asset Type screen allows you to modify an existing asset type. This page is accessed
from the Asset Type List by highlighting an asset type in the list, then clicking the Edit button on
the toolbar. For more information on using the List pages, see the Working with Lists topic.

Keep in mind that editing an Asset Type (The asset type is a category for assets. Assets are
assigned to a specific asset type. For instance, you may have an Asset Type of Label Printers
that defines the manufacturer, size specs, etc. of this particular type of printer. Then specific
printers of the same type are assigned to the Label Printers asset type.) will affect every Asset
associated with that Asset Type.

The Edit Asset Type screen is identical to the New Asset Type page, except all the information
previously entered for the asset type appears on the page. You can change any of this
information. For information on using each tab of the screen, please refer to the Create New

Asset Type topic.
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Edit Contract/License

The Edit Contract/License screen allows you to modify an existing contract/license. This page
is accessed from the Contracts List by highlighting an contract in the list, then clicking the Edit
button on the toolbar. For more information on using the Lists, see the Working with Lists topic.

The Edit Contract/License screen is identical to the New Contract/License screen, except all
the information previously entered for the contract appears on the screen. You can change any
of this information. For information on using each tab of the screen, please refer to the Create
New Contract/License topic.
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Edit Customer

The Edit Customer screen allows you to modify an existing customer. This page is accessed
from the Customer List by highlighting an customer in the list, then clicking the Edit button on
the toolbar. For more information on using the Lists, see the Working with Lists topic.

The Edit Customer screen is identical to the New Customer page, except all the information
previously entered for the customer appears on the page. You can change any of this
information. For information on using the New Customer screen, please refer to the Create New
Customer topic.
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Edit Department

The Edit Department screen allows you to modify an existing department. This screen is
accessed from the Department List by highlighting an department in the list, then clicking the
Edit button on the toolbar. For more information on using the Lists, see the Working with Lists
topic.

The Edit Department screen is identical to the New Department page, except all the information
previously entered for the department appears on the screen. You can change any of this
information. For information on using the Department screen, please refer to the Create New

Department topic.
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Edit Depreciation Class

The Edit Depreciation Class screen allows you to modify an existing Depreciation Class. This
screen is accessed from the Depreciation Class List by highlighting a listing and clicking the
Edit Record button on the toolbar. See the Working with Lists help topic for more information.

The Edit Depreciation Class screen is identical to the New Depreciation Class page, except all
the information previously entered for the class appears on the screen. You can change any of
this information. For information on using the screen, please refer to the Create New
Depreciation Class topic.

Keep in mind that any changes made to an existing Depreciation Class will impact depreciation
calculations for every Asset Type associated with this class.
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Edit Employee

The Edit Employee screen allows you to modify an existing employee. This screen is accessed
from the Employee List by highlighting an employee in the list, then clicking the Edit button on
the toolbar. For more information on using the Lists, see the Working with Lists topic.

The Edit Employee screen is identical to the New Employee page, except all the information
previously entered for the employee appears on the screen. You can change any of this
information. For information on using each tab of the Employee screen, please refer to the
Create New Employee topic.
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Edit Location

The Edit Location screen allows you to modify an existing location. This screen is accessed
from the Location List by highlighting a location in the list, then clicking the Edit button on the
toolbar. For more information on using the Lists, see the Working with Lists topic.

The Edit Location screen is identical to the New Location page, except all the information
previously entered for the location appears on the screen. You can change any of this
information. For information on using the Location screen, please refer to the Create New
Location topic.
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Edit Manufacturer

The Edit Manufacturer screen allows you to modify an existing Manufacturer. This screen is
accessed from the Manufacturer List by highlighting a manufacturer in the list, then clicking the
Edit button on the toolbar. For more information on using the Lists, see the Working with Lists
topic.

The Edit Manufacturer screen is identical to the New Manufacturer screen, except all the
information previously entered for the manufacturer appears on the screen. You can change any
of this information. For information on using the Manufacturer screen, please refer to the Create
New Manufacturer topic.

71



MobileAsset Users' Manual

Edit Site

The Edit Site screen allows you to modify an existing site. This screen is accessed from the Site
List by highlighting a site in the list, then clicking the Edit button on the toolbar. For more
information on using the Lists, see the Working with Lists topic.

The Edit Site screen is identical to the New Site screen, except all the information previously
entered for the site appears on the screen. You can change any of this information. For
information on using the Site page, please refer to the Create New Site topic.
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Edit Vendor

The Edit Vendor screen allows you to modify an existing vendor. This screen is accessed from
the Vendor List by highlighting a vendor in the list, then clicking the Edit button on the toolbar.
For more information on using the Lists, see the Working with Lists topic.

The Edit Vendor screen is identical to the New Vendor screen, except all the information
previously entered for the vendor appears on the screen. You can change any of this

information. For information on using the Vendor screen, please refer to the Create New
Vendor topic.
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Adding New Assets

The New Asset page is used to enter a new asset into the database.

The following topics are discussed in this section:

Accessing the New Asset Page
General Tab

Asset Linking Tab
Depreciation Tab

Attachments Tab

Picture Tab

Maintenance Tab

Contracts Tab

Transaction History Tab
Custom Fields Tab

Accessing the New Asset Page:

To access this feature, from the Main Menu select Asset Management > New Asset.

OR

From the Main Menu select New > Asset.

This feature can also be accessed from the Asset List by clicking the New Record button on the

toolbar. For more information on using the list screens, please refer to the topic Working with

Lists.

The New Asset page is divided into several tabs as shown below:
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New Asset
Asset
Asset Tag: Asset Description:

Automatically assigned| |£J
General Asszet Linking Depreciation Picture Attachments Maintenance Contracts Transaction History Custom Fields L4
Site: ! lb Asset Type: - &J
Location: it |£J Asset Type Description:

Department Code: i lb Manufacturer: - &J
Serial No: Model: |i]
Condition: = |¥| Wendor Number: ~ &J
Hyperlink: lb Checkout Length: 0 Days = |0 Hours = | 0 Minute |i]
Additional Info: Lead Time: 0 Days (= |0 Hours 5 | 0 Minute = |¥|

Depreciation Class:
L]
Category:
| Additicnal information about asset. |
(¥] e

New Asset Page > General Tab

An example of the General Tab is shown in the screen shot above.

Pinning: You may notice that some fields on this and other tabs have a Pin icon in front of them.
These fields represent data that can be "pinned". Pinning allows you to "lock” the information
entered into a field. This is convenient if, for example, you are entering multiple new assets for a
particular site and location. You can enter the site and location once, then pin them. The fields
will retain the information you entered through each new entry until you unpin them. In the
example screen shown below, values are entered in the Site, Location and Department Code
fields. These three fields were Pinned by clicking on their pushpins, causing them to look like
this.

X

Click the pushpin again to unlock the field to enter different information.

Click the Pin All icon to pin every field that offers the pinning feature. Click it again to undo
pinning for all fields.

To Create an Asset:

1. Enter information in the required fields. You must enter information in the Asset Tag,
Asset Type, Site, and Location fields.

Note: If you are using Automatic Asset Tags, you do not need to enter anything in the
Asset Tag field. If the Automatic Asset Tags function is turned on (Administration >
Options on the PC version of MobileAsset), the Asset Tag field will appear as follows:
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New Asset

Asset

Asset Tag:

Automatically assigned

General Asset Linking Depreciation Picture Attachments Maintenance

The tag will be generated when you click the Save button or when you click the
button next to the Asset Tag field.

When you select an Asset Type, the following screen will display:

Set Common Asset Fields?

Do you want to populate the asset fields that are in
@ common with the asset type with the asset type

values?

Yes Mo

Select Yes to populate fields with information from the Asset Type such as Check Out
Length, Model Number, Vendor, etc. For example, if Check Out Length information is
entered for the Asset Type, it will appear here.

If you have enabled the Edit Inherited Asset Type Data option on the Options screen,
you can make changes to the information that is populated from the Asset Type. If this
option is not enabled, these fields will be disabled and you will not be able to make
changes.

If you do not want to incorporate information from the Asset Type, other than the Asset
Type number and Description, click No.

The Department Code, Serial No., Condition, Hyperlink and Additional Info fields are
optional.

The Hyperlink field can be used to store a link to the manufacturer's website, or even to
a location on your network. When a valid web address is entered in this field, the icon
next to it will be enabled. Clicking the icon will open your web browser and access the
website.

Note: When using the drop down lists to enter information in a field (Asset Type, Site,
Location, etc.), the last few selections will appear in the list. If you want to search for an
existing value, select <More> from that field's drop down list to access the List screen.

Use the vertical scroll bar to select a record from the List and click the List dialog's
Select button.
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4. Click OK if you are done entering information for this asset or click on another tab to
proceed with entering more information.

New Asset Page > Asset Linking Tab

Asset Linking is only available in the Professional and Enterprise versions of MobileAsset.
Asset Linking, also known as Asset Kitting, allows you to link two or more assets together to
form one new asset. For example, the asset Mary's Computer may consist of 4 separate assets -
CPU, Keyboard, Mouse and Monitor. These four individual assets are linked together to form one
new asset, Mary's Computer. For a complete definition of Asset Linking and an example,
please refer to the Definitions topic.

The Asset Linking tab allows you to create links:

automatically assigned
_——

General Asset Linking Depreciation Picture Attachments Maintenance Contracts Transaction History Custom Fields =
|| Transact as Whele - Select this checkbox to indicate that this asset and all of its child assets should be audited/checked-out/checked-in etc., as a group.

Parent Asset:

"
Child Asset(s):
Hélp | m Pin All Print Tag On OK - Copies: 0= “

1. The Asset Tag value entered on the General tab will be displayed at the top, but can still
be edited, if desired.

2. If this asset is to be the Parent, or top-level asset, of this group, you can leave the
Parent Asset field blank. If you want to give this asset a parent (for instance, if this asset
is a monitor and you want to link to the asset Mary's Computer), select an asset from the
drop down list in the Parent Asset field.

The asset can have a parent assigned to it and be a parent (have child assets assigned
to it).

Select <More> from the drop down list to access the Asset List. Remember, you can
filter the asset list to only display "Top Level" assets, or parent assets, if needed. See the
Working with Lists topic for further information.

3. To associate child assets with this asset (the current asset will be the "parent” of these
assets), click the Link button below the Child Asset(s) window. The Asset List will
appear.

Highlight the desired asset in the Asset List, then click the Select button. The selected
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asset will appear in the Child Asset(s) window as shown below:

General Asset Linking Depreciation Picture Attachments Maintenance Contracts Transaction History Custom Fields =

|+ Transact as Whole - Select this checkbox to indicate that this asset and all of its child assets should be audited/checked-out/checked-in etc., as & group.

Parent Asset:
78923 MRS

Child Asset(s):

103 - HP Printer

- wv

In this example, asset number 78923 is the parent of the current asset and 103-HP
Printer is the child.

A Note about the Transact as Whole Flag: In the example above, the Transact as
whole flag is checked; therefore, any functions (check-in, check-out, audit, move, etc.)
will be performed as a whole for the group. This flag is driven from the top down,
meaning the selection made for the parent asset will override the selection for a child
asset. If you want to move only one asset that is a child of this asset, you will need to
deselect this checkbox. Deselecting it on the Edit Asset > Asset Linking tab for the
child asset (in this case, Asset 103) will not override the selection made for this asset,
and this group would still be moved as a whole. Similarly, if the Transact as whole flag
was NOT selected on this tab, but it IS selected for Asset 78923 (the parent of this
asset), the group would still be transacted as a whole because the selections made for
the parent of this asset would take precedence. To put it another way, if you think of
these relationships in the vein of child-rearing, one of your children may decide it is ok to
borrow the car, but you as the parent do not think it is ok. Your decision as the parent
would override that of the child.

Also keep in mind that when you check out an asset that has Transact as whole turned
on and you select to use the Default Due Date (on the Check Out screen) MobileAsset
will search all assets linked to the selected asset to find the maximum checkout duration.
The program will use this maximum length to calculate the due dates for all the linked
assets. This ensures that all the assets in the transaction have the same due date even if
some of the linked assets have different checkout durations.

You can unlink child assets by highlighting the asset in the Child Assets list and clicking
the Unlink button.

4. Click OK if you are done entering information for this asset or click another tab to
proceed with entering more information.

New Asset Page > Depreciation Tab:
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Click the Depreciation tab if you want the software to calculate depreciation for this asset. The
method used by the system to calculate depreciation is dependent on the Asset Type assigned to
this asset.

The Asset Tag value entered on the General tab will be displayed at the top, but can still be
edited, if desired.

n&set Tag: =t Description:

Automatically assigned
General Asszet Linking Depreciation Picture Attachments Maintenance Contracts Transaction History Custom Fields =
Depreciate Asset: L | Assets of this asset type cannot be depreciated.
Purchase Order: |¥ | Depreciation Begin Date: & |¥J
Purchase Date: = llj Last Depreciation Date:
Purchase Cost: 0.00 5 llj Total Depreciation:
Salvage Value: 0.00 5 |£J Current Depreciation:
Class Info: Book Value:
Help n m Pin All Print Tag On OK - Copies: 0= ﬁ

1. Click the Depreciate Asset checkbox if you want the software to calculate depreciation.
The Depreciate Asset checkbox will be disabled if a Depreciation Class has not been
defined for the Asset Type specified on the General tab -or- that Asset Type has a
Depreciation Class, but its Depreciation Method is "None".

2. The depreciation method used for an asset is determined by the Depreciation
Class assigned to the Asset Type. This information appears in the Class Info box and
cannot be modified from this screen. If you want to change the Depreciation Method or
the Life of a particular asset, you will need to make changes to the Depreciation Class
assigned to the Asset Type, or create a new Depreciation Class to assign to the Asset
Type. See the Depreciation Class help topic for further information.

3. Purchase Cost and Depreciation Begin Date are required fields when Depreciate
Asset has been enabled, therefore, you must complete them if you want to calculate
depreciation. These two fields are used in the calculation. Please see the Definitions
topic for detailed explanations of each Depreciation Method.

4. Purchase Order, Purchase Date and Salvage Value are optional fields. If a Salvage
Value is not specified, the Calculate Depreciation function will assume a Salvage
Value of zero dollars.

The Class Info, Last Depreciation Date, Total Depreciation, Current Depreciation,
and Depreciated Value cannot be modified. Information is populated in these fields by
the system as depreciation functions are performed.

In the following example, an asset is being entered that uses 5-year Straight-Line
depreciation:
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General Asset Linking |ml Picture Attachments
Depreciate Asset: [+ &]

Purchase Order: w
Purchase Date: &J
Purchase Cost: §99.00 & w

Salvage Value:

0.00 5 w

Maintenance

Contracts Transaction History

Depreciation Begin Date | 7/14/2010
Last Depreciation Date:
Total Depreciation:

Current Depreciation:

Custom Fields

E (¥

Class Tnfo: Book Value:
Class: 5 Year Straight Line
Depreciation Method: Straight-Line
Life:
(] v e a5 om0 o | 012 o

5. Click OK if you are done entering information for this asset or click the next tab to

proceed with entering more information

New Asset Page > Attachments Tab

To attach an image or other documentation to this Asset, click on the Attachments tab:

A TSRy a55pred — . L I
General | Asset Linkng Picture Comtracts | Trassaction Mistory | Custom Fields

Amser Artachements
Asses Type Atiachments

Em O

Print Tag On O - Copies:

1. To add an attachment, click the Add button.
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- GRS T om0 3 = 1=

A screen will appear allowing you to navigate to the desired file on your computer.
Attachments are copied to the MobileAsset database from the external source you
browse to when you click the Add button. Any change made to the external source file
after adding the attachment will not update the attachment in the database. To update
the database with a later version of an attached file, you must first Remove the
attachment from the database, then Add the file again.

Asset Attachments relate only to the specific Asset being recorded. Asset Type
Attachments relate to every Asset recorded for this Asset Type.

If you have attached an image, you can designate this the "default" image (meaning this
is the image that will appear on the Picture tab) by clicking the Set Default Image
button.

After you have added at least one file, the View button is enabled. This feature allows
you to view the attached file. The File Associations defined in Windows Explorer
determine which application will be started to open files, based on their filename
extensions. On most machines, a PDF file would be opened by Adobe® Reader, for
example. Image attachments can be viewed the same way or you can use the Picture
tab to use Asset's internal image viewer.

The Save to File button copies the selected attachment from the database to any drive
and folder available on your system.

The Remove button can only be used to Remove Asset Attachments. It is grayed-out
(disabled) when an Asset Type Attachment is selected. These Asset Type
Attachments may be related to other Asset Tags under the same Asset Type. Asset
Type Attachments can only be removed via the Edit Asset Type Attachments tab (see
Creating New Asset Types for further information.).

Attachments are not actually added to the database until the OK button is clicked. You
can click it at this time if you are finished adding additional information, or click it later,
after you have completed information on other tabs.

New Asset Page > Picture Tab

Click the Picture tab to view any image files that have been attached to either the Asset Type
Attachments folder or the Asset Attachments folder.
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1121 Philips Monitor

General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields =

Hel;; Print Tag On OK - Copies: 0 : ﬁ E

1. The first time you access this tab it will be blank if a default picture has not been added
on the Attachments tab either on the Add/Edit Asset screen or the Add/Edit Asset
Type screen (for the Asset Type assigned to this asset).

The current default picture is always displayed on the Picture tab. Right click the image
to see the popup Picture menu. This menu allows you to Add (a new) Image or to
Select (a previously added) Image. Any image you select for display will become the
new default image.

The files listed in the Select Image sub-menu are a combination of Asset Type
Attachment images and Asset Attachments images, sorted alphabetically, by filename.

2. Image files are not actually added to the database until the OK button is clicked. You can
click it at this time if you are finished adding additional information, or click it later, after
you have completed information on other tabs.

New Asset Page > Maintenance Tab

The Maintenance tab allows you to define maintenance procedures, a maintenance schedule,
and warranty information for an Asset.

This tab allows you to:

Enter Warranty Information

Enter New Maintenance Schedules
Edit Existing Maintenance Schedules
View Maintenance History

Below is an example of the Maintenance tab:
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Automatically assigned

General || Assetlinking | Depreciation | Picture | Attachments |Maintenamcew| Contracts | Transaction History | Custom Fields =

Warranty
( Warranty Begin: Warranty End: Warranty Provider: \

List of Maintenance Schedules:

I
Assigned m} Dﬁtﬁﬂﬁ)lll Ocl:llrs‘ Next Date‘

e [~ sase—
(5] o o Tag onox-comer o2 o o]

Entering Warranty Information:

1. You can optionally enter Warranty Begin and End dates and a Warranty Provider at
the top of this tab.

Click on the Calendar icon to access the calendar feature:

Automatically assigned

General Asset Linking Depreciation Picture Attachments Co
*Warranty
Warranty Begin: @ Warranty End:

List of Maintenance |

AssignedtnI Desi

11 12 [13] 14 15 16 17 || Clickonthe arrows
R e e e to scoll through the

months.
25 26 27 28 29 30 31

You can also click on the Month/Year (August, 2009 in the example above) to view a list
of all months. You can then click on a month to quickly switch dates:
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‘ Automatically assigned @

General Asset Linking Depreciation Picture Attachments | Maintenance

*Warranty
{ Warranty Beain: | Warranty End:
: : 1 2010 Fo|
Assigned tﬂ| Desi  1an Feb Mar Apr [
May Jun Jul Aug
You can click ona

month or use the
sep Oct Nowv Dec | arrows to scroll to
a different year.

2. You can optionally enter the warranty provider in the Provider field.
Entering New Maintenance Schedules:
To enter a new maintenance schedule:

1. Click the New button below the window:

Assigned to Desu:ripliun| 0c1:urs| Mext Date
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The Maintenance Schedule screen appears:

Maintenance Mame:

Assign to: =

Occurs: Date =
Date

[ 7/13/2010 (]

Mext Date: Tuesday, July 13, 2010

Instructions:

e

2. Enter a name for this maintenance schedule.

3. Select the employee who this asset will be assigned to from the Assigned To drop down
list. All employees currently set up in your software will appear in the drop down list.

4. Select how often this maintenance schedule is to happen from the Occurs drop down
list. The area below the Occurs drop down list will change depending on the selection
you make here. Your options are:

e Date - This option indicates a one-time maintenance procedure. When you
select this option, a Date field will appear below the Occurs drop down list.
Select the date on which the maintenance should take place. You can click on
the calendar icon to select a date or type a date directly into the field.
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| Occurs: |

i Date

| [ 7/13/2010 e
| Mext Date: Tuesday, July 13, 2010

Daily - This option allows you to specify a Maintenance Start date, followed by a
frequency specified as Every x number of days (up to a maximum of every 366
days).

In this example, maintenance would be performed every 10 days beginning
Tuesday, July 13, 2010.

| Occurs: Daily . !
E : !
| ¢ Daily |
Maint Start: 7/13/2010 | |
| Every 10 & day(s)
| Next Date: Tuesday, July 13, 2010
|

The Next Date at the bottom of the screen indicates the next date maintenance
will be performed on this asset.

Weekly - This option allows you to specify a Maintenance Start date, followed
by the frequency specified as Every x number of weeks. You will also select the
days of the week on which the maintenance is to be performed. More than one
weekday can be selected.

In this example, maintenance will be performed every week on Fridays beginning
July 16, 2010.

| Deecurs: Weelkly e |

| |
| - Weekly [
| |
[ Maint Start: 7/16/2010 [E| |
[ Every 1 : week(s) on: |
1
I || Sun [ | Mon [ | Tue || Wed I
[ || Thu |+] Fri | | zat |
| |
Mext Date: Friday, July 18, 2010 |

The Next Date at the bottom of the screen indicates the next date maintenance
will be performed on this asset. In this example, since we have selected Friday

87



MobileAsset Users' Manual

88

as the maintenance day, the Next Date is Friday, July 16, 2010.

Monthly - This option allows you to specify a Maintenance Start date, followed
by your choice of two possibilities: Maintenance Every x number of months (up
to a maximum of every 99 months) as shown below:

In this example, maintenance will occur on the 1st day of each month every
month.

Dccurs: -
Monthly
Maint Start: 7/16/2010 [m=]
(*) Day 1 : of every 1 : meonth(s)
of every = month(s)
Mext Date: Sunday, August 01, 2010

Notice the Next Date reflects the first day of the next month.

OR

Maintenance can be set to occur on a specific weekday of every x number of
months (up to a maximum of every 99 months) as shown below:

Oceurs: Monthly -
Monthly
Maint Start: 7/16/2010 [=H]
() Day = of every & month(s)
(») | 1st - .Thursday v. of every 1 : month(s)

Mext Date: Thursday, August 05, 2010

In this example, maintenance will occur on the first Thursday of every month.
Notice the Next Date reflects the first Thursday of the next month from the Start
Date.

Disable - This option is used when you want to temporarily disable an existing
maintenance schedule. Highlight the maintenance schedule in the list, then click
Edit. On the Maintenance Schedule screen, select Disabled from the Occurs
drop down box. You can also set up a new maintenance schedule as Disabled
then enable it later by select Daily, Weekly, etc.

5. Click Save when you are done entering information for this maintenance schedule. The
schedule will appear in the list on the Maintenance tab:
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Warranty

{ Warranty Begin:

[#E|| Warranty End:

List of Maintenance Schedules:

Assigned to Description Occurs | Next Date |

Bradley, Pittsburg | Battery Replacement | Monthly | 7/13/2010

Em -

Editing Existing Maintenance Schedules:

1.

Highlight the maintenance entry you want to edit, then click the Edit button. The
Maintenance Schedule screen will appear populated with the selected entry's
information.

Make changes as necessary, then click the Save button. The edited entry will appear in
the list on the Maintenance tab.

Viewing Maintenance History:

The Maintenance History screen displays all completed maintenance on this asset.

1.

3.

Click the View History button. The Maintenance History screen will appear:

<SS>

When you first access this screen, all maintenance entries associated with the selected
maintenance schedule are displayed. You can change the selected schedule using the
Schedule drop down menu. You can also enter From and To dates to further filter the
list.

Click the Show All button to remove the filter.

4. Select the Print History button to print a list of the displayed maintenance entries.

New Asset Page > Contracts Tab

The Contracts tab allows you to record contract and/or software licenses associated with this
asset. The tab will appear empty when you are first adding a new asset. You can add contracts
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and licenses to this asset as needed from this tab. Contracts/licenses can be added to the
database via the Contracts List screen.

Butomatically assigned

General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields -

Select from the full contract list

Begin Date Description Contract Number Cost End Date Internal Contact Software Hyperlink Licenses Vendor Number

= JUET oo -0 % —>—]

1. To add a contract/license, click the Add button. The Contracts List will appear. Select
the desired contract from the list, then click Select on the Contracts List screen. The
selected contract will appear on the Contracts tab as shown in the example below:

Automatically assigned

General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields

Select from the full contract list

Begin Date Description Contract Number Cost End Date  Internal Contact Software Hyperlink Licenses Vendor Number
|10f23f2007 Contract 3 for Software 3 0.00| 10/23/2008 = Al =

2. You can remove a contract by highlighting it in the window, then clicking the Remove
button.

Click Select All to select all contracts in the window.
Click Clear All to deselect all contract in the window.

3. Click OK if you are done entering information for this asset or click the next tab to
proceed with entering more information

New Asset Page > Transaction History Tab

The Transaction History tab displays data only after one or more Asset Management
transactions have been performed (check-in, check-out, etc.). Keep in mind that this tab will be
blank when you are setting up a new asset. The example below shows the Transaction History
tab as it might appear on the Edit Asset screen.
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1121 =1l Optiplex GX270

General Asset Linking Depreciation Attachments Picture Maintenance Contracts m} Custom Fields b
Time Type Action User Name
7/7/2010 10:40:06 AM Check-0Out To employee: 1 - from hardware filter category, ckout <2 asset tag to empl 4 with new locat wilson Stock Admin, User
7/7/2010 10:40:04 AM Move From: Helpdesk 1_ at The Wilson Hospital - Admin, User
7/7/2010 10:40:04 AM Mowve To: Stock Room 1_ at The Wilson Hospital - Admin, User
7/6/2010 11:45:56 AM | New Asset Admin, User

Print Transactions
" o]

Click Print Transactions to send a list of the transactions for this asset to the printer.

Click OK if you are done entering information for this asset or click another tab to proceed with
entering more information.

New Asset Page > Custom Fields Tab

Please refer to the Using Custom Fields topic for instructions on creating custom text, number
and date fields.

utomatically zssigned
General Asset Linking Depreciation Attachments Picture Maintenance Contracts Transaction History Custom Fields hd
~Text ~ Number
Custom Text 1: - Custom Number 1: 0.0000 :
Custom Text 2: = Custom Number 2: 0.0000 &
Custom Text 3: - Custom Number 3: 0.0000 (&
Custom Number 4: g =
Custom Text 4: - 0000 i
Custom Number 5: 0.0000 15
Custom Text 5: -
Custom Text 6: i I i
Custom Date 1: )
Custom Text 7; - —
Custom Date 2: ES)|
Custom Text 8: - Custom Date 3: E
Custom Text 9: - Custom Date 4: E
Custom Text 10: - Custom Date 5: @
() o o nox a2 o ] o

If the Close New Form option is enabled on the Options screen and no fields are pinned, the
screen will close when the OK button is clicked.

91



MobileAsset Users' Manual

Asset List Example

The Asset List, accessed from the Main Menu by selecting List Forms > Assets or Asset
Management > List Assets, allows you view Assets you have already setup and to create new
or modify existing assets. For detailed information on working with list screens, please see
Working with Lists. Below is an example of the Asset List.

Asset List
WView
PR APy L T 3R AE i YsdE TTRIESRIS
Linking Asset Tag p— Description  Asset Type | Asset Type Description Transact As Whole | Site Location | Department Code | Chec =
Not Linked | 1 Philips Monitor 15 TFT Philips Menitor 1 1 Sytem ID -
Not Linked | 1-1 Asset in Type 111 111 Type 111 3 10
Not Linked | 1-2 Philips Monitor 150 Philips Monitar 3 10 T
Not Linked | 1-3 Asset in Type 111 114 Type 111 3 10
Not Linked | 1-4 Asset in Type 111 111 Type 111 3 10
Not Linked | 1-5 Asset in Type 111 111 Type 111 3 10
Not Linked | 1121 Philips Monitor 150 Philips Menitor 3 10 ACC
Not Linked | 1127 Dell Optiplex GX270 | GX270 Dell Optiplex GX270 £l 10 Wasp =
Not Linked | 1128 Dell GX150 CPU GX150 Dell GX150 CPU The Wilson Hos | Stock Room 2_ | Wasp
Not Linked | 1132 Dell Optiplex GX270 | GX270 Dell Optiplex GX270 3 10 Wasp =}
Mot Linked | 1137 AMD Base Athlon AMD Base Sutton & Mertoi| Green Wrythe &) Sytem ID
oo amars o =l o e PR P =l E.
4 »
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Moving Assets

The Move Asset function is used to relocate an asset from one location to another.

1.

To access this function, from the Main Menu select Asset Management > Move. The
Move screen appears.

You can also access this function from the Asset List by highlighting an asset and
clicking the Move button on the toolbar, or just clicking the Move button on the toolbar.

For more information on using the List screens, please refer to the topic Working with
Lists.

Asset List
2v BT FRE2 &zEn- =
Linking Asset Tag Asset Description | Asset Type Asset Type Description  Tr

Philips Monitor

Move

Filter

Asset Tag: - Department:

Location: Purchase Order:

MILS -\

|_| | Asset Tag Asset Description Asset Type Asset Type Description Site Location Department Code Checked Out Serial No Condition Hyperlink Manufacturer Mod

Destination

To Location:

Notes

2. The Move screen offers two modes of asset selection - Filter and Custom Filter:

o Filter is the default selection mode, allowing you to select the Assets you want to
Move by specifying any combination of values for the four filter criteria: Asset
Tag, Location, Department and Purchase Order.

Note: Pinning can be used with Move transactions. Pinning allows you to "lock"
the information entered into a field. This is convenient if, for example, you are
moving multiple assets for a particular site and location. You can enter the site
and location once, then pin them. The fields will retain the information you
entered through each new entry until you unpin them. In the example screen
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shown below, values are entered in the Location and Department Code fields.
These fields were Pinned by clicking on their pushpins, causing them to look like
they are pushed in. Click the pushpin again to unlock the pin.

Move

Filter

Asset Tag: . Department: .
Location: JE O —— - . . Purchase Order:
Sutton & Merton PCT, Alexandra Surgery 1_ 1 -

|_| |Asset Tag AﬁdDﬁ:ﬁMlnn‘mTvm.W Site Location Department Code Checked Out| Serial No Condition Hyperlink *

The assets matching your criteria will appear in the grid. You can manually limit the list of
assets further by selecting the checkbox in front of only those assets in the list you want
to move.

| |  AssetTag Asset Description| Asset Type Asset Type Description Site Location Department Code | Checked Out Serial No Condition Hyj *
(] 78904 | Sony Monitor CPD15SX1 | Sony Monitor Sutton & Merton PCT | Alexandra Surgery 1_ @ Good
4 »
Destination
To Location: Bk
Notes ¥
e .

The Select All checkbox can be used to highlight all the records found by your choice of
filter criteria.

|| | Asset Tag Asset Description Asset Ty

[l

73904 | Sony Monitor
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4. After you have selected the assets you want to move, you need to select the To
Location. Notice that the items listed in the To Location drop down list consist of both a
Site and a Location at that Site. Select a recently used To Location from the drop down,
select <More> to select a location from the Location List.

Destination

To Location:

Notes L1 I
Sutton & Merton PCT, Alexandra Surgery 1_ ok f
<More>
o

5. Click the Move button when you are ready to move the selected assets to the new
location..

Click Close when you are ready to exit the Move function.
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Checking Out Assets

The Check-Out Asset function, provides the ability to check-out assets to a customer or
employee, specifying a due date and time by which the asset should be returned. Keep in mind
that you can set the check out length to only consider weekdays and the due date to only fall on a
weekday on the Options screen.

1.
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To access this function, from the Main Menu click Asset Management > Check-Out.

You can also access this feature from the Asset List by highlighting the asset you want
to check-out, then clicking the Check-Out button on the Asset List toolbar. When
accessed this way, the selected asset's information will be pre-populated on the screen.
For more information on using the Asset List, click here.

Check Out
~ Filter  Asset Pending Check Out
Asset Tag: - (s) Customer: - @
() Employee: &4
Description: - R Change Location To: MERY
Location: - || Due Date
=% (*) Use each asset's checkout duration (Select a pending asset to see its
due date
Category: ||  § | ) ‘

() None (Each asset has no due date) R

~ Assets Available for Check-Out
s () Custom (Each asset gets the due date below)

|_| | Asset Tag | Asset Description | Asset Type Asset Type Description

Notes &\

Assct Tag | Asset Description| Asset Type| Asset Type Description Site *

ﬁ Print Receipt On Check-Out - Copies: o A | Show Location on Receipt

The Check-Out function offers two modes of asset selection - Filter and Custom Filter:

Filter is the default selection mode, allowing you to select the Assets you want to Check-
Out by specifying any combination of values for the four filter criteria: Asset Tag,
Description, Location, and Category.

Pinning (Pinning allows you to "lock" the information entered into a field. This is
convenient if, for example, you are entering multiple new assets for a particular site and
location. You can enter the site and location once, then pin them. The fields will retain
the information you entered through each new entry until you unpin them. In the example
screen shown below, values are entered in the Site, Location and Department Code
fields. These three fields were Pinned by clicking on their pushpins, causing them to
look like this. Click the pushpin again to unlock the field for entry of a different value.)
can be used with Check-Out transactions.

Custom Filter may be selected instead of Filter. This makes use of the Simple Find or
Advanced Find pages to select the assets you want to Check-Out.

After applying your choice of filter criteria, you can manually limit the list of assets further
still by using CTRL and the left mouse button, clicking to highlight only those assets in
the assets available to check-out list that should be Checked-Out, then click the > button
to move them to the assets pending check-out list. All the listed assets can be shifted to
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the assets pending check-out list via the >> button.

The Select All button can be used to highlight all the records found by your choice of
filter criteria. De-Select All can be used to clear any selections previously made.

The Detail button will open the Edit Asset screen for a highlighted record, to view or
modify the asset record prior to doing the Check-Out. If more than one record is
selected, the Detail button will be disabled.

When you are satisfied with the assets accumulated in the assets pending check-out list,
you can optionally apply Notes to the transaction, then specify either a Customer or an
Employee to whom the asset will be checked out.

Next, enter a Due Date (and time) for this asset.
You have three options for selecting a Due Date.

e Use each asset's checkout duration - highlight a pending asset in the
Assets pending Check-Out window. The selected asset's due date will
appear in the window. The due date is based on the check out length
set for the selected asset or asset type.

e None - No due date will be assigned.

e Custom - You can set a specific due date for all assets in the list.
Highlight the asset in the Assets pending Check-Out window, then
enter a date and time in the fields provided.

Keep in mind if you are checking out a linked asset and the Transact as
Whole flag is checked for the group, if you choose to use the default due
date (rather than entering a new due date, MobileAsset will search all
linked assets to find the maximum checkout duration. The maximum
length is used to calculate the due dates for all the linked assets. This
ensures that all the assets in the transaction have the same due date
even if some of the linked assets have different checkout durations.

You can optionally change the location of the asset being checked out using the Change
Location To field. For instance, you would use this feature if you are checking the asset
out to someone at a different location, such as another building or warehouse. To
change the location, select a location from the Change Location To drop down list.

Enter a number in the Print Receipt - Copies box to print Check-Out receipts for this
transaction.

When the required fields have been satisfied, the Check-Out button will be enabled.
Click it to post the transaction or click the Close button to exit without checking out the
asset.
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Checking In Assets

The Check-In asset function is used to Check-In assets that are currently checked out to a
Customer or Employee.

1.

2.
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To access the Check-In feature, from the Main Menu, select Asset Management >
Check-In. The To access the Check-In feature, from the Main screen, select Asset
Management > Check-In. The Check-In screen shown below appears.

You can also access this feature from the Asset List by highlighting the asset you want
to check-in, then clicking the Check-In button on the Asset List toolbar. When accessed
this way, the selected asset's information will be pre-populated on the screen. For more
information on using the Asset List, click here. screen shown below appears.

You can also access this feature from the Asset List by highlighting the asset you want
to check-in, then clicking the Check-In button on the Asset List toolbar. When accessed
this way, the selected asset's information will be pre-populated on the screen. For more
information on using the Asset List, please refer to the topic Working with Lists.

Check In
r Filter Checked Out To
Asset Tag: -
Customer: - X
Employee: -|[¥ |
~ Select Assats
Assets Available for Check-In Assets Ready to Check-In
|_|  Asset Tag Asset Description Asset Type Asset Type Description Sil * Asset Tag Asset Description Asset Type | Asset Type Description Site| L¢ *
To Location: i | ¥
T v Notes ¥

After applying your choice of filter criteria, you can manually limit the list of assets further
by using CTRL and the left mouse button, clicking to highlight only those assets in the
Assets Checked-Out list that should be Checked-In, then click the > button to move
them to the assets ready to check-in list. All the listed assets can be shifted to the assets
ready to check-in list using the >> button.

The Select All button can be used to highlight all the records found by your choice of
filter criteria. De-Select All can be used to clear any selections previously made.

The Detail button will open the Edit Asset screen for a highlighted record, to view or
modify the asset record prior to doing the Check-In. If more than one record is selected,
the Detail button will be disabled.

When you are satisfied with the assets accumulated in the assets ready to check-in list,
you can optionally apply Notes to the transaction.
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When the Print Receipt - Copies box has a value greater than zero, one or more
Check-In receipts will be printed for this transaction.

You can optionally add Notes to these assets by clicking the Notes button or enter a
Check In location in the Location field. Select a new location for the asset will check the
asset into the selected location, effectively moving it from its former location.

When the required fields have been satisfied, the Check-In button will be enabled. Click
it to post the transaction or click the Close button to exit without checking in the asset.
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Transferring Checked Out Assets

The Transfer Checkout function allows you to transfer physical possession of a checked out
item from one person to another or to another location. Transferring a checked out asset
prevents you from having to check the asset back in, then check it out again to another person. If
the asset won't be returning to your company's possession before going to another customer or
employee, use this function to transfer it.

Keep in mind that you can set the check out length to only consider weekdays and the due date
to only fall on a weekday on the Options screen.

1. From the Main Menu, click Asset Management > Transfer Check Out. The Transfer
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Check Out page appears.

Transfer Check Out
r Filter ~ Assets Ready for Transfer Check-Out
fssetilag: - (s) Customer
() Employes MR
Customer: %
£ Change Location To: -] [ &)
Employee:
s & Due Date b §
T (3) Use each asset's existing due date ‘ )
() Recalculate using asset's checkout duration
() Mone (Each asset has no due date)
() Custom (all asset get the due date below)
~ Assets Available for Transfer Check-Out
| | | Asset Tag Asset Description | Asset Type Asset Type Description Notee | ¥
Asset Tag | Asset Description | Asset Type Asset Type Description Site Lt

This screen is similar to the Check Out screen.

The Transfer Check-Out function offers two modes of Asset selection - Filter and
Custom Filter:

Filter is the default selection mode, allowing you to select the Assets you want to Check-
Out by specifying any combination of values for the four filter criteria: Asset Tag,
Description, Location, and Category.

Note: Pinning is available on this screen. Pinning allows you to "lock" the information
entered into a field. This is convenient if, for example, you are entering multiple new
assets for a particular site and location. You can enter the site and location once, then
pin them. The fields will retain the information you entered through each new entry until
you unpin them. In the example screen shown below, values are entered in the Site,
Location and Department Code fields. These three fields were Pinned by clicking on
their pushpins, causing them to look like this. Click the pushpin again to unlock the field
for entry of a different value.

After applying your choice of filter criteria, you can manually limit the list of Assets further
still by using CTRL and the left mouse button, clicking to highlight only those Assets in
the Assets available to check-out list that should be Checked-Out, then click the >
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button to move them to the Assets pending check-out list. All the listed Assets can be
shifted to the Assets pending check-out list via the >> button.

The Select All button can be used to highlight all the records found by your choice of
filter criteria. De-Select All can be used to clear any selections previously made.

Specify either a Customer No. or an Employee No. You can optionally enter Notes on
the transaction by typing in the Notes field.

Next, enter a Due Date (and time) for this asset.

You have four options for selecting a Due Date.

e Use each asset's existing due date - highlight a pending asset in the Assets
Available for Transfer window. The selected asset's due date will appear in the
field.

e Recalculate using asset's checkout duration - The due date is based on the
check out length set for the selected asset or asset type.

¢ None - No due date will be assigned.

e Custom - You can set a specific due date for all assets in the list. Highlight the
asset in the Assets pending Check-Out window, then enter a date and time in the
fields provided.

Keep in mind if you are checking out a linked asset and the Transact as Whole flag is
checked for the group, if you choose to use the default due date (rather than entering a
new due date, MobileAsset will search all linked assets to find the maximum checkout
duration. The maximum length is used to calculate the due dates for all the linked assets.
This ensures that all the assets in the transaction have the same due date even if some
of the linked assets have different checkout durations

When the Print Receipt on Transfer Check-Out Copies box has a value greater than
zero, one or more Check-Out receipts will be printed for this transaction.

Check the Show Location on Receipt checkbox if you want the transfer location to
appear on the receipt.

When information has been entered in all required fields, the Transfer Check-Out button
will be enabled. Click it to post the transaction or click the Close button to exit without
checking out the asset.
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Disposing of Assets

The Dispose function is used to delete one or more assets from your database. You will use this
function when you no longer have an asset.

Keep in mind that once disposed, assets cannot be "un-disposed", meaning there is no way to
reactivate the asset. You would need to create a new asset if the asset is found. There may be
situations where you will want to move an asset to a temporary location, rather than disposing of
it, if the asset is misplaced. For example, if you regularly have items that are not found during an
audit, but are found later, you may not want to dispose of them. Moving them to a temporary
location you set up in MobileAsset enables you to move them back to their regular location when
they are found. Disposing of these assets requires you to create a new asset later if they are
found.

1. To access the Dispose screen from the Main screen click Asset Management >
Dispose. The Dispose screen shown below appears.

You can also access this screen from the Asset List by highlighting the asset you want
to Dispose, then click the Dispose button on the toolbar. For more information on using
the Lists, please refer to the Working with Lists topic.

Dispose

Filter
Asset Tag: % Department: i X
Location: v| | ¥ | purchase Order: MEE S

| |  Asset Tag Asset Description Asset Type Asset Type Description Site Location Department Code Checked Out Serial No Condition Hyperlink Manufacturer Mg *

] »

Dispose
|/Rsason: MRS

Notes
A

.

2. You can search for specific assets using the Filter or the Custom Filter at the top of the
screen.

Filter: This is the default selection mode and allows you to select assets by specifying
any combination of values for the four filter criteria: Asset Tag, Location, Department
and Purchase Order.

Pinning can be used with Dispose transactions. Pinning allows you to "lock" the
information entered into a field. This is convenient if, for example, you are entering
multiple new assets for a particular site and location. You can enter the site and location
once, then pin them. The fields will retain the information you entered through each new
entry until you unpin them. In the example screen shown below, values are entered in
the Site, Location and Department Code fields. These three fields were Pinned by
clicking on their pushpins, causing them to look like this. Click the pushpin again to
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unlock the field for entry of a different value.

Custom Filter: This feature uses the Simple Find or Advanced Find screens to select
the assets you want to dispose.

The assets matching your criteria will appear in the grid. You can manually limit the list of
Assets further by highlighting only those assets in the list you want to dispose. To multi-
select, hold down the CTRL key while clicking on assets with your mouse.

The Select All button can be used to highlight all the records found by your choice of
filter criteria. De-Select All can be used to clear any selections previously made.

The Detail button will open the Edit Asset page for a highlighted record, to view or
modify the Asset record prior to disposing of it. If more than one record is selected, the
Detail button will be disabled.

A Disposal Reason must be selected from the drop list. Reasons are: Sale, Lost,
Damaged, Trade In, Stolen or Other.

You can optionally apply Notes to the transaction.
When you are finished entering information in the required fields, the Dispose button will

be enabled. Click it to dispose of the selected assets or click the Close button to exit
without disposing of any assets.
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Creating a Maintenance Entry

The Maintenance Entry screen is used to record maintenance activity for one or more assets.
You can schedule maintenance on this screen and record when maintenance was completed
and the condition of the asset.

104

1. To access this screen from the Main Menu select Asset Management > Maintenance

Entry.
OR

From the Main Menu, select Lists > Asset List. Highlight an asset in the Asset List,
then click the Maintenance icon on the toolbar. The Maintenance Entry screen
appears. Note that if you access the Maintenance Entry screen from the Asset List,
the page will appear populated with the selected asset's information and any scheduled
maintenance.

Maintenance Entry

 Filter

Asset Tag: Department:

it
= lb Date Due: E |b

Location:

- Select Assets

|| Asset Tag Asset Description Maint. Desc. Due Date Asset Type Asset Type Description| Serial No| Site Location Department Code Custom Date 1 Custom Dal *

4

 Completion Inf

Complete: O

Descriptien of maintenance: i

25t 7/19/2010

=

Condition:

4

Cost:

| =

ar

:

On the Maintenance Entry screen, you can filter assets to locate those you want to
create an entry for using the Filter options.

Filter allows you to select the assets for which you want to record a Maintenance Entry
by specifying any combination of values for the four filter criteria: Asset Tag, Location,
Department and Date Due.

Date Due will select those assets with a scheduled Next Date that occurs on or before
the Date Due specified. The Next Date is set on the Edit Asset > Maintenance tab.

Note: Pinning can be used with Maintenance Entry transactions. Pinning allows you to
"lock" the information entered into a field. This is convenient if, for example, you are
entering multiple new assets for a particular site and location. You can enter the site and
location once, then pin them. The fields will retain the information you entered through
each new entry until you unpin them. In the example screen shown below, values are
entered in the Site, Location and Department Code fields. These three fields were
Pinned by clicking on their pushpins, causing them to look like this. Click the pushpin
again to unlock the field for entry of a different value.
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The assets matching your criteria will appear in the grid. You can manually limit the list of
assets further by highlighting only those assets in the list for which you want to create a
maintenance entry. To multi-select, hold down the CTRL key while clicking on assets
with your mouse.

If you want to select all assets that appear in the grid, check the box in the top left corner
of the grid:

— 2 e

~ Select Assets

|| | Asset Tag Asset Description Maint. Desc.

1121 Philips Monitor Unscheduled Maintenanc

[+
[+] | 1368 HP Printer Unscheduled Maintenance

{ I | = e e e o e R | I e o e Sl I e o e

1

Completion Inf

If the maintenance is completed, select the Complete checkbox. You can also specify a
Completion Date, the asset's current Condition and the Cost of the maintenance. The
Complete checkbox does not need to be selected to enter a Completion Date,
Condition or Cost.

Enter a Description of Maintenance for this Maintenance Entry. The Description of
Maintenance field allows you to enter a brief overview of the maintenance performed.
You can type a one-time entry into the Description field, or you can set up recurring
descriptions from which you an select.

a. To setup descriptions, click the ... button above the Description of
Maintenance field.
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el A R L L W e

Description of maintenance: ;[

Click here to /'
access the

Maintenance
Entry screen.

e

The Maintenance Selection screen appears:
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Maintenance Seleclin

~ Maintenance Selection

Maintenance Short Name Description

[ | Battery Check - Printer

~ Details

b. Any descriptions you already have setup will appear in the Maintenance Short
Name Description field. To enter a new description, click the New button. A
new entry will appear in the Maintenance Short Name Description field:

a
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Maintenance Selection

~ Maintenance Selection

Maintenance Short Name Description

| |_| Battery Check - Printer

| ]

c. Enter a name for this maintenance.

Maintenance Selection ......

~ Maintenance Selection

Maintenance Short Name Description

[ ] Battery Check - Printer

D Mew Maintenance Entry |

N N S

d. Click in the Details section, then type in the description for this maintenance.

108



Asset Management

Maintenance Seleclinn

~ Maintenance Selection

Maintenance Short Name Description

[ | Battery Check - Printer

[] | MNew Maintenance Entry

=TI

~ Details

Type a description of the maintenance to be performed here.

T o

e. Click Apply to save your changes.

f.  Select which maintenance description you want to use by checking the desired
listing, then click the OK button.
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~ Maintenance Selection

Maintenance Short Name Description

|#] Battery Check - Printer
[_| Mew Maintenance Entry

Edit

~ Details

Make sure battery is fully charged.
Replace as nesded.

Apply

Discard

“o ] o

Your selection will be added to the Description of Maintenance field.

1320 HP Printer

+ + + +
[v] 1368 HPPrinter | Unscheduled Maintenance | | Inkget | CNOP14454683342115RL 1 B
= la ‘ ' ‘ e - ‘ ‘ -
[+ il
Completion Information
Complete: ] ? -
[ escription of mamntenance: R
Date: T
7/18/2010 , I Battery Check - Printer
Enil -|x Make sure battery is fully charged.
| Replace as nesded.
ek 0.00 = (X
==

6. When all required fields have been completed, the Save button will be enabled. Click
Save to save your changes or click the Close button to exit without recording a

Maintenance Entry.
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Entering Maintenance Prior to Due Date: If maintenance is entered for an asset before that
maintenance schedule is due, the following screen appears:

Early Maintenance ;

The completed maintenance date (8/5/2010) for the following
asset is earlier than the scheduled due date.

Would you like to advance the current due date to the next due
date according to the schedule?

! ! L Click No if you want to keep the current due date.
Asset Tag: 1

Maint. Description: Monthy Maintenance
Current Due Date: 9/1/2010

Yes Mo

Select Yes if you want to advance the schedule. This means the maintenance will be marked
completed for this period and the due date will be moved to the next due date on the schedule.

Select No to keep the current due date. The maintenance will be marked completed but the due
date will stay the same.

Example: Monthly maintenance is due on the 1st of every month. The current due date is
September 1st. If the user enters maintenance for August 20th, he/she will see the screen
above. If Yes is selected, the due date will advance to October 1st. If No is selected, the due
date will remain September 1st.
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Printing Labels/Asset Tags from the List Screens

MobileAsset Web allows you to print labels and asset tags directly from the List screens. The
following List screens have label printing functionality:

e Asset List - Print Asset Tags

e Employee List - Print Employee Badges

e Location List - Print Location Labels

Note: You must select a label printer in the MobileAsset PC application prior to printing tags from
the List screens. To do this, see the topic Selecting a Label Printer in the Mobile Asset Online
Help.

To Print Tags/Labels/Badges:

1. With the desired List screen open (Asset, Employee or Location), highlight the listing
you want to print. You can select multiple listings by holding down the Ctrl key on your
keyboard while clicking on listings.

2. Click the Print Tags/Labels button on the toolbar.

The following screen appears:
<SS>

3. Enter the number of labels you want to print for each selected item.

4. Click the OK button.
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Security

Groups and Users are setup in the MobileAsset PC application. If you need to make
corrections/additions to your users or groups, you will need to do so on the PC. There are two
ways you can setup users in the MobileAsset PC application to have access to the MobileAsset
Web Module:

1. Manually Enter Users: Create Groups and Users using the MobileAsset PC
application.

2. Let MobileAsset Automatically Create User Profiles Using Windows NT
Authentication: If you are using Windows NT Authentication, you can setup a Group in
MobileAsset that matches your group name in the Microsoft Active Directory. When
users in this Group access MobileAsset for the first time their User account will be
automatically created and added to the Manage Users screen in MobileAsset (PC
application).

Example: You have a group in your Active Directory named My Users and you want
everyone in My Users to have access to the MobileAsset Web Module. Create a Group
with the name My Users in MobileAsset using the MobileAsset PC application. Now
when each member of the Group My Users accesses MobileAsset, they will receive the
usual Windows Network Login Screen. They should enter their normal Network User
Name and Password. MobileAsset will recognize the Active Directory Group's name as
matching the MobileAsset Group name and automatically create a User account for that
user. You can then view those User accounts in MobileAsset (Security > Manage
Users). Keep in mind that if you change the password on the user's MobileAsset User's
account, they will receive the regular login screen and must enter the new password,
rather than their network password.

To prevent users from seeing the network login screen, complete the following steps in
your Internet Browser:

a. From your browser, go to Tools > Internet Options:
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%Cunvert - @Select
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Delete Browsing Histore...

Diagnose Connection Problermns..,

Pop-up Blacker
Phishing Filter
Manage Add-ons

YWeark Offline
Windows Update

Full Screen
Menu Bar

Toolbars

Fiddler?
Create hahil

3un lava Consale

Internet Options

The Internet Options screen appears:

b. On the Internet Options screen select the Security tab, then select Local
Intranet > Custom levels.
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I =

Internet Options @

General | SECUrity | Privacy I Content | Conneckions | Prograrns | .ﬁ.-:l'-.fan-:eu:l|

Select a zone to view or change security setkings,

@ & v O

Inkernet B leg=n=4  Trusted sites  Restricted
sikes

Local intranet
This zone is for all websites that are

= found on your inkranet,

Security level for this zone

Custom

Zuskom setkings.
- To change the settings, click Custom lewel,
- To use the recommended settings, click Default level,

Enable Protected Mode (requires restarking Internet Explorer)

[ Cuskom level... H Default level ]

[ Reset all zones to defaulk lewvel I

nﬁj Some setkings are managed by vour syskem administrator,

[ Ik ] [ Zancel Apply

The Security Settings screen appears.

c. Onthe Security Settings screen under User Authentication, make sure
Automatic Logon with Current User Name and Password is selected.
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Security Settings - Local Intranet Zone
Settings
(7) Disable -
@ Enable
=0 | Allovs websites ta prompk Far information using scripted wind:d
(7) Disable
@ Enable
= _u:ripting of 1ava applets
() Disable
@ Enable
() Prompt
H2, User Authentication
a8 Logan
() Anonymous logon
(71 Auktomatic logon only in Intranet zone
(=18 Aukamatic logon with current user name and passwor |_J
(7) Prampt Far user name and password
1 | 1] | 3
*Takes effect after wou restart Internet Explorer
Reset custom settings
Resetto: | Madium-low {default) T] [ Reset... ]
[ (] 4 ] [ Cancel ]

d. Click OK to close the Security Settings screen.

e. Select Local Intranet and the Sites button.
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I General | SEcurity |F‘rivac~;.-' I Content | Conneckions | Prograrns | .ﬁ.-:l'-.fan-:eu:l|

Internet Options @

Select a zone to view or change security setkings,

@ Gi, #’F ®

Inkernet Local intranet  Trusted sites  Restricted
sikes

Local intranet
This zone is for all websites that are

= found on your intranet,

Security level for this zone

Custom
Zuskom setkings.
- To change the settings, click Custom lewel,
- To use the recommended settings, click Default level,

[¥] Enable Protected Mode (requires restarting Internet Explorer’

[ Cuskom level... ][ Default level I

[ Reset all zones to defaulk lewvel I

-ﬁ- Some setkings are managed by vour syskem administrator,

I Ik ] [ Zancel Apply

-

The Local Intranet screen appears.

Click the Advanced button.

r-

G{ Use the settings below to defing which websites are included in
the local intranet zone,

ukomatically detect intranet networ
[] Automatically detect intranet network
[#] Include all local {intranet) sites nat lisked in other zones

[¥] Include all sites that bypass the proxy server
Include all network paths (UNCs)

wehat are inkranet setkings? I Advanced ] Ok ] I Cancel

Local intranet ==
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g. Enter the website address of your MobileAsset Web Module in the Add this
website to the zone field and click the Add button.

F- =

Local intranet ==

G’lh ¥ou can add and remove websites from this zone, &l websites in
* this zone will use the zone's security settings.

#dd this wehsite ta the zone:
Add

Websites:

htkp: fflocalbost Remove

[ require server verification (https: for all sices in this zone

| Close |

The website will appear in the Websites list.

F- =

Local intranet ==

G’Ih ¥ou can add and remove websites from this zone, &l websites in
ﬁ this zone will use the zone's security settings.

#dd this wehsite ta the zone:
| Add

Websites:

htkp: fflocalbost Remove
hkkp: | fvaurmobileasseturl

[ require server verification (https: for all sices in this zone

| Close |

h. Click Close to close the Local Intranet screen.

i. Click OK to close the Local Intranet screen.
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j- Click OK to close the Internet Options screen.
k. Restart your browser.

For more information on Security features in the MobileAsset PC application, please refer to the
MobileAsset online help.
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Setting Next Asset Tag Number

The Asset Tag values created will be incremented by a value of one, beginning with the largest
Asset Tag value that existed in the database when the option was first enabled. Beginning with
an empty database, the first automatically assigned Asset Tag will be a value of "1000". You can

change the first automatically assigned Asset Tag on the Set Next Tag Value screen.

Note: You must have the Use Automatic Asset Tags feature enabled on the Options screen to
use this feature.

1. To access this screen from the Main screen, select Administration > Set Next Asset
Tag Number. The Set Next Asset Tag Number screen appears allowing you to select a
start number. Below is an example of the Set Next Asset Tag Number screen. In this
example, assets with values of 1000, 1001 and 1002 were already entered in the system,
so the next tag value the system would use is 1003.

Set Next Asset Iag/ mb

Set Next Tag Number

F
-

EE N EEE

2. Enter the number you want to begin with, then click OK.

30020
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Options

Options

The Options screen is where you can turn off and on some automatic processes for asset
functions and control how the software performs in certain situations.

The following functions are controlled from the Options screen:
Asset Options

Allow Duplicate Serial Numbers
Automatic Asset Tags

Automatic New

Checkout Duration Uses Week Day Only
Decimal Places

Due Date on Next Week Day

Edit Inherited Asset Type Data

Last Depreciation Date

Email Options

Always Show Email Destination List
SMTP Password

SMTP Port

SMTP Server

SMTP SSL/TSL

SMTP User

Support Options

Check for Newer Label Versions
Close New Form
Max Row Count
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Allow Duplicate Serial Numbers

The software allows you to have two assets that have the same Asset Type to also have the
same serial number. This option is disabled, or turned off, by default. This option covers the
possibility that a generic asset type that is not make- and model-specific might have to support
assets which coincidentally have the same serial number from two different manufacturers.

You can enable this option by following the instructions below:
1. From the Main Menu, click Administration > Options. The Options screen appears.

2. On the Options screen, highlight Allow Duplicate Serial Numbers.

Tools

dAsset =
Allow duplicate Senal Numbers within the same

Allow Duplicate Serial Numbers Aok Tone

Automatic AssetTags
Automatic New
Checkout Duration Uses Week Days
Decimal Places
|| ¥Yes(Check to turn option on)
Due Date On Mext Week Day
Edit Inherited Asset Type Data
Last Depreciation Date
AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTF Server
SMTP S5L/TSL
SMTF User
dSupport

Check For Newer Label Versions

Cloze New Form

EE =

3. Enable the option by clicking the Yes checkbox.

4. Click OK to save the option and to close the Options screen.
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Automatic Asset Tags

This option automatically assigns Asset Tags when creating new assets or duplicating an
existing asset. When this option is turned on, you will not be able to enter a tag into the asset tag
field on the New/Edit Asset screens. The tag will be automatically generated when you click
Save or click the button next to the Asset Tag field on the New/Edit Asset screens.

For information on setting the default tag number the system will begin with when assigning asset
tags, see the section Setting the Automatic Tag Numbers, below. This option is turned off by
default.

The following topics are discussed in this section:

Turning on the Automatic Asset Tags Feature
Setting the Automatic Tag Number

Turning On the Automatic Asset Tags Feature:

1. Toturn on this feature (it is turned off by default), from the Main Menu, click
Administration > Options > Automatic Asset Tags. The Options screen appears.

2. On the Options screen, highlight Automatic Asset Tags and select the Yes checkbox.

options /

Tools

dAsset &
| Automatically assign asset tags when creating a

Allow Duplicate Serial Numbers e 2
new or duplicating an existing asset.

Automatic AssetTaags
Automatic New
Checkout Duration Uses Week Days
Decimal Places
|+ Yes(Check to turn option on)
Due Date On Mext Week Day
Edit Inherited Asset Type Data
Last Depreciation Date
AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTP Server
SMTP SSL/TSL
SMTP User
4dSupport

Check For Newer Label Wersions

Close New Form

=l =N
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3. Select the OK button to implement the features you have chosen and to close the
Options screen.

Setting the Automatic Asset Tag Number:

The Asset Tag values created will be incremented by a value of one, beginning with the largest
Asset Tag value that existed in the database when the option was first enabled. Beginning with
an empty database, the first automatically assigned Asset Tag will be a value of "1000". You can
change the first automatically assigned Asset Tag on the Set Next Tag Value screen.

1. To access this screen from the Main screen, select Administration > Set Next Asset
Tag Number. The Set Next Tag Value screen appears allowing you to select a start
number. Below is an example of the Set Next Tag Value screen. In this example,
assets with values of 1000, 1001 and 1002 were already entered in the system, so the
next tag value the system would use is 1003.

R

Set Next Asset Tag_:/___ jumh

Set Mext Tag Mumber

e
-

EE K EES

2. Enter the number you want to begin with, then click OK.

30020
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Automatic New

The Automatic New option enables the system to automatically open the Create New screen
when you enter an asset, site, location, depreciation class, etc. that is not already in the
database. For example, if you are creating a new asset and enter a location in the Location field
that does not currently exist in the database the New Location screen will appear allowing you to
finish entering the new location. This option is off by default.

When this option is turned off, a message appears when a new asset, site, etc. is entered asking
if you want to create the new item. If you select Yes, the New screen appears.

1. To enable this feature, from the Main Menu, click Administration > Options.
2. Highlight the Automatic New listing and select the Yes checkbox.

3. Click OK to save your changes.

Options . .-4

Tocols

dhisset =

Automatically open the Create New screen when
you enter an asset/site/location etc. that does not
Automatic AssetTags ewist. e.g. if you are creating a new asset and

| enter a location that i= not in the database, the
Mew Location screen will pop up automatically.

Allow Duplicate Serial Numbers

Automatic New

Checkout Duration Uses Week Days
Decimal Places
|sf] Yes(Check to turn option on)
Due Date On Next Week Day
Edit Inherited Asset Type Data
Last Depreciation Date
AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTF Server
SMTP SSL/TSL
SMTF User
ASupport

Check For Newer Label Wersions

Close New Form

O
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Check for Newer Label Versions

This option tells MobileAsset to use the newest label version when printing labels. For example,
if you are printing Asset Tags, MobileAsset will automatically use the label with the most recent
saved date. This options is on by default.

To Turn Off/On the Newer Label Versions Options:

1. From the Main Menu, click Administration > Options. The Options screen appears.

2. Onthe Options screen, highlight Check for Newer Label Versions.

Tocols

Allow Duplicate Senal Numbers

Automatic AssetTags When printing labels, like for asset tags, if a newer
|label has been installed and this option is on, the

Automatic New new label will be used.

Checkout Duration Uses Week Days
Decimal Places
Due Date On Next Week Day
Edit Inherited Asset Type Data [+ Yes(Check to turn option on)
Last Depreciation Date
AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTF Server
SMTP S5L/TSL
SMTF User

dSupport

Check For Newer Label Wersions

Close New Form

Max Row Count v

G TR

3. Deselect the Yes checkbox to turn off the option. Select the Yes checkbox to turn the
option on.

4. Click OK to save your changes.
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Checkout Options

The Options screen (Administration > Options) allows you to set two options regarding
checking out assets:

Checkout Duration Uses Week Days
Due Date On Next Week Day

Checkout Duration Uses Week Days

When this option is turned on, MobileAsset will not consider weekends when calculating the
Checkout Duration. For example, assume you set the Checkout Duration (on the Asset Type
> General tab) to 4 days and turn this option on. If an asset of this type is checked out on a
Thursday, it will be due back the following Wednesday because the two weekend days are not
considered in the calculation. If the option is turned off and the asset is checked out on a
Thursday, it will be due back the following Monday.

To set the checkout duration option:
1. From the Main Menu, click Administration > Options. The Options screen appears.

2. Onthe Options screen, highlight Checkout Duration Uses Week Days:
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Tools

disset E

When calculating the due date, only week days

#llow; DpRoalte; Serial Numbers are counted as checked out days.

Automatic AssetTags

Automatic New

Checkout Duration Uses Week Days

Decimal Places
|| Yes{Check to turn option on)
Due Date On Mext Week Day
Edit Inherited Asset Type Data
Last Depreciation Date
AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTFP Server
SMTP S50L/TSL
SMTF User
ASupport

Check For Newer Label Versions

Cloze New Form

I R

3. Select the Yes checkbox to turn on this option.

Due Date On Next Week Day
When this option is turned on, the due date will always fall on a weekday. For example, if you

turn this option on, if an assets due date would normally fall on a weekend, it is automatically

bumped to the next weekday. This means that if the due date were to fall on a Saturday, it would
be moved to Monday.

You can enable this option by following the instructions below:
1. From the Main screen, click Administration > Options. The Options screen appears.

2. On the Options screen, highlight Due Date on Next Week Day:
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Tools

dAzset

=i

If the calculated due date falls on a weekend, the

Allow Duplicate Serial Numbers B T

Automatic AssetTags
Automatic New
Checkout Duration Uses Week Days

Decimal Places

[ ] ves{Check to turn option on)
Due Date On Mext Week Day

Edit Inherited Asset Type Data
Last Depreciation Date
AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTFP Server
SMTP S5L/TSL
SMTFP User

AdSupport

Check For Newer Label Versions

Close New Form

I TR

3. Select the Yes button to enable the option.
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Close New Form

The Close New Form function enables the system to automatically close the New screen each

time a new record is created. If the feature is turned on (enabled), after you enter a new item and
click OK on the New screen, the screen will clear of information and remain open allowing you to
enter another new record. If it is turned off (disabled), the New screen will close each time a new

record is saved.

This option can only be enabled/disabled by a user set up in the Admin Group in Security. The
Close New Form option is turned ON by default.

You may want to turn this option off when first entering data to speed up the process, then turn it
on later to avoid confusion when using it infrequently.

Options

1. To enable/disable this feature, from the Main Menu click Administration > Options.

2. Onthe Options page, highlight the Close New Form listing and select the Yes checkbox
to enable the feature or make sure the checkbox is not selected to disable it.

Tools

Allow Duplicate Senal Numbers
Automatic AssstTags

Automatic New

Checkout Duration Uses Week Days
Decimal Places

Due Date On Mext Week Day

Edit Inherited Asset Type Data

Last Depreciation Date

AEmail

Always Show Email Destination List
SMTP Password

SMTP Port

SMTP Server

SMTP S5L/TSL

SMTFP User

ASupport

Check For Newer Label Versions
Close New Form

Max Row Count

T

Automatically close the New form each time a new

record is created or duplicated.

|+ Yes(Check to turn option on)

Cancel
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Decimal Places

This option allows you to set the number of decimal places to display in numeric fields (where
possible).

All values entered in numeric fields are stored in the database with up to 4 decimal places. You
may not want to display all four decimal places on your list screens and reports, so you can
designate the number of decimal places, from 1 to 4, that will display.

The following topics are discussed in this section:
Setting the Decimal Places Option

Changing the Decimal Places Option
Searching for Data with Truncated Decimal Places

Setting the Decimal Places Option
1. From the Main screen, click Administration > Options. The Options screen appears.

2. Highlight the Decimal Places option:

Tools

disset =

| A All numbers that can display decimal places will
use this number to determine how many decimal
Automatic AssetTags places to display. Valid VALUES 0..4

Allow Duplicate Serial Numbers

Automatic New

Checkout Duration Uses Week Days

Decimal Places 4

Due Date On Mext Week Day
Edit Inherited Asset Type Data
Last Depreciation Date

AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTFP Server
SMTP S5L/TSL
SMTP User

AdSupport

Check For Newer Label Versions

Cloze New Form

G TR
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3. Inthe text field, enter the number of decimal places you want to display. You can enter O
through 4. The default setting is 2 decimal places.

4. Click the OK button when you are done entering information.

Changing the Decimal Places Option

If you change the number of allowed decimal places to a great number (1 to 4, for example) any
digits stored prior to the change will display with trailing zeros. For example, if a value of 25.5
was stored when the Decimal Places option was set to 1, it will be displayed as 25.500 if the
Decimal Places option is later set to 3.

If you change the number of allowed decimal places to a lesser number (4 to 1, for example) any
digits stored prior to the change will be rounded. For example, if a value of 25.5 was stored when
Decimal Places was set to 1, it will be displayed as 26 if Decimal places is later set to 0. (Values
rounded for display at the currently specified number of Decimal Places will retain their original
number of decimal places as stored in the database.)

Searching for Data with Truncated Decimal Places

Keep in mind that your numbers are stored with up to four decimal places. If you set the Decimal
Place option to 1, but your numbers contain 4 decimal places, it will be helpful to search using all
the decimal places. For example, if you are searching for the numbers: 4.123, 4.134, 4.148 but
the Decimal Places option is set to one decimal place showing, the Asset List will displays these
numbers as 4.1, 4.1, 4.1. If you are attempting to use the Find feature to search for a specific
number, you can type in all decimal places, 4.123, for example to make your search easier.
However, when they go into the Find, they will be able to see all the decimal places.
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Edit Inherited Asset Type Data

This option allows you to edit the Asset Type information on the New Asset/Edit Asset -
General Tab. When you create a new Asset and select an Asset Type, you will be asked if you
want to incorporate data from that Asset Type (manufacturer, check out length, lead time, etc.).
For more information on incorporating data from the Asset Type into a new Asset, please refer to
the topic Creating a New Asset.

This option is enabled by default.
To Disable the Edit Inherited Asset Type Data Option:
1. From the Main screen select Administration > Options. The Options screen appears.

2. Onthe Options screen, highlight the Edit Inherited Asset Type Data option.

Tocols

dAsset i

1 Turn this option off to prevent the data on the
asset window that is inherited from the asset type
Automatic AssetTags from being edited.

Allow Duplicate Serial Numbers

Automatic New
Checkout Duration Uses Week Days
Decimal Places

|| Yes{Check to turn option on)
Due Date On MNext Week Day

Edit Inherited Asset Type Data

Last Depreciation Date
AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTF Server
SMTP SSL/TSL
SMTF User
dSupport

Check For Newer Label Versions

Cloze New Form

EE =

3. Deselect the Yes checkbox.

4. Click the OK button when you are done making changes.
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Email Options

The Email options allow you to configure MobileAsset for sending emails. Emailing is available
on the New/Edit Reservation Screen.

These options are accessed from Main Page > Administration > Options.
The following topics are covered in this section:

Always Show Email Destination List
SMTP Password

SMTP Port

SMTP Server

SMTP SSL/TSL

SMTP User

Always Show Email Destination List:

Select Yes to always have the list of email destinations appear when you select the Email
checkbox on the New/Edit Reservation Screen. This list allows you to select the email
addresses to which the order will be sent.

If you deselect the Yes checkbox, the list will not appear and the emails will automatically be sent
to every address on the list.
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Tools

Allow Duplicate Senal Numbers

Automatic AssetTags Turn this option off if you don't want to show
| email destination list when you send email from

Automatic New AR
the application.

Checkout Duration Uses Week Days
Decimal Places

Due Date On Mext Week Day

Edit Inherited Asset Type Data Izl Yes(Check to turn option on)
Last Depreciation Date

AEmail

Always Show Email Destination List

SMTP Password
SMTFP Port
SMTP Server
SMTP 55L/TSL
SMTP User
ASupport
Check For Newer Label Versions

Close New Form

Max Row Count

Kl =N

4

SMTP Password:

If your SMTP server requires authentication to send outgoing mail, enter the password here. If it
does not require authentication, leave this field blank.

135



MobileAsset Users' Manual

Options
Tools

Afsset -
Allow Duplicate Serial Numbers
Automatic AssetTaas
Automatic New
Checkout Duration Uses Week Days
Decimal Places
Due Date On Mext Week Day
Edit Inherited Asset Type Data
Last Depreciation Date s

AEmail
Always Show Email Destination List
SMTP Password
SMTP Port

If your SMTF server requires authentication to
send outgoing email, enter the account password
to use. Otherwise, leave this blank.

SMTP Port:

Enter the SMTP mail server listening port here. The default port is 25.
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Tocls

3

dhsset
SMTP mail server listening port. Default SMTP

Allow Duplicate Serial Numbers P Eah B

Automatic AssetTags
Automatic New
Checkout Duration Uses Week Days
Decimal Places 465
Due Date On Mext Week Day
Edit Inherited Asset Type Data
Last Depreciation Date

AEmail
Always Show Email Destination List

SMTE Password

SMTF Port

SMTP Server

SMTP SSL/TSL

SMTP Server:
Enter the name of an outgoing mail server that supports SMTP for delivering notification emails.

Enter the name of the same outgoing mail server that is setup in your own email program. If you
do not want MobileAsset to send notification emails, leave this field blank.
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Tools

AAsset
Allow Duplicate Serial Numbers
Automatic AssetTaas
Automatic New
Checkout Duration Uses Week Days
Decimal Places
Due Date On MNext Week Day
Edit Inherited Asset Type Data
Last Depreciation Date
4Email
Always Show Email Destination List
SMTP Password

SMTF Port

SMTP Server

SMTP SSL/TSL

SMTF User

| »

An outgoing mail server that supports SMTF for
delivering notification email. Set this to the same
thing as the 'outgoing mail server' in your own
email program. If you don't want to send
notification email at all, leave this blank.

smtp.gmail.com

SMTP SSL/TSL:

Turn this option on for all SMTP servers that require SSL or TSL, including GMail SMTP servers.
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Options

Tools

dfzset E
If ywour SMTF server requires a secure connection

Aillows Duplicabi: Serial fumbens (55L or TSL), check the box to turn this option on.

Automatic AssetTags
Automatic New
Checkout Duration Uses Week Days

Decimal Places

|+ ¥es(Check to turn option on)
Due Date On Mext Week Day

Edit Inherited Asset Type Data
Last Depreciation Date
AdEmail
Always Show Email Destination List
SMTP Password
SMTP Port

SMTP Server

SMTP SSL/TSL

SMTP User

Note for GMail Users:
To use a GMail SMTP server to send out mail from MobileAsset:
1. Go to www.gmail.com and setup your gmail account.
2. Have your IT department open port 587 and 465 on your computer.

3. Turn on the SMTP SSL/TSL option, and set up the other SMTP related options on the
Options screen.

The GMail SMTP server address is smtp.gmail.com. The SMTP user should be
'yourgmailname@gmail.com' (don't forget @gmail.com). The SMTP Password is your Gmail
account password.

Please be aware that you need to turn this option on for all SMTP servers that require SSL
or TSL, not just for GMail SMTP servers.

SMTP User:

If your SMTP server requires authentication to send outgoing mail, enter the user name here. If it
does not require authentication, leave this field blank.
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Tools

Ahsset
Allow Duplicate Serial Numbers
Automatic AssetTaas
Automatic New
Checkout Duration Uses Week Days
Decimal Places
Due Date On Mext Week Day
Edit Inherited Asset Type Data
Last Depreciation Date
AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTP Server

SMTP SSL/TSL

3

SMTP User

4ASuppod

If wour SMTFP server requires authentication to
send outgoing email, enter the account name to
use. Otherwise, leave this blank.
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Last Depreciation Date

This view only field on the Options screen allows you to view the last date depreciation was
calculated on your assets. Keep in mind that though you can enter a new date in this field, it will

not affect the actual last deprecation date. This field is view only.

Tools

dAsset i
This is the last date used to calculate asset

Allow Duplicate Sernal Mumbers MR
depreciation.

Automatic AssetTags

Automatic New

Checkout Duration Uses Week Days
Decimal Places

Due Date On Next Week Day

Edit Inherited Asset Type Data 7_":"r30-"r?|_310

Last Depreciation Date i

AEmail
Always Show Email Destination List
SMTP Password
SMTP Port
SMTF Server
SMTP S5L/TSL
SMTF User

4ASupport

Check For Newer Label \Versions

Close New Form

K 8
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Max Row Count

By default MobileAsset displays all records on a List screen. You can change this default number
to be lower on the Options screen. For example, if you have many records (over 1,000), you can

set this number to display fewer rows at one time to improve system performance. It will take

your system longer to retrieve and display 5,000 asset records on the Asset List screen then to

display 1,000. Therefore, you may want to set the maximum to display 1,000

1. To change the default number of rows that display, from the Main Menu, select
Administration > Options. The Options screen appears.

On the Options screen, select Max Row Count. The default number is 0, which

displays all rows. You can change this to any humber between 100 and 1,000. Or, you

can enter 0 to display all rows on the List screen.

Tools

Allow Duplicate Zenal Numbers
Automatic As=stTags

Automatic New

Checkout Duration Uses Week Days
Decimal Places

Due Date On Next Week Day

Edit Inherited Asset Type Data

Last Depreciation Date

AEmail

Always Show Email Destination List
SMTP Password

SMTP Port

SMTP Server

SMTP S5L/TSL

SMTFP User

ASupport

Check For Newer Label Yersions

Close New Form

Max Row Count

This is the maximum number of rows that will be
displayed on most grids. Set this number to 0 to
see all rows. The maximum can not be less than
100.
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Working with Lists

This application contains several list screens that enable you to quickly view and access a variety
of information. Available list screens are:

o Assets e Locations

e Asset Types e Manage
Approvals

e Contracts e Manufacturers

e Customers e Sites

e Departments e Transactions

e Depreciation e Vendors

Classes

e Employees

Below is an example of the basic list screen layout. This is an example of the Asset List, the list screen
you will probably use most often. This list screens are divided into three sections (labeled A through C in
the example below):

A. Menu Bar

B. Toolbar

C. Search Field

D. Contents List

E. Buttons/Status Bar

In addition to these menus there are also "Context-Sensitive Menus" that appear when you

right-click on certain areas of the screen. These provide another way to access many of the
functions available in the toolbar. These types of menus are also discussed later in this section.
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Asset List

[ |A
ERAFEL I e e 1TE

= -

=B c|

Linking | Asset Tag [ro— Description } Asset Type ?Asset'[vpe Description ;Transa:t.lswlnole | site Location | Department Code ?ﬂ!ﬁ’_‘_
I Not Linked | 1 Philips Monitor It is TFT Philips Monitor 1 1 Sytem 1D .

Not Linked | 1-1 Asset in Type 111 111 Type 111 3 10

Not Linked | 1-2 Philips Monitor 150 Philips Menitor 3 10 T

Not Linked | 1-3 Asset in Type 111 111 Type 111 D 3 10

Not Linked | 1-4 Assetin Type 111 111 Type 111 3 10

Not Linked | 1-5 Asset in Type 111 111 Type 111 3 10

Not Linked | 1121 Philips Monitor 150 Philips Monitar 3 10 ACC

Not Linked | 1127 Dell Optiplex GX270 | GX270 Dell Optiplex GX270 5l 10 Wasp ]

Not Linked | 1128 Dell G¥150 CPU GX150 Dell GX150 CPU The Wilson Hos | Stock Room 2_ | Wasp

Not Linked | 1132 Dell Optiplex GX270 | GX270 Dell Optiplex GX270 3 10 Wasp =

Not Linked | 1137 AMD Base Athlon AMD Base Sutton & Mertol| Green Wrythe £ Sytem ID

PP Y L aame aai PP =l - —n PR — =l _-
4 v

=

Quick Links:
Click a link below to jump to that section of the topic:

Section A: Menu Bar

Section B: Toolbar

Section C: Search Field
Section D: Contents List
Section E: Buttons/Status Bar
"Context-Sensitive Menus"

Section A: Menu Bar (Asset List Only)

The menu bar appears at the top of the screen and provides access to two menus:

View

Linked &ssets Only ‘ ﬁﬁ _
| A
Unlinked Asssts Only

Top Level (linked) Assets Only lmt D ription

hips Maonitor

Disposed Asssts set in Type 111

Top Level (all) Assets Only

Not Linked | 1-2 | Asset in Type 111

in Type 111
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View (Asset List Only) - The View menu option allows you to filter what assets display in the list.
Options are:

e Linked Assets Only - Displays only Linked assets

¢ Unlinked Assets Only - Displays only assets that are not linked to other assets.

e Top Level (linked) Assets Only - Displays only "Parent" assets, not the assets
associated with them.

e Top Level (all) Assets Only - Displays all assets.

e Disposed Assets - Displays all assets that have been marked as Disposed.

Section B: Tool Bar

Ve

<= |6

The toolbar at the top of the list screen provides quick access to a variety of functions and also
allows you to customize how the information on the list is displayed. Keep in mind that if the >>
icon appears in the toolbar of your list, there are hidden icons.

Button

Description

£

Filter - Accesses the Find screen allowing you to quickly enter information to narrow your search.
For more information on the Find screen, please see the Simple Find help topic.

Toggle Filter - Once you have entered a filter(specific search criteria entered on the Find screen
to narrow the search results) on the Find screen, the list results will be limited to the information
you entered. For example, if on the Find screen you designated that you want to view only items
with Asset Tag 243, only the item with Asset Tag 243 will appear in your list. You can click on the
Toggle Filter button to revert back to seeing all of the list items. Click it again to reapply your
filter.

New - Accesses the New screen allowing you to enter a new Asset, Asset Type, etc.

I

| r—

Edit - Assesses the Edit screen allowing you to update and change information.

Dispose or Delete - This icon is called Dispose on the Asset List. It allows you to Dispose of
the selected item in the list. For more information on the Dispose transaction, please see the
Dispose help topic.

This icon is called Delete on other lists. It allows you to delete selected items in the lists.

Duplicate - Allows you to copy the information from the item selected in the list to a new item.

Check In- Accesses the Check In screen allowing you to check in an asset. For more
information on the Check In feature, please see the Check-In help topic.

Check Out - Accesses the Check Out screen allowing you to check out an asset to an employee
or customer. For more information on the Check Out feature, please see the Check-Out help

topic.

Move - Accesses the Move screen allowing you to move one or more assets from one location to
another. For more information on the Move feature, please see the Move help topic.

View Linked Assets - If you are using asset linking, highlight a listing, then click the View Links
button to view the parent asset and any children. Below is an example of the View Linked
Assets screen.
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View Linked AEEEE . S :"::-:._-‘.'_:"::-':-.-‘.'.:"::"5--‘.'.:"::-'5--‘.'.:"::-':-.-‘.'.:"::-':-.-‘.'.:"::-':-.-‘.'.:"::-"-'.-"'::-'-':‘?:'

A7922 - Kingston Hub
42550 - Dell Optiplex GX270
43346 - Dell Optiplex GXZ220
3944 - Dell 5/Card Keyboard

K==

E

Notice that in this example the asset that was highlighted in the Asset List appears highlighted on
the View Links screen (asset 2550 in this example). The parent asset appears at the top. This
asset 2550 has children linked to it, so those also appear on this screen.

&

Print - Allows you to print the list. The standard Windows print screen appears.
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F&Q Print 3w
General | Options
Select Prinker
%Add Printer o= Microse
= Adobe PDF =0 Microst
=i Fax =0 Microst
=5 HP Photosmart 3200 series (from AGGIESDOMNER-PC) B prket-38

4| 1 |

I
Statuz: Ready Print ta file
Lacation:

Comment; Find Printer...

FPage Fange
@ Al Murnber of copies: 1 =
Selection Current Fage
(71 Pages: 1 Collate : :
. . : 2131 [ 23
Enter either a single page number or a single : 1 : 1
page range. For example, 5-12
Frint ] [ Cancel Apply

Export - Allows you to export the entire asset list to a comma-delimited text file.

What is a comma-delimited file?This is a type of data format in which each piece of data is
separated by a comma. This is a popular format for transferring data from one application to
another, because most database systems are able to import and export comma-delimited data.

For example, data pulled from a database and represented in comma-delimited format looks
something like the following. Each column value is separated by a comma from the next column’s
value and each row starts a new line:

Adams, Jane, 46, female, New York
Doe, John, 32, male, California
Jones, Sam, 13, male, Texas
Smith, Mary, 64, female, Louisiana

When data is represented in comma-delimited format they also are referred to as comma-
separated values, abbreviated CSV.

When the Export button is selected, a screen appears allowing you to specify where the exported
data will be saved on your computer. Make sure you save this to a location you can remember.
You must also choose a name for your file on this screen. After you have made your selections,
click Save to export your data.

A confirmation message will appear when your data has been successfully exported by the
system.

147




MobileAsset Users' Manual

=

Display/Hide Group Selections - The list screens provide you with the capability of "grouping”
the displayed information so you can view data in a way that is most easy-to-read for you. You
can have one group, two groups, or many groups depending on how you want to view your
information. For instance, if you want all assets on the Asset List to be displayed grouped by
location, you can quickly set this up.

To see the grouping options, click the Display/Hide Group Selections button. The top of the list
screen expands to display the group selections as shown below:

Asset List
View
3 = || T - 3 4 [ e = — 0| = ———
L (1P| %=) |IRIESIENE ==
LY R85 || &) o = - |} Sears
Drag 2 column header and drop it here to group by that column
Linking Asset Tag Asset Description | Asset Type | Asset Type Description Transact As Whole  Site Location Department Code  Chec *
Not Linked | 2532 el Uptiplex GXZ/U | GKZ/U Dell Uptiplex GXZ/U Tl Ine Wilson Hes | Helpdesk I_ | Sytem ID =
Mot Linked | 2542 Dell Optiplex GX270 | GX270 Dell Optiplex GX270 = 1 1 Wasp ]
% Linked Both 2550 Dell Optiplex GX270 | GX270 Dell Optiplex GX270 [ i} T Sytem ID =
Mot Linked | 3 Toshiba e570 Handhe | ES70 Toshiba e570 Handheld = The Wilson Hos | Portakabin 1_ | Wasp =
Not Linked | 3055 Dell 5/Card Keyboard | SK-3106 Dell 5/Card Keyboard &= Sutton & Mertol| Cannon Hill Lan| Sytem ID =

Creating Groups
1. To create a new group, click on a column header, then drag it to the space indicated on

the screen. For example, if you want to group information by Site, click on the Site
column header and drag it to the indicated space.

| Drag a column header and drop it here to group by that column |
Linking Asset Tag Asset Description Asset Type Asset Type Description T - - Locatic

Not Linked | 1

Philips Monitor 15 TFT Philips Monitor = 1 1

Mot Linked | 1-1 Asset in Type 111 111 Type 111 = a i 1

2. The screen now lists Site as one of your groups and the assets are grouped according to
what Site they are assigned.

Grouped by:
. Linking

1

Asset Tag Asset Description Asset Type Asset Type Description  Transact As Whole _ Loc

Not Linked |1 Philips Monitor 15 TFT

[
=
=

Philips Monitor

Not Linked | 1-1 Asset in Type 111 111 Type 111 = e i
Mot Linked | 1-3 Asset in Type 111 111 Type 111 & 1 1
Not Linked | 1-4 Asset in Type 111 111 Type 111 7 i 1

3. You can create additional groups to further organize your information by continuing to
drag and drop column headers. For example, you can create a second group for
Locations within Sites by dragging the Location column header to the top of the screen.

Now the Asset List groups information by Site, and then by Location.
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[t R IEEE |
.J!I Linking Asset Tag Asset Description Asset Type | Asset Type Description | Transact As Whole “ Location
[
Al

Mot Linked | 1 Philips Monitor 15 TFT Philips Monitor 1 1

Mot Linked | 1-1 Asset in Type 111 111 Type 111 1 1

Mot Linked | 1-3 Asset in Type 111 111 Type 111 1 1

=

4. By default, the groups list information in ascending order (Site 001, Site 002, etc.). You
can change this to descending order by clicking on the group name. Notice that after you
click on the group name, the arrow next to the name is now pointing in the opposite
direction and the information on the screen is reorganized.

\— L - L% K ALK Y 1 | — A
Grouped by: b Location
-i-| Linking Asset Tag Asset [

Deleting Groups
1. If you no longer want to display information in a particular group you can easily ungroup
the data. For instance, if you have created a group for Site and another for Location, but
now wish to only group by site, you can delete location from the Grouped by list. Hover
your mouse over the group you want to delete. A checkbox appears:

Grouped by: , Location B

-
-|- 1 imllrimm L

A M

2. Click the checkbox to delete the group. The information contained in that group still
appears on the display screen, but it is no longer grouped together.

Grouped by:
.‘ Linking Asset Tag Asset Description Asset Type Asset Type Description Transact As Whole m Location Depar
g
Not Linked | 1 Philips Monitor 15 TFT Philips Monitor 1 1 Sytem
Mot Linked | 1-1 Asset in Type 111 111 Type 111 1 1
Mot Linked | 1-3 Asset in Type 111 111 Type 111 1 1
Mot Linked | 1-4 Asset in Type 111 111 Type 111 1 1
Mab limbnd |4 € Ammmb i Turmm 444 ERE] Toomm =

Show/Hide Columns - The list allows you to hide columns by clicking the Show/Hide Columns
icon and selecting which columns you want to see. This enables you to hide information you do
not usually need. Click on the Show/Hide Columns icon to see a list of all columns. Those with
check marks in front of them are currently displayed in your list. To hide a column, click on a
column name. The check mark will disappear, meaning that column will not appear in your list.
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¥ Linking ¥ Checkout Length ¥ Warranty Begin ¥  Custom Number 4
¥ Asset Tag ¥ Lead Time ¥ Warranty End v Custom Number &
v Asset Description v  Depreciation Class ¥ Warranty Provider Custom T1

v Asset Type ¥ Category ¥ Last Audit Date Custom T2

v Asset Type Description  +  Vendor Number v Due Date Custom T3

¥ Transact As Whole ¥ Purchase Date v Customer Custom T4

¥ Site ¥ Purchase Cost ¥ Employee Custom T5

¥ Location ¥ Salvage Value ¥ Custom Date 1 Custom T6

¥ Department Code v Depreciation Beqgin Date  + Custom Date 2 Custom T7

¥ Checked Out v Last Depreciation Date ¥ Custom D3 Custom T8

¥ Senial No v Total Depreciation v Custom Date 4 Custom T9

v Condition v Current Depreciation v Custom Date 5 Custom T10

v Hyperlink v Book Value v Custom Mumber 1

v Manufacturer v Depreciate Asset v Custom N2

o Model 5 Purchgse Qrder 5 Cystom Mumber 3

Notice in this example the Custom T1 through T10 columns are hidden (no check mark).

When you hide a column, it will remain hidden until you manually return it to the List screen by

following the instructions above.

%]

Print Tags/Labels/Badges - This button is available on the Asset, Employee, Location Lists only.
This option allows you to print barcode labels for any assets, employees, etc. selected in the list.

Note: You must select a Label Printer in the MobileAsset PC application prior to printing tags
from the List screens.

To Print Tags/Labels:
1. Click the Print Tags button on the toolbar. An example of your tag/label/badge appears.

2. Click the Print button to print.

M

Views - This icon allows you to save your list settings, including any filters (search criteria), group
settings, reordered columns, etc. Click on the icon arrow to view available options for this feature,
as shown below:
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™

=

Save/Save As

5C i
Delete b
Load b
Reszet View Settings
=
Options are:

e Save/Save as - Accesses the Save View screen allowing you to name and save list
settings.

e Delete - Click the arrow to view a list of views that can be deleted. To delete:
a. Select Views > Delete. A list of all saved views appears.

b. Click on the filter you want to delete.

SavefSave As

= Delete b | a# Available Items
Load ; The Wilzon Hos | Stock!
Reset View Settings The Wilson Hos | Stock
— = 3

c. A confirmation message similar to the one below appears:

Are you sure you want to delete the view:
‘Available Items'?

Yes Mo

Click Yes on the confirmation message.
e Load -This option allows you to apply a saved view to the list.

To load a saved filter:

a. Select Views > Load. A list of all saved views appears.
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b. Click on the view you want to apply:
Save/Save As
| hole Site
Delets 3 7 :
1 Main Office
1 Load P | & Monitors
1 Reset View Settings & Laptops
o = ) .
24 = [Mo Global Views]
' ==
c. The selected view will be applied to your list.

Section C: Search Field

3

Enter a keyword or number in this field. MobileAsset Web will search all records on the list and
display only those containing all or part of the entered text.

Section D: Contents List

-

Linking Asset Tag Asset Description  Asset Type Asset Type Descri| Transact As Whole Site Location Department Cc
Not Linked 1005 17" Monitor Monitor 17 17" Monitor (1] Main Office Storage Rm A 1203
Mot Linked 4000 T61 units Laptop IBMThinkPac| T61 units = Main Office Storage Rm A 1203
Mot Linked 4001 T61 units Laptop IBMThinkPac| T61 units = Main Office Storage Rm A 1203
Mot Linked 4002 T61 units Laptop IBMThinkPac| T61 units | Main Office sales office 1 1203
Mot Linked 4003 T61 units Laptop IBMThinkPac| T61 units Main Office Storage Rm A 1203
Mot Linked 4005 video card device Video Card video card device = Main Office Storage Rm A 1203
Not Linked 4007 ID socftware suite Software Macromed | 1D software suite = Main Office Storage Rm A 1203
Not Linked 4008 ID software suite Software Macromed | 1D software suite = Main Office Storage Rm A 1203
Not Linked 4010 di7 laptop Laptop Dell d17 laptop = Main Office Storage Rm 17 1203
Not Linked 4011 di7 laptop Laptop Dell d17 laptop = Main Office Storage Rm 17 1203
Not Linked 4012 d1i7 laptop Laptop Dell d17 laptop = Main Office training office 1203
o — e — = e —— T
4 »

The contents list displays all data related to the selected list. For example, if you selected the
Asset List, all assets will display here, if you selected the Locations list, all locations will display
here, etc.

Sorting Columns: Most of the columns that appear in the lists can be sorted ascending or
descending. The columns sort ascending by default. To change the sort order, click on the
column heading. An arrow will appear next to the column name to let you know in which direction
the information is sorted. The example below shows the Site column sorted Ascending.
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Selecting a Listing: You can quickly scroll through the listings using the scroll bars to the right
and below the contents list. Keep in mind that you can also use the Hide/Show Columns button
to view columns that are normally hidden (see Section B: Toolbar, above).

You can click on a listing to highlight it, then click the button that accesses the desired function.
For example, if you want to edit Asset 1137, use your mouse to click on that item in your Asset
List, then click the Edit button.

Selecting Multiple Listings: You can select multiple listings at a time by holding down the Ctrl
and clicking the listings with your mouse. Multi-select can be used for Disposing/Deleting items
and Maintenance.

Section E: Buttons/Status Bar

)

This section contains the following:
Help - Click this button to access this help document.

Close - Click this button to close the list. Keep in mind when closing the list that your groups and
column settings will be retained.

Status Bar - The bar at the bottom of the screen indicates what filters you currently have set for
the list.

Context-Sensitive Menus
The software provides you with a toolbar for quick access to various list features and, in addition,

many of these features can also be accessed via "context-sensitive menus". By right-clicking on
a column heading, a list of available features appears, as shown below:
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Filter

Mew Asset

Edit Asset
Dispose
Duplicate Asset
Check In
Check Out

Mowve

Maintain

Print List
Export List

Group Columns

Print Tags

These features allow you to sort, group and hide columns in the list. Any changes you make to
the list via this menu will be retained when the screen is closed and re-opened.
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Vendors List Example

Working with Lists

The Vendor List, accessed from the Main Menu by selecting List Forms > Vendors, allows you

view Vendors you have already setup and to create new or modify existing Vendors. For detailed
information on working with list screens, please see Working with Lists.

Below is an example of the Vendor List.

Vendor List

« =, =alir | [e= |

AY R0 er-En | =-

‘Vendor Code ‘Na wail Web Site Contact Nar Address ﬂ i
3333 Computers Direct Sarah Peterson

689754 PC Unlimited

85766 Tech Services Jennifer Dean 1400 10th St Plz
86597 IT Services Elizabeth Banks
a4 >
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Asset List Example

The Asset List, accessed from the Main Menu by selecting List Forms > Assets or Asset
Management > List Assets, allows you view Assets you have already setup and to create new
or modify existing assets. For detailed information on working with list screens, please see
Working with Lists. Below is an example of the Asset List.

Asset List
WView
PR APy L T 3R AE i YsdE TTRIESRIS
Linking Asset Tag p— Description  Asset Type | Asset Type Description Transact As Whole | Site Location | Department Code | Chec =
Not Linked | 1 Philips Monitor 15 TFT Philips Menitor 1 1 Sytem ID -
Not Linked | 1-1 Asset in Type 111 111 Type 111 3 10
Not Linked | 1-2 Philips Monitor 150 Philips Monitar 3 10 T
Not Linked | 1-3 Asset in Type 111 114 Type 111 3 10
Not Linked | 1-4 Asset in Type 111 111 Type 111 3 10
Not Linked | 1-5 Asset in Type 111 111 Type 111 3 10
Not Linked | 1121 Philips Monitor 150 Philips Menitor 3 10 ACC
Not Linked | 1127 Dell Optiplex GX270 | GX270 Dell Optiplex GX270 £l 10 Wasp =
Not Linked | 1128 Dell GX150 CPU GX150 Dell GX150 CPU The Wilson Hos | Stock Room 2_ | Wasp
Not Linked | 1132 Dell Optiplex GX270 | GX270 Dell Optiplex GX270 3 10 Wasp =}
Mot Linked | 1137 AMD Base Athlon AMD Base Sutton & Mertoi| Green Wrythe &) Sytem ID
oo amars o =l o e PR P =l E.
4 »
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Departments List Example

The Department List, accessed from the Main Menu by selecting List Forms > Departments,
allows you view Departments you have already setup and to create new or modify existing
departments. For detailed information on working with list screens, please see Working with
Lists.

Below is an example of the Department List.

Department List
€ e g | e ey - —

AY BB &=

Depa Code Department Name -
101 Sales

102 Development

103 Shipping/Receiving

104 HR

105 Marketing

106 Accounting

107 Training

1203 T

123 Logistics

-

a4 »
10 Records
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Depreciation Class List Example

The Depreciation Class List, accessed from the Main Menu by selecting List Forms >
Depreciation Classes, allows you view depreciation classes you have already setup and to
create new or modify existing classes. For detailed information on working with list screens,
please see Working with Lists.

Below is an example of the Depreciation Class List.

PIN A EITY I Yo dE [REE
m Depreciation Method | Custom Percentage | Asset Life Years | Asset Life Months | Fully depreciate to salvage value  *
150DB5 150% Declining Balance 0.00 5 o
Computer Software | Double Declining Balanc 0.00 4 o
DDB4 Double Declining Balanc 0.00| 4 o
Furniture Sum-of-the-years'-digit 0.00| 7 o
Laptops Straight-Line 0.00| 3 0
Monitors Straight-Line 0.00| 5 0
PCSLA Straight-Line 0.00| 4 0
sL2 Straight-Line 0.00| 2 0
SLE Straight-Line 0.00) 6 0
SYD4 Sum-of-the-years'-digit 0.00| 4 0
-
4 3
==
T
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Customer List Example

The Customer List, accessed from the Main Menu by selecting List Forms > Customers, allows
you view customers you have already setup and to create new or modify existing customers. For
detailed information on working with list screens, please see Working with Lists.

Below is an example of the Customer List.

Customer List
7 |||k | FER| || ‘ ﬁ ﬁ | ™ E J_J - =
PANAIFY S eIl i Ve =
Customer No. Name | Company Name  Email | Department | Date Added Address 1 Address 2 City State | Postal Code | “
i Eric Fowler First Bank efowler@firstbank.. Sales 12/1/2007
2 Jeremy Knight | City College Jknight@ccollege.et| Inventory 12/1/2007
3 Kathy Howard | InfoTronics khow@info.com Sales 12/1/2007
4 Deborah Smith | InnerSpec dsmith@inspec.con | Procurement 12/1/2007
5 Brian Jackson | TestData Inc brian.jackson@td.c | Inventory 12/1/2007
[ John Vinson Family Groceries | jv@family.com Sales 12/1/2007
7 Grace Whatley | Adams, Pruitt, & Ar| gw@apacount.com | Procurement 12/1/2007
8 Evan Danielson | Main Engineering | edanielson@main.c| Procurement 12/1/2007
9 Sarah Feldman | Design Central sara@design.com | Inventory 12/1/2007
1 »
.
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Contracts/Licenses List Example

The Contracts List, accessed from the Main Menu by selecting List Forms >
Contracts/Licenses, allows you view contracts or licenses you have already setup and to create
new or modify existing contracts/licenses. For detailed information on working with list screens,
please see Working with Lists.

Below is an example of the Contracts List.

Contract List

2v R EE e

= -

Contract Number  Description | Internal Contact Begin Date | End Date  Licenses  No End Date AssetCount | Software  Cost Hyperlink  *
051503 Macromedia Suite sof| Liz Banks 12/1/2008 5 7 0.00

402900 PC repair/service Liz Banks 12/1/2008 12/1/2010 1 = 22 = 0.00

4 »
==
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Asset Type List Example

The Asset Type List, accessed from the Main Menu by selecting List Forms > Asset Types,
allows you to view Asset Types you have already setup and to create new or modify existing
asset types. Asset Types are a category for assets. Assets are assigned to a specific asset type.
For instance, you may have an Asset Type of Label Printers that defines the manufacturer, size
specs, etc. of this particular type of printer. Then specific printers of the same type are assigned
to the Label Printers asset type.

For detailed information on working with list screens, please see Working with Lists.

Below is an example of the Asset Type List.

Av REpEezEn =

Asset Type i Description i Checkout Length i Manufacturer i Model i Vendor Number i Depreciation Classl Category _‘_E
10/100 8 prt Buffalo Switch 5 days0 hrs 0 min | Palm 10/100 8 pr 1 Handheld Hardware
1016DT SMC Switch 8 days0 hrs 0 min |Palm 1016DT 2 Handheld Hardware
1024DT SMC Switch 11 days 0 hrs 0 min | Palm 1024DT Handheld

111 Type 111 0 days1 hrs 0 min | Brother P Touch Printer Hardware

112 112 on wdt3200 8 days0 hrs0 min |3 model wdt3. | 180 180 cat wdt3200
113 113 wdt 9 days0 hrs 0 min | mf 3200 model 3200 3200 2 cat 3200

114 114 2 days0D hrs0O min |4 4 8 str 3200

115 115 0 days0 hrs 0 min

13 13 8 days0 hrs0 min |13 13 Model 13 double 5 13 cat

1320 HP Lower Tray 10 days 0 hrs 0 min | Hewlett Packarc| 1320 b s Handheld Hardware

15 TFT Philips Monitor 6 days 0 hrs 0 min | Toshiba 15 TFT 2 Monitor Hardware

150 Philips Monitor 10 days 0 hrs 0 min | Toshiba 150 il Monitor 1200

150B2 Philips Monitor 11 days 0 hrs 0 min | Toshiba 150B2 none new CAT USE
1505 Philips Monitor 11 days 0 hrs 0 min | Toshiba 1505 Monitor

155 155 = Aave N_hre N_min Finiten M 15 = Mahila Nauvica Hardwara 4
L] 3
==
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Locations List Example

The Location List, accessed from the Main Menu by selecting List Forms > Locations allows
you view Locations you have already setup and to create new or modify existing locations. For
detailed information on working with list screens, please see Working with Lists.

Below is an example of the Location List.

Location List

TR

A Y B

001 Administrative OFf
001 NE Warehouse
001 Plano Warehouse
001 SW Warehouse
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Manufacturer List Example

Working with Lists

The Manufacturer List, accessed from the Main Menu by selecting List Forms > Manufacturers
allows you view Manufacturers you have already setup and to create new or modify existing
manufacturers. For detailed information on working with list screens, please see Working with

Lists.

Below is an example of the Manufacturer List.

Manufacturer List

- GE [Tk (| (o= - —

A E Y Yo E I REE

i : Email ‘Web Site ‘Address 1 Address2  City | 'Postal Code | ( *
Dell http://www.del | James Bullocks 1688 E. Mfg We Dallas 75074

Dell 2 jsmith@dell.com www.dell.com | Jim Smith 1688 E. Mfg Dr.| Suite 88 Dallas 75074

Fujitsu http:/fwwew. fuji

Hewlett Packarc http://www.hp.

Kyocera http:/fwww. kyc

Palm jsmith@eurc.palm. | http://eurc.palr| John Smith 1677 W. Palm £| Suite 77 Dallas 78501

Toshiba http://uk.comp

4|

11 P_ecnrds
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Employee List Example

The Employee List, accessed from the Main Menu by selecting List Forms > Employees, allows
you view employees you have already setup and to create new or modify existing employees.
For detailed information on working with list screens, please see Working with Lists.

Below is an example of the Employee List.

Employee List

LAY pRL bR en- =

= -

Employee No Last Name | First Name Department  Manager No | Phone | Ext Email Address 1 | Address 2 | Mail Stop =3
04295153 Thomas Dan
05150329 Taylor Dawvid
123456789 Miller Billy 1203
379856458 McGee Billy 123
6458732159 Phillips Terri
6598742 Harris Eric 123 eharris@work.com
975648125 Martin Joan
-
a » i
=
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Site List Example

The Site List, accessed from the Main Menu by selecting List Forms > Sites, allows you view
Sites you have already setup and to create new or modify existing Sites. For detailed information
on working with list screens, please see Working with Lists.

Below is an example of the Site List.

LAY e se-dmn = -
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Transactions List Example

The Transaction List displays all transactions completed in MobileAsset. The Transaction List is
accessed from the Main Menu by selecting List Forms > Transactions, You can keep this list
current by using the Archive Transactions function to remove old transactions from your list.
For detailed information on working with list screens, please see Working with Lists.

Below is an example of the Transaction List:

- - @ @ @ @ @ =@ @

Transaction List.

2y (sEnE-
Trans Date | Trans Type | Asset Tag | Department | Location | Other Location | Reason | Entry Date | DateAu]u":l
12/4/2008 Add 4000 Storage Rm A 12/4/2008 i
12/4/2008 Add 4001 Storage Rm A 12/4/2008 | .
12/4/2008 Add 4002 Storage Rm A 12/4/2008 F
12/4/2008 Add 4003 Storage Rm A 12/4/2008
12/4/2008 Add 4005 Storage Rm A 12/4/2008
12/4/2008 Add 1005 Storage Rm A 12/4/2008
3/13/2009 Add 5000 1203 Storage Rm E 3/13/2009
3/13/2009 Add 5001 1203 Storage Rm E 3!’13.;’2009
3/13/2009 Add 5002 1203 Storage Rm E 3/13/2009
3/30/2009 Add K1000 marketing office 3/30/2009
12/8/2008 Add 4068 Storage Rm A 12/8/2008
12/8/2008 Add 4089 Storage Rm B 12/8/2008
12/8/2008 Add 4070 training office 12/8/2008
2/2/2009 Add 49000 marketing office 2/2/2009
ke Wi Wi Talate] Add Aannni marlatina affice e Fie¥ e TaTal:1 ! F
4 3
==
.
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Save View Screen

This screen, accessed from some List screens, allows you to save settings you have made on the
List screen, including search criteria, grouping, column reordering, etc. For more information on
the Save Named Filters function, please refer to the topic Working with Lists.

Using the Save View Screen:

1. After you have arranged, grouped, filtered the list as desired, select the Views icon from

the toolbar.

el |

—
E

J—
S
=

Save/Save As

Delete 3

Load 3

Reszet View Settings

=]

2. Click on Save/Save As. The Save View screen appears:

7

b
Ha

Save View

Please enter 2 name and description for the view that you want to save.

Name:
Description:
Set As Default? [ Check the box if yvou want to save this view as your default view.

Visible For All Users? || Check the box if you want this view to be accessible to all users.

O
1

Enter a name for these list settings in the Name field.

You can optionally enter a description for the filter in the Description field.

If you want this view to be the default list view, select the Set as Default checkbox. The
list will always open with the saved settings when you open it.

If you want the view to be visible to everyone who accesses the List screen, select the
Visible for All Users checkbox. This means that any users who is logged in to
MobileAsset and has access to the List screens can see this view.

Click the OK button to save your settings.
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Printing Labels/Asset Tags from the List Screens

MobileAsset Web allows you to print labels and asset tags directly from the List screens. The
following List screens have label printing functionality:

e Asset List - Print Asset Tags

e Employee List - Print Employee Badges

e Location List - Print Location Labels

Note: You must select a label printer in the MobileAsset PC application prior to printing tags from
the List screens. To do this, see the topic Selecting a Label Printer in the Mobile Asset Online
Help.

To Print Tags/Labels/Badges:

1. With the desired List screen open (Asset, Employee or Location), highlight the listing
you want to print. You can select multiple listings by holding down the Ctrl key on your
keyboard while clicking on listings.

2. Click the Print Tags/Labels button on the toolbar.

The following screen appears:
<SS>

3. Enter the number of labels you want to print for each selected item.

4. Click the OK button.
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Reports

Report Viewer

The Report Viewer presents reports in an interactive environment that permits keyword
searches, printing and export to Adobe Acrobat® Reader™ (.pdf), Microsoft® Excel (.xls),

Microsoft® Word (.doc) or Rich Text Format (.rtf) files.
The following topics are covered in this section:

Report Viewer Overview
Navigating Reports
Troubleshooting Reports
Troubleshooting Opening Reports
Troubleshooting Printing Reports
Printing on All Browsers/OS
Printing on Svr2008 64Bit IE8
Printing on Svr2003 64 Bit IE8

Report Viewer Overview:

1. Reports are accessed from the Main Menu by clicking the Reports icon. A list of all

reports will appear.

2. Click on the desired report. The report will open in the Report Viewer.

m s s M AT L] Main Report « 4 1o00% -
* Asset Types RGPOIT Wasp Barcode Technologies 7_6_2010

“10M00 8 prt
016DT
-024DT Asset Type Description Dep Class  Manufacty Vendor Number
bkl
12

1320 107100 & prt Buffalo Switch Handheld Palin 1
jkruas 1016DT SMC Switch Handheld Pal 2
150
- 5082 1024DT SMIC Switch Handheld Palin
1505 111 Type 111 Printer Baother
"85
B0 112 112 on wdt3200 180 3 180
MBS

1320 HF Lower Tray Handheld Hewlett Packard 1

“16port
sk 15 TFT Philips Monitor Ilondtor Toshiba 2
180

. 150 Philips Monitor Monitor Toshiba 1
182 150B2 Philips Monitor none Toshba
183
— 1503 Philips Monitor Ilonitor Toshiba

185 155 Jiit ; i 5
Lg
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Navigating Reports:

Contents Tree: Use the Contents Tree to quickly jump to sections of the report. In the example
Assets By PO Report shown below, the Contents Tree displays all Purchase Orders contained in
the report. Clicking on PO in the Contents Tree will display that PO in the report area to the right.
Notice that the selected PO appears highlighted (in orange) in the report.

""" Ascpts By PO Report Wasp Barcode Technologies 7_6_2010
i 1550
“po 1000 Purchase Order: po 9
"o 2000 dsset Tag Description Serial No Purchase Date Purchase Cost
o 206 79090 160: 160 all new an web 312010 $1,000.0000
o 21000 50004 2010: 2010 on weh 312010 $1,200.0000
o 3000 50007 2010: 2010 on weh 30172010 $900.0000
L 20008 2010; 2010 on weh 2142010 $500.0000
- 50009 2010: 2010 on weh 2172010 $900.0000
3172010 $900.0000
12Ro 000 . L. 3172010 $1,000.0000
“po g Click on a listing in the Contents 312010 $1,000.0000
“pewpa20s(  Tree to jump to that section of 612007 $900.0000
~pal550 the report. Total: $47,500.0000
pa2000 |

Description Serial No Purchase Date Purchase Cost
RT7D60: Dell S/Card Keyboard %NDT68653? 1725450001 11019/2007 $1,500.0000
Total: $1,500.0000

Purchasw, Order: polss0
Asset Tag \ Description Serial No Purchase Date Purchase Cost
€] \D?D: Toshiba 6570 Handheld palm 1550 SM2202003 $1,000.0000
Total: $1,000.0000

Purchase Order: po2000
Asset Tag Description Serial No Purchase Date Purchase Cost
1137 Lthlon: AWD Base 25072 511552008 $2,000.0000
80018 Lthlon: AWD Base 511502008 $2,000.0000
Total: $4,000.0000
Grand Total: $217,800.00

Report Viewer Toolbar:

The Toolbar at the top of the Report Viewer provides a variety of functions.
T 2 ST S L Main Report @ 100%

Each function is described below:

Allows you to export the current report to another format.

To Export a Report:

Export 1. Click the Export button on the Report Viewer Toolbar. The following Expo

screen is displayed:
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Export Options

Flease select an Export format from the list.

Faormats: -

Enter the page range that you want to Export.
@ Al

Fages

From: To:

o

2. Select the format to which you want to export the report from the Formats: d
list.. Your options are:

Crystal Reports RPT

Acrobat Format PDF

MS Word

MS Excel 97-2000

MS Excel 97-2000 (Data Only)
Rich Text Format

3. Next enter the page range you want to Export. You can choose ALL to expo
of the report, or select Pages and enter a page range in the From and To fie

4. Click the OK button when you are done entering criteria. For all Formats ex
Save screen will appear asking if you want to Save or Open the exported file

File Dowenload [E3m]

Do you want to open or save thiz hle?

@ j Mame: CrystalReportviewerl.doc

Type: Microsoft Word Document, 151KE
From: 190.51.99.81

Open I I Save ] [ Cancel

(V] Always ask before opening this type of fil

I iy | While files from the Intermet can be useful, zome files can potentially
g harm pour computer. If you do not tragt the zource, do not open or
e zave thiz file. what's the rgk?

5. Select Open to view the report immediately or Save to save the report to a s
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location on your computer.

S ) .
Print Accesses the Print feature.
73 Refresh Updates the current report with any new/changed information since the report was first run.
Use these buttons to navigate through the report. From left to right, the buttons are:
Navigation Retu_rn to First page
Previous Page

e Next Page

e Jump to Last Page
Al

Page Number/Number of This view only field displays the current page number/total number of pages in the report.
Pages

] Go To Enter a page number in the field, then click the page icon go to that page.
Main Report .
ey Selection
List
o Enter a keyword or a number in this field, then click the binocular icon. The MobileAsset We
Find highlight any matching text it finds in the report.
L oom Select a Zoom level from the drop down list.

Troubleshooting Opening and Printing Reports

Troubleshooting Opening Reports

Troubleshooting Printing Reports
Printing on All Browsers/OS
Printing on Svr2008 64Bit IE8
Printing on Svr2003 64 Bit IE8

Troubleshooting Opening Reports: If you are unable to access the reports, make sure
the following settings are correct:

1. Make sure the option "Always open popups in a new window" is selected on the
Internet Options screen. To check this:

a. From the Internet Explorer toolbar, select Tools > Internet Options.
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=5 HoR =%

v|¢f|x||GDDg!'E £ -
%Cunvert - @Select

o >
f:}T ~ B v o= vl-_{llvpagevlﬂjTDculs "|

Delete Browsing Histore...

Diagnose Connection Problermns..,

Pop-up Blacker
Phishing Filter
Manage Add-ons

YWeark Offline
Windows Update

Full Screen
Menu Bar

Toolbars

Fiddler?
Create hahil

3un lava Consale

Internet Options

The Internet Options screen displays.

b. Onthe General tab, select Settings in the Tabs section.
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Internet Options

Gaeneral |Securit';.f | Privacy | Conkent I Connections I Prograrns I .ﬂ.dvanced|

Harme page

/? Ta create home page kabs, bype each address an its awn line.
lf‘,[

hitpffpartnerpage.google. comdsmallbiz.dell, com,e n e

[ Idse current H s default H se blank,

Browsing history

71 Delete temporary Files, history, cookies, saved passwords,
*’_ ,-' and wehb Farm information,

Delete. .. ][ Settings ]

Search
p hange search defaults. Setkings
Tabs
[ || Change how webpages are displayed in Settings
— kabs,

2
[ ===

[ Colors ][ Languages H Fonks H Accessibility ]

[ (04 ][ Zancel ] Apply

The Tabbed Browsing Settings screen appears.

c. Make sure the option "Always open popups in a new window" is selected.
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| Enable Tabbed Browsing (requires restarting Inkernet Explorer)

[&] wwarm me when clasing multiple tabs
Always switch bo new tabs when they are created
| Enable Quick Tabs (requires restarking Internet Explarer)
Cpen only the First home page when Internet Explorer starts
o | Open new kabs next to the current tab

Cpen home page For new tabs instead of a blank page

When a pop-up is encountered:

Let Inkernet Explorer decide how pop-ups should open

@ Always open pop-ups ina new window

always open pop-ups in a new tab

Open links from other programs in:
& new window
@ A new tab in the current window

The current tab or window

Restore defaulks I, ] | Cancel

Tabbed Browsing Settings @

d. Click OK on the Tabbed Browsing Settings screen to close it.

Click OK on the Internet Options screen to close it.

Printing on All Browers/OS:
1. Make sure all Active X controls are set to Enable.

From the Internet Explorer toolbar, select Tools > Internet Options.

Reports

If you have Popup Blocker turned on, select "Always Allow Popups from this Site"
when prompted. You will usually be prompted the first time you try to access reports
from MobileAsset.

Troubleshooting Printing Reports: If you are unable to print reports, make sure the
following options are set correctly:
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=5 HoR =%

v|¢f|x||GDDg!'E £ -
%Cunvert - @Select

o >
f:}T ~ B v o= vl-_{llvpagevlﬂjTDculs "|

Delete Browsing Histore...

Diagnose Connection Problermns..,

Pop-up Blacker
Phishing Filter
Manage Add-ons

YWeark Offline
Windows Update

Full Screen
Menu Bar

Toolbars

Fiddler?
Create hahil

3un lava Consale

Internet Options

The Internet Options screen displays.

b. On the Security tab, select Local Intranet and the Custom Level button.
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I =

Internet Options @

General | SECUrity | Privacy I Content | Conneckions | Prograrns | .ﬁ.-:l'-.fan-:eu:l|

Select a zone to view or change security setkings,

@ & / O

Inkernet B leg=n=4  Trusted sites  Restricted
sikes

Local intranet
This zone is for all websites that are

= found on your inkranet,

Security level for this zone

Custom

Zuskom setkings.
- To change the settings, click Custom lewel,
- To use the recommended settings, click Default level,

Enable Protected Mode (requires restarking Internet Explorer)

[ Cuskom level... H Default level ]

[ Reset all zones to defaulk lewvel ]

nﬁn Some setkings are managed by vour syskem administrator,

[ Ik ] [ Zancel Apply

The Security Settings screen appears.

c. Onthe Security Settings screen, make sure the Active X controls are set to
Enable.

179



MobileAsset Users' Manual

Security Settings - Local Intranet Zone @

Setkings

|#| Activer controls and plug-ins -
|#| Allow previously unused Activel controls o run without pron
(7 Disable
@ Enable
¢ Allow Scripklets
(7 Disable
@ Enable
() Prompk
| Aukomatic prampring Far Ackivey cantrals
(7 Disable
@ Enable
|#| Binaty and script behaviors
() Administrator approved
(7 Disable
@ Enable

4| Miecmlzu vidas amd smirasbicn a6 s usknsas Fheb dose mak oes

o L1 I

*Takes effect after vou restart Internet Explaorer

Reset cuskom settings

Reset ol | mMedium-low {default) v| I Reset... I

[ (84 ] [ Cancel I

d. Click OK to close the Security Settings screen.
e. Click OK to close the Internet Options screen.
2. Add the MobileAsset website to your "safe" list. To do this:

a. From the Internet Explorer toolbar, select Tools > Internet Options.
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=5 HoR =%

v|¢f|x||GDDg!'E £ -
%Cunvert - @Select

o >
f:}T ~ B v o= vl-_{llvpagevlﬂjTDculs "|

Delete Browsing Histore...

Diagnose Connection Problermns..,

Pop-up Blacker
Phishing Filter
Manage Add-ons

YWeark Offline
Windows Update

Full Screen
Menu Bar

Toolbars

Fiddler?
Create hahil

3un lava Consale

Internet Options

The Internet Options screen displays.

b. Select Local Intranet and the Sites button.
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C.

Internet Options @

I General | SEcurity |F‘rivac~;.-' I Content | Conneckions | Prograrns | .ﬁ.-:l'-.fan-:eu:l|

Select a zone to view or change security setkings,

@ Gi, #’F ®

Inkernet Local intranet  Trusted sites  Restricted
sikes

= found on your intranet,

Local intranet
This zone is for all websites that are

Security level for this zone

Custom

Zuskom setkings.
- To change the settings, click Custom lewel,
- To use the recommended settings, click Default level,

[¥] Enable Protected Mode (requires restarting Internet Explorer’

[ Cuskom level... ][ Default level I

[ Reset all zones to defaulk lewvel

-ﬁ- Some setkings are managed by vour syskem administrator,

I Ik ] [ Zancel Apply

-

The Local Intranet screen appears.

Click the Advanced button.

r-

Local intranet

G{ Use the settings below to defing which websites are included in
the local intranet zone,

[] Automatically detect intranet network
[#] Include all local {intranet) sites nat lisked in other zones
[¥] Include all sites that bypass the proxy server
Include all network paths (UNCs)

wehat are inkranet setkings? I Advanced ] Ok ] I Cancel
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d. Enter the website address of your MobileAsset Web Module in the Add this
website to the zone field and click the Add button.

F- =

Local intranet ==

G’lh ¥ou can add and remove websites from this zone, &l websites in
* this zone will use the zone's security settings.

#dd this wehsite ta the zone:
Add

Websites:

htkp: fflocalbost Remove

[ require server verification (https: for all sices in this zone

| Close |

The website will appear in the Websites list.

F- =

Local intranet ==

G’Ih ¥ou can add and remove websites from this zone, &l websites in
ﬁ this zone will use the zone's security settings.

#dd this wehsite ta the zone:
| Add

Websites:

htkp: fflocalbost Remove
hkkp: | fvaurmobileasseturl

[ require server verification (https: for all sices in this zone

| Close |

e. Click Close to close the Local Intranet screen.

f. Click OK to close the Local Intranet screen.
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g. Click OK to close the Internet Options screen.

h. Restart your browser.

Printing on Svr2008 64Bit IE8: To enable printing on Svr2008 64 Bit IE8, follow the instructions
below:

1. Open the Start Menu.

2. Right click Computer and select Manage. The Server Manager opens. Select
Configure IE ESC.

3. Select Off for Administrators in the Server Manager.

E_Server Manager =] 5|

File Acton View Help

&= =]
o Server Maneger (MEVROSETo0)

2 Roles
| Features

= Diagnostics Get an overview of the status of this server, perform top management tasks, and add or remove server roles and features.
%! Configuration

Storage

(~) Server Summary Server Summary Help

(~] Computer Information 1l Change System Properties

=)
Full Computer Name: vmSvrdsentsd = FESRiCl kR S
& Configure Remote Desktop
Workgroup: WORKGROUP
Local Area Connection: 190.51,99.84, IPv6 enabled
Remate Desktop: Enabled
Product ID: 55041-222-1955431-76378

¥ Do not show me this consale at logon

‘ Security Information @ Go to Windows Firewall
&
Windous Firemall: fatid & Configure Updates
. Internet Explorer Enhanced Security Co x| #2 Check for New Roles
Windows

& Run Security Configuration Wizard

Last chet Internet Explorer Enhanced Security Configuration (IE ESC) reduces the & Confiqure IE ESC
expasure of your server to potential attacks from Web-based content,

Last insty Internet Explorer Enhanced Security Configuration is enabled by

default for Administrators and Users groups.

IE Enhar

Escl: Administrators:

= [ " on (Recommended;
(~) Roles Sur @ & ) Roles Summary Help

. [ g
'~ Roles: @1 = off

3,-' Go to Roles LI
“ 20| ¥ testRefresn

& on (Recommended)

B Cof

More about Internet Explorer Enhanced Security Configuration

OK Cancel

4. Open IE8 and select Tools > Internet Options.
5. On the Security tab, select Trusted Sites > Sites.

6. Uncheck "Require server verification (https:) for all sites in this zone".

184



Reports

7. Enter the website address of your MobileAsset Web Module in the Add this website to
the zone field and click the Add button.

8. Click Close to close the screen.

9. Onthe Internet Options - Security tab, select Custom Level > Reset Custom Level >
Medium Low.

10. Click OK, then Apply.

11. Restart your browser. When you select the Print icon on a report you will be prompted to
install the Crystal Reports Viewer. Install it following the on screen instructions.

Printing on Svr2003 64 bit IE8: To enable printing on Svr2003 64Bit IE8, follow the instructions
below:

1. Open the Start Menu.
2. Select Control Panel > Add/Remove Programs.

3. Onthe Add/Remove Programs screen click Add/Remove Windows Components.

S Add or Remove Programs

'ﬁ‘ Currently installed programs:

Change or

E fdobe Reader 3,1

B cuteroF writer 2.7

#E FogBugz Screenshat

Add Mew ﬁ'_:’;! Microsoft \MET Framewark 2.0 Service Pack 2

Programs
ﬁ Micrasaft \MET Framewark 3.0 Service Pack 2

ﬁi- ﬁ'_;:ﬁ Microsoft .MET Framework 3.5 5P1
1]

I@I Microsoft ActiveSync

| MSRML & Service Pack 2 (KB973686)

Yiware Tools

(_ Windows Internet Explorer 8

Click here for support information,

4. Onthe Add/Remove Windows Components screen, make sure Internet Explorer
Enhanced Security Configuration is NOT selected.
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10.

11.

12.

13.

Windows Components Wizard

Windows Components
Yau can add ar remave campanents af Windows.,

To add ar remove a component, click the checkbox, & shaded box means that only
part of the component will be inztalled. To zee what's included in a component, click

Detailz.

Lormponents:

[ 1 Z ndexing Service 00ME =]
[] @8 Intermnet Explarer Enhanced 5 ecurity Canfiguration 0.0 MB

[ Eﬂ b anagement and kanitaring Tools 26.4 MB —
[ 29 Networking Services 8.2 MB

1 2= thier Mehwrk File and Print S emvires name T

Dezcrption:  Includes “Windows Acceszones and Utilities for your computer,
Total dizk space required: 434 MEB Details |
Space available on dizk: EE4E.5 ME =
< Back I Hest » I Cancel | Help |

Select Next to exit the Windows Components Wizard.

Open IE8 and select Tools > Internet Options.
On the Security tab, select Trusted Sites > Sites.
Uncheck "Require server verification (https:) for all sites in this zone".

Enter the website address of your MobileAsset Web Module in the Add this website to
the zone field and click the Add button.

Click Close to close the screen.

On the Internet Options - Security tab, select Custom Level > Reset Custom Level >
Medium Low.

Click OK, then Apply.

Restart your browser. When you select the Print icon on a report you will be prompted to
install the Crystal Reports Viewer. Install it following the on screen instructions.
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Reservations Overview

The Reservations module allows you to mark an asset or multiple assets as reserved for a
specific employee or customer. The Reserved period can be for a single date or a range of
dates. Assets that are reserved cannot be checked out to other employees/customers during the
reservation period.

Users given security access to the module can create reservations. Those reservations will then
need to be approved before they become active. Approve Reservations

The Reservations module contains the following features:
Create New Reservation

Manage Reservations
Approve Reservations
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Create New Reservation

The Create New Reservation screen allows you to designate one or more assets as reserved for
a selected employee or customer for a specified period of time.

To Create a Reservation:

188

From the Main screen, select Reservations > Make a New Reservation. The New
Reservation screen appears:

New Reservation

~ | General Info

Reservation No: = Urgency: = &J
Reference No: ‘l] Notes: &]
For: | customer v -3 Request Status:

Asset Tag: - m Asset Type: = m

Reservation includes the following:

[<X>] 16 - 22 July 2010

07/16/2010

| 07/17/2010 07/18/2010 | 07/19/2010 I 07/20/2010 ; 07/21/2010 { 07/22/2010

Approver: Notify status change via email

Print Receipt On Reserve - Copies: 0 - || Shari deBlonk || Notify reserved for user

(vel |
The top of the New Reservation screen is the General Information section. You may
notice that some fields in this section have a Pin icon in front of them. These fields
represent data that can be "pinned”. Pinning allows you to "lock" the information
entered into a field. This is convenient if, for example, you are entering multiple new
assets for a particular site and location. You can enter the site and location once, then
pin them. The fields will retain the information you entered through each new entry until

you unpin them. Pin a field by clicking on its pushpin. Click the pushpin again to unlock
the field for entry of a different value.

This section is where you will enter:
e Reservation Number: This unique identifier can be manually entered, or you

can select the |%J icon next to the Reservation Number field. When the icon is
pressed, MobileAsset will assign the reservation the next available reservation
number. Reservation Number is a required field.

New Reservation
- | General Info

Reservation No: Urgency:

Reference No: Notes:

Request Status:

e Reference Number: This optional field is a number used for your reference.
This number is not tracked by MobileAsset.
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e Customer/Employee Drop Down: Select whether this reservation is for a
customer or an employee. Then use the drop down box to assign a specific
customer or employee. Select <MORE> to access the Customer List or
Employee List. This is a required field.

e Urgency: This field allows you to assign an level of urgency to this reservation.
This is useful if more than one reservation is created for the same asset at the
same time. The person approving the reservations can quickly refer to the
assigned Urgency of the request to help determine which reservation to
approve.

e Notes: You can optionally enter notes on this reservation. To add a note, click in
the field and type in the information.

e Request Status: This view-only field lists the current status of this reservation.
Possible Statuses are New, Pending, Approved and Rejected.

3. Now you can select those assets or asset types you want to reserve. You can select a
specific asset or, if you do not care which asset is reserved, select an asset type. For
example, if you want to reserve an HP laptop for an employee, but don't care which HP
laptop, select the Asset Type - HP Laptop. MobileAsset will assign an asset within the
Asset Type to this reservation.

Asset - Manually type in an asset or select an asset from the drop down list. Select
<MORE> to access the Asset List. After you have made your selection, click the Add
button.

OR
Asset Type - Manually type in an asset type or select an asset type from the drop down

list. Select <MORE> to access the Asset Type List. After you have made your
selection, click the Add button.

Your selection will appear in the scheduling window. Repeat this step until you have
added all Assets or Asset Types you need for this reservation.
If the selected asset already has a reservation or is checked out, a notice will appear on

the appropriate date. In the example below, asset 1121 already has an Approved
reservation for July 19 - 20.
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. Z
Reference Mo: liJ Notes:
For: | customer - - liJ
7 Select an Asset, then |-
Asset Tag: 1121 N m As| click the Add button.

Reservation includes the following:

[« ¥ -] 19 - 25 July 2010
07/19/2010
Approved || Approved |

23/2010

07/21/20

07/20/2010

The Assetis added to
the Reservations
f scheduling window.

& 1121

(Philips Monitor)

Approver: Notify status change via email

Print Receipt On Reserve - Copies: 0 [= |_| Shari deBlonk

Click the red x icon to delete the asset from the reservation.

o 11Ll

Reservation includes the following:

Click here to
delete this
assetiasset

type.

1121

(Philips Meonitor)

Approver:

Hint: Click the arrow icon in the top left corner of the General Information section to
minimize this section. This will enlarge the viewing area of the list of the scheduling

window.

New Reservation

}Qﬁt Click here to "collapse" the
General Info section.

= m Asset Type:

Rese

19 - 25 July 2010

00 E

07/22/2010 07/23/2010 07/24/2010 07/25/2010

07/21/2010

07/20/2010
|| Approved

07/19/2010
| Approved

Use the Scheduling Window to select the dates for which you want to reserve the
selected asset(s) or asset type(s).
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Reservation includes the following:

X 9 010
07/19/2010 07/20/2010 07/21/2010 07/22/2010 07/23/2010 07/24/2010 07/25/2010

Approved || Approved )

@ 1121

(Philips Monitor)

You can scroll to different dates using the arrow buttons, or select a date from the
calendar by clicking the Calendar icon.

Aosicl 1dy. 1121 -

Reservation includes the following:

19 - 25 July 2010

July - 2010 07/21/2

Sun Mon Tue Wed Thu Fri Sat Q
— 29 30 1 2 3

Scrollthrough p 6 7 8 9% 10
weeks usingthe p 13 14 15 18 17
Arrows or click g 0 ET AT SR
the Calendaricon | ., .5 29 30 =1
to display the
calendar.

3 4 3 & i

Double click on a date to display the Edit/New Reservation screen:

Asset 1121

Double click on a date to Start time | 7/26/2010 _ 12:00 AM =

display the Edit/New
Reservation screen.

End time | 7/27/2010 ||| 12:00 AM ~

Save & Close _Can cel

a. Enter a Start and End Date for this reservation by manually entering a date, or
click the Calendar icon to select a date.
b. Use the drop down menus in the Time fields to select a Start and End Time.
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c. Click Save and Close on the Scheduling Options screen to return to the
Create New Reservations screen. Now a bar with the current reservations
status will appear in the selected dates.

Reservation includes the following:

00 H

26 July - 1 August 2010

fulr S Le T = LsTa bW al fafor s o s T W
u T v ¥

07/28/2010

Mew

£ 1121

(Philips Monitor)

Hover the mouse over the status bar to view the reservation details.

Reservation includes the following:

o0 B

26 July - 1 August 2010

07/26/2010 07/27/2010 07/28/2010 07/28/2010 07/30/2010

+ 1121

Hover the mouse over the New
status bar to see details
about the reservation.

€ 1121

(Philips Monitor)

Reservation Number:

Approver: Start: 7/26/2010 12:00:00 AM

End: 7/28/2010 12:00:00 AM
Print Receipt On Reserve - Copies:

Click twice on the status bar to open the Edit/New Reservation screen and
make changes to the reservation date or time.

Hover the mouse over the status bar and click the x icon that appears to delete
the reservation from these dates.

Rezervation includes the following:

00 B

26 July - 1 August 2010

07/26/2010 07/27/2010

| MNew

a} 1123

(Philips Monitor) Click here to delete the
reservation fromthese dates.

d. Repeat these steps for all assets/asset types in the Scheduling Window.
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5. Now you can select someone to Approve the Reservation. Manually type in a name in
the Approver field or use the drop down list to make a selection. The drop down list
displays all users granted permission to Approve Reservations (setup in Administration
> Security).

6. You can optionally enter a number in the Print Receipts on Reserve - Copies field. The
number of copies entered will print to the designated printer (setup in the MobileAsset PC
application) upon selecting the Reserve button.

7. The Notify Status Change via Email section allows you to select to send a notification
e-mail to yourself, to the Approver and to the Customer/Employee if the Reservation's
status changes.

8. Click the Reserve button when you have completed entering information for this
reservation. When you click Reserve, an email is automatically sent to the Approver
notifying him/her of the new Reservation. This initial e-mail is sent whether or not you
have select to send notification e-mails to the Approver in the Notify Status Change Via
Email section.

Notice that once you click Reserve, the status of the Reservation changes to
Requested.

Reservation includes the following:

00 B

26 July - 1 August 2010

07/26/2010 07,/27/2010
| Reguested |

o7

1121

(Philips Monitor)

9. Click Close to close the Create New Reservation screen.
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Manage Reservations

The Manage Reservations screen allows you to access, view, edit and create new reservations.
This screen functions the same as other list screens in MobileAsset. For more information on
using the List screens, please refer to the topic Working with Lists.

To access the Manage Reservations screen, click Reservations > Manage My Reservations.

Below is an example of the Manage Reservations screen:

Manage Reservations

TN -3 - |[= -
PRl = r et I Vgl | =
Reservation No ce No | Ci No  Cu Name E No E Name Urgency Approver Notify of Status Change Created By Request St *
23 1023 £ 1145 Sebastian LeChat Critical Tester, Shirle| T Ready For C
25 1025 0001 Pittsburg, Bradley | Critical Tester, Shirle| F Requested
26 1026 1145 Sehastian | aChat Lo Tester. Shir: F Annroved |
4 »
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Approving Reservations

After a Reservation is created, it needs to be Approved by the assigned user before the asset is
actually held in reserve. The Approve Reservation screen allows you to see those reservations
assigned to you and to Approve or Reject them as needed. You can also Check Out approved
reservations directly from this screen.

Approving/Rejecting Reservations:

1. From the Main Menu, click Reservations > Approve Reservations. The Approve
Reservation screen appears:

Approve Reservation
~ | General Information:

Reservation No: ~ | Reference No: Urgency:

For: notes Request Status:

~ Reservation Details:

i} Asset Tag Asset Description Start End | Asset Type Asset Type Quantity LastUpdated

4 3

|__| This Request Is Ready For Checkout. Comment:

|| Request Approval Fror -

I o

2. The General Information section at the top of the screen displays basic data about the
Reservations. The following information is contained in this section:

e Reservation No: This drop down list contains any Reservations assigned to this
user. Click the drop down list to display the list and select a Reservation.

Approve Reservation

~ | General Information:

Reszervation No: * |Reference M
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e For: Customer/Employee: This field displays the unigue identifier of the
Customer/Employee associated with this Reservation.

o Reference No: The Reference No assigned to this Reservation (if any) displays
here.

e Notes: Any notes entered on this Reservation appear here.

e Urgency: The assigned urgency displays here. Urgency levels are Critical,
Normal and Low.

3. After you select a reservation from the Reservation No drop down list, the assets
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assigned to the reservation appear in the Reservation Details section.

Approve Reservation

~ | General Information:

Reservation No: 74 v | Reference No: A7712 Urgeney: Normal
For: Customer 1145 - Sebastian LeChat notes Client requested Request Status: Requested
- Reservation Details:
(] Asset Tag | Asset Description Start End Asset Type AssetType  Quantity Last Updated -
0| @ 1n Philips Menitor 7/28/2010 | 7/29/2010 | 150 Philips Moniter 1.00| 7/26/2010
O 7/28/2010 | 7/29/2010 | 10/100 & prt | Buffalo Switch 1.00| 7/26/2010
4 »
This Request Is Ready For Checkout. Comment:
|_| Request Approval Fror

Asset Tags and Asset Types are listed differently in the Reservation Details window. In
the example above, the first listing is an Asset Tag, and lists the Tag number and the
Asset Description. The second listing is an Asset Type so the Asset Tag and Asset
Description fields are blank.

You can approve/check out all the assets or asset types listed by checking the Select All
box.



Reservations

or:  Cus 1an LeC

~ Reservation Details:

= Ad tart End Asse
. 17 SEIECt A" f28/2010 | 7/29/2010| 150
I_I )
Check box
1] f28/2010 | 7/29/2010| 10/10

To Approve/Reject Reservations with Only Asset Tags:

a. Select the assets you want to Approve or Reject, then click the Approve or
Reject button.

To Approve Reservations with Asset Types:

a. When you select an asset type from the Reservations Detail window, or when
you click the Select All checkbox when asset types exist in the window, the
Reservations Details section changes to display all available assets for that asset
type along with a schedule window.

Reservation Details:

Please pick 1 asset from the following list: >

| | | Asset Description Asset Tag

[] | Buffalo Switch 80028
[] | Buffalo Switch 80029

Assign |
7| | Back

o ° 27 July - 2 August 2010

7-27 7-28

b. Select an asset to view that asset's schedule (when it is checked-out or reserved).
MobileAsset will filter out any assets of the selected asset type that are checked
out during the requested Reservation period.
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- Reservation Details:

Please pick 1 asset from the following list: >

Asset Description Asset Tag =

Philips Monitor 7904

PhilipsjMonitor 7911
PhilipsMonitor 80001

L}
]
Ll
Ll
sl
‘

Philips [Monitor 80041

Y5

€3 7904
(Philips Monitor)

c. Click the Assign button when you have chosen the asset you want to assign to this
Reservation. The selected asset tag will appear in the Reservations Details
section.

3 - 9 August 2010

Reservation Details:

|+ Asset Tag Asset Description Start End Asset Type Asset Type Quantity Last Updated

] | & | 704 Philips Monitor 8/4/2010 | 8/6/2010 | 150 Fhilips Monitor 1.00| 8/3/2010

If you want to check out the assigned asset(s) at the same time you approve the
Reservation, select the This Reservation is ready for check-out checkbox.

If you want to have another person approve this Reservation, select a name from the
Request Approval From drop down list.

You can leave a comment by clicking in the Comment field and typing in a note.
When you are ready to approve the Reservation, click the Approve button.
If you want to reject the Reservation, click the Reject button.

If you have selected the This Reservation is ready for check out checkbox, the Check
Out button will be enabled. Click Check Out to simultaneously Approve the Reservation
and Check-Out the assigned asset(s). The Check Out screen will appear populated
with the asset(s) from the current Reservation. Reservation Check Out will appear in the
Notes section. For more information on completing the Check Out screen, please refer
to the topic Checking Out Assets.
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Working with Multiple Companies

The Enterprise version of MobileAsset allow you to create databases for multiple companies.
This means that if you have two separate entities for which you want to maintain assets, you can
install one instance of MobileAsset, then create two databases - one for each company. A
database is the repository for all information about your company. Everything from your
company's name and address, to your employee information, to your asset information is stored
in the database. If you need to track asset information for two separate companies, you wouldn't
want to group that information into one database, as it would be impossible to know to which
company the asset belongs. Creating a database for each company allows you to enter sites,
locations, customers, employees, assets, etc. that are specific to one company. In addition, each
company has its own security so you can control who has access to a specific company.

Below are the steps to setting up and working with multiple companies:

1. Create Your Databases: To work with multiple companies, you will need to first create
your databases using the Wasp Database Manager. You will need a database for each
company. For more information on the Wasp Database Manager, please refer to the
Database Manager online help. To open the Database Manager, click on Start > All
Programs > Wasp > MobileAsset > Database Manager.

2. Log In to MobileAsset: After you setup your databases, when you log in to MobileAsset,
the Company Selection List will appear first. Select which company you want work in.
If you have access to more than one database, this screen will appear each time you
open MobileAsset so you can specify which company you want to access.

3. Set Up Your Databases: Create Sites, Locations, Asset Types, etc. for each company.
You will need to follow the steps in Getting Started for each company you create.
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Company Selection List

The Company Selection List page appears after you log on to MobileAsset if you have created
multiple databases and you have access to more than one database.

Selecting a Company:

1. After logging in to MobileAsset, you will see a page similar to the following (if you have
created multiple databases and you have access to more than one database). You will
only see those companies to which you have been given access in Security in
MobileAsset on the PC. The first time you log in using the Admin login, you will see all
companies.

' Company Group Name

] Wasp Barcode Technologies

.Test DB 6-4-10 - [
WaspTrackAssetMain | Wasp Team
WaspTrackAssetMain Wasp Development

2. Click on the company you wish to access. MobileAsset will open with the desired
company's information displayed. Note that the title bar at the top of the window
indicates which company you currently have open.

Click Cancel on the Company Selection List to return to the Log In page.
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Technical Support

Wasp Technical Support, Knowledge Base and Downloads
Wasp Barcode Online Store
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